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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their reliability
and durability. However, these materials cannot be totally guaranteed against wear and / or decomposition by chemical
action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspection of
returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respect-
ive brand names or trade names. We, therefore, make no express or implied warranty as to such products. We
shall use our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or
replacement of such of his products that may prove defective in workmanship or materials. Service charges made
by such manufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to
such products, except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion
of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals,
etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items
which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of man-
ufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied,
including but not limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Contact Us

CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive

Norcross, GA / USA / 30093-2901

Phone: 1-770-662-3636

Fax: 1-770-662-3696

www.Micromeritics.com

---------------

U.S. Inquiries

U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

---------------

Quotes, Orders, and Customer Satisfaction

Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

---------------

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666
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ABOUT THIS MANUAL

The following formats are used throughout this manual:

NOTE - Notes contain important information pertinent to the subject matter.

CAUTION - Cautions contain information to help prevent actions that may damage the ana-
lyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

Keypad Function - The keypad icon indicates the section is applicable only when using
the keypad.

Labels and Buttons Description
Buttons (in the applic-
ation)

Buttons in the application are represented as bold font and blue letters —
such as: Save, Edit, and Replace All.

Field Labels Field Labels are represented as italicized words — such as: Sample, Auto-
matically Collected, and Analysis Conditions.

Keyboard Commands Keyboard commands are represented as bold font and black letters — such
as: F2 and Alt+F4.

Menu Instructions Menu instructions are represented as bold and italicized words — such as:
File > New Sample and Reports > Start Report.

Screen Tabs Screen Tabs are represented as italicized words — such as: Sample Descrip-
tion, Analysis Conditions, and Report Options.

Screen Titles Screen Titles are represented as italicized words — such as: Analysis
Adsorptive Properties, Free Space, and Sample Tube.

Field Labels and Screen Titles

About this Manual
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1 ABOUT THE ACCUPYC II 1340 PYCNOMETER

The AccuPyc II Pycnometer is an easy to use, fully automatic gas displacement pycnometer. It
determines density and volume by measuring the pressure change of helium within calibrated volumes. It
also reports the chamber temperature at the end of the requested cycles. The AccuPyc II can be operated
using the analysis program installed on an attached computer, or if no computer is attached to the
pycnometer, the keypad can be used to start and run analyses. The analyzer may be operated in English,
French, German, Italian, or Spanish.

The AccuPyc II Pycnometer consists of a control module and an analysis module. When ordering a
single unit, the control module is built into the same unit as the analysis module for convenience. The
analysis modules are also available in a standalone configuration, allowing multiple analysis modules to
be attached to a single controlling unit. A maximum of five analysis modules can be installed to one
controller (six total). Each module has its own gas connection. The pycnometer can be controlled by
either:

l a Windows interface. The operational status of the pycnometer can be continually monitored in a
status window shown on the computer monitor. If the Windows interface is used, the keypad is dis-
abled.

l the keypad if not running the Windows interface. A separate keyboard and printer can be attached to
the pycnometer using USB ports.

1 About the AccuPyc II 1340 Pycnometer
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1 About the AccuPyc II 1340 Pycnometer

ABOUT THE TEC MODULE

Density measurements at specific temperatures are required for certain applications. The AccuPyc II
Thermo Electric Cooling (TEC) Module maintains an accurate temperature control during analysis using
the principle of Peltier cooling.

TEC Modules, also known as Peltier coolers, are solid-state heat pumps that utilize the Peltier effect to
move heat. By passing a current through the TEC Module, heat is transferred from one side of the
module to the other, typically producing a heat differential of approximately 40° C.

The transferred heat is then removed from the system through the combination of a heat sink and fan,
cooling the system to maintain a set temperature for accurate analysis.

TEC systems feature:

• fast dynamic response
• long-life
• no moving parts
• no use of refrigerants or circulated liquids/antifreeze

ASPHALT DENSITY APPLICATION

The AccuPyc II TEC Module can measure asphalt density using disposable cups to limit cross-
contamination of samples. See "Asphalt Density Measurement" on page H - 4.

This solution can be closely correlated ( <0.15% difference) to results obtained with ASTM Test Method
D70-09. The AccuPyc asphalt density measurement is completed much faster than the ASTM method
while virtually eliminating operator error. The Peltier thermoelectric cooling control (15 to 36 °C)
provides stability for handling of samples.

Performing an asphalt density measurement requires the AccuPyc II Asphalt software and disposable
sample cups. Refer to "Parts and Accessories" on page 13 - 1 for ordering information.

1 - 2 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



ABOUT THE FOAMPYC MODULE

A FoamPyc option for measuring open and closed cell foam materials is available for both standard and
temperature controlled pycnometers. This unit can be ordered initially with the FoamPyc application
installed, or can be upgraded from the standard AccuPyc with a software enhancement via USB media.
Configuration options are:

l 100 cm3 nominal cell volume (recommended)

l 10 cm3 nominal cell volume

The FoamPyc option performs analyses on materials such as polystyrene, urethane, and rubber foams
using five different methods:

l Method A. Measures the closed cell fraction and corrects for the cells damaged while cutting the
sample to the necessary size and shape. This is accomplished by using either the average cell dia-
meter or the cell chord length (as defined in ASTM method D-3576) and the measurements of the
sample to determine the volume of the cut cells. This volume is deducted from the total volume of the
open cells measured by the pycnometer.

l Method B. Corrects for the cut cells by using two separate measurements. For the 2nd measurement,
the sample is recut to double the amount of cut surface. The observed difference in cut open cell
volume is applied as a correction to the initial measured volume. This method offers the distinct
advantage that no assumptions are needed about the relative amounts of open and closed cells.

l Method C. Does not correct for cut cells. It is used for materials with predominantly open cells
where good accuracy can be achieved without correction. The accuracy level deteriorates as the per-
centage of closed cells increases.

l Method D. Is a compressibility test. The fill pressure is increased incrementally over the sample with
each repeat of the P1,P21 ) cycle. The apparent variation of the measured sample volume with the
average pressure is determined. This test is an approximate indication. It is not intended to be an
exact measure of the volume compressibility.

l Method E. Is a cell fracture test; a perfectly rigid foam is assumed. First, a P1,P2 cycle is performed
at the lower of two specified P1 pressures, and the results stored. A second cycle is performed at a
higher specified value of P1, then a third cycle identical to the first cycle is performed. The dif-
ference between the volume of the sample on the first measurement and on the third measurement is
reported as the volume of fractured cells. It is assumed that cells fracture by exposure to the highest
pressure (2nd cycle) so that when the third measurement is made, the measured sample volume has
decreased from the first cycle by the amount of the closed cell volume which was fractured.

1 ) Where P1 is the initial pressure to which the sample is charged, and P2 the final pressure after
expansion.

About the FoamPyc Module
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1 About the AccuPyc II 1340 Pycnometer

The 100 cm3 AccuPyc II has been designed and tested to follow the procedure in ASTM Method D 6226
for FoamPyc analyses. The 10 cm3 and 350 cm3 units can be used for some types of foam materials;
however, analyses on these AccuPycs will not conform to the ASTM method. The 1 cm3 AccuPyc II
cannot be used to perform FoamPyc analyses.

The FoamPyc software also provides the capability to perform analyses in the Standard mode of
operation. This is especially convenient for users who have upgraded to the FoamPyc method from the
standard method. For example, a 100 cm3 AccuPyc on which FoamPyc analyses are performed and a 1
cm3 analysis module attached on which standard analyses are performed.

INSTRUMENT COMPONENTS

FRONT

The sample chamber, located on the top panel, is where the sample container is placed for analysis, or
the standard for calibration.

The sample chamber should remain capped except when inserting or removing a sample. When left
uncapped, water vapor adsorbs on the inner surface of the chamber or the chamber temperature becomes
unstable; either condition can affect analysis results. If water vapor accumulates in the chamber, the
pycnometer must be purged.

The standalone control module, often used for the Glove Box pycnometer, does not contain a sample
chamber.

Component Description
Active indicator A blue LED which illuminates when an operation is in progress. It is included on

all analysis modules. It is not included on standalone control modules.
Display window Displays Remote Operation when the Windows application is being used.

The AccuPyc can be operated in the keypad mode when the Windows application
is closed.

Keypad Not used with AccuPyc software application.
Power indicator A green LED which illuminates when the analyzer is powered on.

1 - 4 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



REAR

Component Description
Analysis module
connector

Used to connect up to five analysis modules to the initial control / analysis mod-
ule. Each module contains analysis module input and output connectors.

Brightness control Used to adjust the brightness of the display. See "Brightness Control" on page J
- 9.

Dust filter (not
shown)

(For 2000 cm3 units only.) Traps sample dust to protect internal valves.

Ethernet port Provides for setting up for e-mailing reports, sending data to a web browser, or
interfacing with the AccuPyc Windows application.

Gas inlet port Use to connect the analysis gas; helium is recommended. If multiple analysis
modules are attached, each module contains a gas inlet port. Multiple gases can
be attached using the Multigas option. See "Multigas Option" on page I - 1.

On/Off switch For powering the analyzer on and off.
Power connector For connecting the power source to the instrument.
RS-232 port Used to transmit data only when using the keypad function.
USB connectors Use for connecting a keyboard, printer, or balance to the isntrument.

Rear
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1 About the AccuPyc II 1340 Pycnometer

ABOUT THE SOFTWARE

The AccuPyc II Pycnometer’s unique run precision reports data from five consecutive runs that are
within a user-specified tolerance. This feature allows early termination of analyses, thereby decreasing
the number of runs needed for accurate results.

Analysis provides the measurement of sample volume, from which density can be derived automatically
if the sample mass is entered. The unit comes preprogrammed with default conditions and ready to
perform analyses. It can be reprogrammed to meet specific needs. Analyses can be modified by entering
the number of purges and purge fill pressure, number of cycles and cycle fill pressure, equilibration rate,
and run precision. Modifying these parameters allow control of the primary portions of the analysis;
purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypad mode. For example; if
the computer is inoperative for some reason, analyses can be performed using the keypad.

If running the FoamPyc module, an option to select a Standard method is available so that analyses on
other types of sample materials can be performed.

Hardware and software installation instructions are found in "Installation Instructions" on page J - 1.

1 - 6 AccuPyc II Operator Manual — (Rev -)
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EQUIPMENT OPTIONS

HIGH PRESSURE CORE PYCNOMETER

Gas pycnometry is recognized as one of the most reliable techniques for obtaining skeletal volume and
density. The fully automatic AccuPyc High Pressure pycnometer provides high speed, high precision
volume measurements and density determinations on intact or crushed shale core samples.

The high pressure pycnometer:

l Operates at a pressure of 500 psi to provide a better diffusion of the gas into the rock.

l Has a stainless steel sample chamber with a volume of 100 cm3.

l Has a sample chamber that can accommodate a 48 mm (1.85 in.) diameter core of up to 60 mm (2.40
in.) in length.

LARGE VOLUME CORE PYCNOMETER

The AccuPyc Large Volume pycnometer sample chamber addresses the specific needs of operations that
require pore volume knowledge of intact drilling cores. This instrument eliminates the need to break core
samples into smaller pieces prior to analysis.

The large volume pycnometer:

l Has a large sample chamber with a volume of approximately 2000 cm3.

l Has a sample chamber that can accommodate a 95 mm (3.74 in.) diameter core of up to 278 mm (10.9
in.) in length.

MULTIVOLUME INSERTS

The MultiVolume option is used to analyze smaller sized samples. Options are:

l 1 cm3 nominal cell volume; contains a 0.1 cm3 cup

l 10 cm3 nominal cell volume; contains 1 cm3 and a 3.5 cm3 cups

l 100 cm3 nominal cell volume; contains 10 cm3 and 35 cm3 cups

l 2000 cm3 nominal cell volume, contains 650 cm3 and 1300 cm3 cups

Each kit includes inserts, reference standards, and sample cups. See "Parts and Accessories" on
page 13 - 1.

MULTIGAS OPTION

The Multigas Option allows connection of up to four gases to one analyzer. See "Multigas Option" on
page I - 1 and "Parts and Accessories" on page 13 - 1.

Equipment Options
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1 About the AccuPyc II 1340 Pycnometer

CONFIGURATION OPTIONS

For best fit with a sample, the AccuPyc II is available in multiple configurations.

All sample chamber volumes are nominal unless otherwise specified.

l 1 cm3 sample chamber

l 10 cm3 sample chamber

l 100 cm3 sample chamber

l 350 cm3 sample chamber

l 2000 cm3 sample chamber

Best fit means the sample nearly fills the sample chamber and, therefore, optimizes the precision of the
results.

GLOVE BOX

Provides for analysis of samples in which a controlled environment is required.

Options Description
Configuration l 1 cm3 sample chamber

l 10 cm3 sample chamber

l 100 cm3 sample chamber

l 350 cm3 sample chamber

l 2000 cm3 sample chamber

This unit consists of two separate modules. The controller is placed outside the glove box, while the
analysis module is placed inside the glove box. Up to six analysis modules may be placed in the glove
box, all controlled by one external control module.

1 - 8 AccuPyc II Operator Manual — (Rev -)
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TEMPERATURE CONTROLLED MODULE

Provides for the attachment of an external circulating bath.

Options Description
Configuration l 10 cm3 sample chamber

l 100 cm3 sample chamber

The temperature controlled unit is specifically designed for temperature sensitive materials. This unit is
ideally suited for laboratories in which ambient temperature varies during normal work hours, or in
which subambient cooling is required.

Temperature Controlled Module

AccuPyc II Operator Manual — (Rev -)
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1 About the AccuPyc II 1340 Pycnometer

SPECIFICATIONS

Characteristic Specification
Analysis

Precision Reproducibility typically to within ± 0.01% of the nominal full scale cell
chamber volume. Reproducibility guaranteed to within ± 0.02% of the
nominal full scale volume on clean, dry, thermally equilibrated samples
using helium in the 15° to 35 ºC range (15° to 50 ºC for temperature con-
trolled models).

Accuracy Accurate to within 0.03% of reading, plus 0.03% of sample capacity
Electrical

Voltage 90 to 264 VAC
Power 30 VA
Frequency 50 to 60 Hz

Environment
Temperature Stable between 15° and 35 ºC (59° to 96 ºF)

Temperature controlled AccuPyc - temperature stability is dependent
upon specifications of the installed circulator. Recommended range: 15°
to 50 ºC (59° to 122 ºF)

Humidity 20 to 80% relative, non-condensing
Gases

Research grade helium or nitrogen is recommended. If unavailable, use helium with a dew point of -67
ºC (-88 ºF) or lower. Carbon dioxide, dry air, or argon can also be used for different applications. A
multigas option is available for connection of multiple gases.

Physical
Analysis Module
(1, 10, 100 cm3)

Height.  17.9 cm (7.0 in.)
Width. 22.2 cm (8.7 in.)
Weight. 7.9 kg (17.4 lbs)
Depth. 36.2 cm (14.3 in.)

Analysis Module
(350 cm3)

Height.   25.9 cm (10.2 in.)
Width.   22.2 cm (8.7 in.)
Weight. 10.5 kg (23.2 lbs)
Depth. 36.2 cm (14.3 in.)

Analysis Module
(2000 cm3)

Height.  43 cm (17 in.)
Width. 27 cm (10.6 in.)
Weight. 26 kg (57.0 lbs)
Depth.  36.2 cm (14.3 in.)
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Characteristic Specification
Control Module Height.  17.9 cm (7.0 in.)

Width.  27.3 cm (10.7 in.)
Weight. 3.6 kg (8.0 lbs)
Depth.  36.2 cm (14.3 in.)

Control Analysis Module Height. 17.9 cm (7.0 in.)
Width.  27.3 cm (10.7 in.)
Weight. 9.3 kg (20.5 lbs)
Depth. 36.2 cm (14.3 in.)

TEC Module Height. 27.3 cm (10.7 in.)
Width.  28.7 cm (11.3 in.)
Weight. 13.8 kg (30.5 lbs)
Depth. 36.1 cm (14.2 in.)

Printers
Requirements: l must be USB 2.00 (or newer)

l must have a printer language supported by one of the printer drivers

l cannot be host based
Supported printers l Canon Bubble Jet

l Epson ESCP

l Epson ESCP Raster

l Epson ESCP2

l HP PCL 3

l HP PL 6XL

l Postscript

Sample Chamber
1 cm3 chamber 1.15 cm ID × 1.1 cm Deep (0.45 in. ID × 0.44 in. Deep)
10 cm3 chamber 1.8 cm ID × 3.93 cm Deep (0.72 in. ID × 1.55 in. Deep)
100 cm3 chamber 4.62 cm ID × 6.17 cm Deep (1.82 in. ID × 0.2.43 in. Deep)
350 cm3 chamber 5.84 cm ID × 13.94 cm Deep (2.30 in. ID × 5.49 in. Deep)
2000 cm3 chamber 9.7 cm ID × 26 cm Deep (3.8 in. ID × 10.2 in. Deep)

Computer Requirements
Windows 7 Professional or higher operating system is recommended for the best user
experience. If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

All users of the application will need Read / Write permission to all directories and
subdirectories where the application is installed.

In keeping with a policy of ongoing product improvement, specifications are subject to change without
notice.

Specifications
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1 About the AccuPyc II 1340 Pycnometer

POWER THE ANALYZER ON AND OFF

It is important that a constant temperature be maintained inside the unit because a change in
temperature could alter analysis results. We recommend that the pycnometer remain
powered on at all times to maintain thermal stability.

Do not turn off the analyzer while initialization is in progress. Doing so may damage the
instrument.

When the analyzer is powered on, after a few seconds, the system vents automatically and the green
indicator light on the front panel illuminates. Allow approximately 30 minutes for the analyzer to warm
before performing analyses. For analyses that require very precise results, allow the analyzer to warm a
minimum of two hours. If running the analyzer with a computer:

l Power ON. Power on the equipment in the following order:

o Computer
o Monitor
o Printer
o Analyzer
o Start software application

l Power OFF. Power off the equipment in the following order:

o Analyzer. Allow any analyses in progress to complete prior to powering off.
o Software application. Always exit the analysis program before powering off. Failure to

do so could result in loss of data.
o Computer
o Monitor
o Printer

If running the analyzer without a computer:
l Power ON

o Analyzer.

l Power OFF. Power off the equipment in the following order:

o Allow any analyses in progress to complete prior to powering off the analyzer.
o Printer
o Analyzer
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2 DATA ENTRY WITH KEYPAD
Data can be entered into the system using either a:

l Keypad (or a keyboard). Used if a computer with the analyzer software installed is not connected to
the analyzer. In this case, any section of this manual referring to software can be omitted. All instruc-
tions specific to the keypad are designated with the icon specified in the section "About this Manual"
on page iii.

l Computer. Used if the computer with analysis software is installed and connected to the analysis
module. In this case, this section of this manual can be skipped.

ABOUT THE DISPLAY
The display provides information about the analyzer and the current operation. During operations,
different types of information are shown in lines two, three, and four. Line one always displays the unit
and serial number. If the Alt key is pressed, the 3 in 10 cm3 will change to a + (plus sign). This is an
example of the display when the analyzer is in an idle state, or the Reload prompt.

Line Description
First Displays the unit number, serial number, and nominal cell volume of the

selected unit. Up to five analysis modules may be attached; though the ini-
tial module, containing the keypad and display, will control all units.

Second At the Reload prompt, manual control, or an automatic operation, this line
contains three characters, separated with dashes. The first character
represents the Fill valve, the second represents the Expand valve, and the
third represents the Vent valve.

Valve states: X = Closed, O = Open

During user interface, this line shows the command currently in use.
Third Displays status of the current operation, or Reload when in an idle state.

When the Reload prompt is displayed, this line may also contain an aster-
isk (*), indicating there is a message in the queue. Refer to "Error Mes-
sages" on page A - 1. During certain functions (such as Setup), this line
contains a prompt for additional information.

2 Data Entry with Keypad
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2 Data Entry with Keypad

Line Description
Fourth At the Reload prompt, shows the current pressure and temperature

alternately, where:

l P = Pressure

l T = Temperature

This line is also used to choose options, enter information, or provide
information about the current operation.

ABOUT THE KEYPAD

A keyboard can be connected to the USB port on the rear panel of the AccuPyc II. Com-
mands can be entered from either the keypad or the keyboard.

Most keys on the keypad perform one primary and one alternate function. The primary function of any
key is indicated by the number or command on the face of the key. The alternate function is indicated by
the command above the key. The top right corner of the display screen will show a + (plus sign) when
the Alt key is pressed and the alternate function mode is entered. See "About the Display" on the
previous page.

To select the:

l Primary function. Press only the key. Primary functions are labeled on the key face. For example;
press 4 to enter the number 4.

l Alternate function. Press Alt, then press the key. Alternate functions have blue labels above the
key. For example; press Alt + 4 to start an analysis. If the Alt key is pressed accidentally, pressing it
a second time will cancel its function.

The alternate functions for keys 7 (FILL), 8 (EXPAND), and 9 (VENT) are executed differently. Press
Alt + 1 first to enter Manual mode then press the alternate key. For example: press Alt + 1 + 7 to
manually control the Fill valve. Press Alt + CLEAR to exit Manual mode.
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Functions can be entered from the keyboard.

Keypad Function Key Sequences Description
Keypad Keyboard

Decimal ( . ) . . Enter a decimal point, a dash for sample or
instrument ID, a slash for date, or a colon for
time

Number keys ( 0
through 9 )

0 - 9 0 - 9 Enters the numbers 0 through 9

Calibrate Alt + .
(decimal)

Ctrl + O Calibrates the pycnometer.

Zero Alt + 0 Ctrl + Z Zeroes the pressure transducer.
Manual Alt + 1 Ctrl + Y Provides manual control to open and close

valves.

l Fill (Key 7)

l Expand (Key 8)

l Vent (Key 9)

The state of the valve is shown on the second
line of the display, where X=Closed and
O=Open.

Alt + CLEAR exits manual mode.
Set Up Alt + 2 Ctrl + U Display or edit:

l Analysis parameters

l Report options

l Calibration data

l Data transmission parameters

l Unit types

l Operating language

l Date and time

Keypad and Keyboard Functions

About the Keypad
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2 Data Entry with Keypad

Keypad Function Key Sequences Description
Keypad Keyboard

Transmit Alt + 3 Ctrl + T Transmits analysis or calibration data. Transmits
a partial report if an automatic operation is in
progress.

Analyze Alt + 4 Ctrl + A Performs an analysis.
Review Alt + 5 Ctrl + R Review completed analysis or calibration data.
Print Alt + 6 Ctrl + P Prints an analysis or calibration report. If an auto-

matic operation is in progress, prints a partial
report.

Unit Alt +
CHOICE +
(unit number)

N/A Selects unit (when multiple analysis modules are
attached).

Escape Alt +
CLEAR

Esc Discards all data entered in the current mode
and returns to display mode. Cancels an auto-
matic operation in progress. Exits manual mode.

CHOICE CHOICE Ctrl + N Display the next message when in display mode.
Display the next multiple choice item when in
command mode.

CLEAR CLEAR Ctrl + X Clear a message when in display mode.
Clear an entry when in command mode.

ENTER ENTER Enter or Ctrl +
M

Complete an entry or begin an action.

SAVE SAVE Ctrl + W Save the information and return to display mode.

Keypad and Keyboard Functions (continued)
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CANCEL AN ANALYSIS

To cancel an analysis, press Alt + CLEAR.

Press ENTER within five seconds to cancel the operation. A notification that the automatic operation
has been canceled will be displayed.

When canceling an operation, messages are displayed indicating that termination is in progress. The
termination process, which vents the system, takes about 30 seconds and returns to the Reload prompt.

To view the data that have been collected, press CHOICE.

The following prompt is displayed if no cycles have been completed.

MANUAL MODE

Press Alt + 1 to enter manual mode, allowing manual control of the Bypass, Fill, Expansion, and Vent
valves.

The Bypass valve is only available on the 2000 cm3 units and the High Pressure Core Pycno-
meter units.

Cancel an Analysis
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2 Data Entry with Keypad

Display Text Description
Manual WhenManual is shown, manually open and close the Fill, Expansion,

and Vent valves by pressing:

l 5 - Opens and closes the Bypass valve

l 7 - Opens and closes the Fill valve

l 8 - Opens and closes the Expansion valve

l 9 - Opens and closes the Vent valve

The three characters in the second line of the display show the state of
the valves (Fill, Expansion, Vent). X = Closed. O = Open.

Press SAVE to exit Manual mode and return to display mode.

Prolonged opening of all three valves at one time may cause excessive loss of helium.

TRANSMIT

The AccuPyc RS-232 interface transmits report data to a computer using the standard ASCII file format.
Reports may be transmitted in a single column format or a spreadsheet format. See "Transmitted Data"
on page D - 1.

Press Alt + 3 to transmit report data.

Press Alt + CLEAR to cancel report data transmission.
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ANALYSIS PARAMETERS

This option enables specific analysis and calibration parameters. Although the Setup Type is shown as
Analysis Parameters, these same prompts are used to specify calibration parameters. The pycnometer is
shipped with default values; however, these settings may be modified to meet laboratory requirements.

After each selection, press Enter to display the next prompt. If data results are to be e-mailed
automatically after analysis, specify e-mail parameters in "Setup Reports" on page 2 - 9.

Enter appropriate analysis and report parameters for the current analysis. The chosen or specified
parameters in Set Up determine what prompts and information are displayed for the analysis.

Display Text Description
Setup Type?
Analysis Parameters

Press ENTER to accept Analysis Parameters.

Number of Purges: Key in the number of purges to be performed. Purging cleans the sample
cell and expansion chambers before an analysis begins. The greater the
number of purges, the cleaner the sample will be when analyzed.

The range is 0 to 999. For calibration, 10 is sufficient.
Purges Fill Pressure Key in the fill pressure. For most applications, the default of 19.500 psig

is adequate. Typically, the greater the fill pressure, the easier it is to
measure the volume precisely. However, a lower pressure may be
required for some samples.

The range is psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

Number of Cycles Key in the number of cycles to be performed. A cycle is a series of
functions which equal to a single volume measurement.

The range is 1 to 999. For calibration, 10 is sufficient.
Cycle Fill Pressure Key in the fill pressure. For most applications, the default of 19.500 psig

is adequate.

The range is psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

P1, P2 end by?
[selection]

Choose the manner in which to end the pressure measurement. Press
CHOICE to make a selection.

The available options are Equilibrate and Fixed interval.

Analysis Parameters
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2 Data Entry with Keypad

Display Text Description
Equilibration Rate: (Does
not display for Fixed
Intervals)

Select Equilibrate at the P1, P2 end by? prompt. Pressure measurement
will end when the entered rate is obtained. Key in the equilibration rate.

A high rate will produce faster results, but results may not be as precise
as desired. The lowest rates may cause errors when some materials (such
as those with appreciable vapor pressures or organics) are analyzed.

The default setting is 0.0050 psig/min.
The range in psig/min is 0.0001 to 9.0000.
The range in kPag/min is 0.0007 to 62.0500.

Interval Time: (Does not
display for Equilibrate)

Select the Fixed interval at the P1, P2 end by? prompt. Pressure
measurement ends when the specified time is reached. Key in the interval
time.

The range is 10 to 99999 s (seconds).
Use Run Precision? Allows early termination of the analysis when certain criteria are met.

l Yes. The analysis terminates after five consecutive cycles are within
the specified tolerance. Always request a large number (50 to 99) of
runs. The number of runs is determined through the Number of Cycles
option. With a small number of runs, the analysis stops when the selec-
ted number is reached, even if the specified tolerance has not been
met.

l No. Run Precision is not used.
Percent Full Scale: This prompt only displays if Yes is selected for Run Precision and more

than five cycles have been requested.

Enter the run precision volume tolerance which is expressed as a
percentage of nominal cell volume (sample capacity).

The range is 0.01% to 50.00%.
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SETUP REPORTS

The Report Options command enables the report mode (density or volume for analysis) and specification
of the report destination. After analysis or calibration, the display returns to the Reload prompt. An
asterisk (*) in the third line of the display indicates an error message exists.

A report is generated automatically to the destination selected at the Setup > Report Options as follows:

l Printer. Report is automatically sent to the printer.

l Transmission line. Report is automatically sent through the serial line to an attached device for this
purpose.

l E-mail. Report is e-mailed to the address specified (when connected to a network).

To view report data by points, use the Review function. See "Review Data" on page 2 - 11.

Field or Button Description
Setup Type?
Report Options

Press CHOICE until Report Options is displayed.

Report Options
Anls Display Mode?
Density

Press CHOICE to select Density, Volume or Specific Gravity, the mode
in which the analysis report will be displayed. When Density is selected,
a Sample Mass? prompt displays during the Analysis function. Enter a
value for the sample mass. For accurate data, the sample mass must be
entered when choosing Density.

Report Options
Request Sample ID?

A sample ID (identification) is a unique identifier of the sample. Using
sample IDs can help keep track of data from multiple analyses and can
be used as a date and time stamp. A Sample ID prompt displays during
the analysis operation, allowing entry of the identification when after
selecting Yes to this prompt. Press CHOICE to select Yes or No.

Report Options
Request Description?

Provides entry of additional descriptive information. This prompt
typically is used when a computer keyboard is attached. All system
commands can be executed on the keyboard. Press CHOICE to select
Yes or No.

Report Options
Print Report?

Provides automatic generating of a report after an analysis or cal-
ibration. The type of printer is selected at the Printer? prompt. Press
CHOICE to select Yes or No.

Setup Reports
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2 Data Entry with Keypad

Field or Button Description
Report Options
Transmit Report?

Provides transmission of analysis or calibration data automatically after
the operation. Press CHOICE to select Yes or No. See "Transmitted
Data" on page D - 1.

Report Options
E-mail Report?

Select Yes at this prompt to automatically send an e-mail at the con-
clusion of an analysis or calibration operation. An e-mail address and
server must be specified in order to select Yes. Press CHOICE to select
Yes or No.

Report Options
Printer?
[printer name]

Provides selection of the report printer. This is a system option and does
not have to be specified for each analysis (or calibration). It also applies
for all units when multiple analysis modules are attached. Press
CHOICE to select the appropriate printer. See "Printer Setup" on
page J - 11.

Report Options
Transmission Format?

Select the format of data to be used when transmitting reports. Press
CHOICE to select either the Single Column format or the Spreadsheet
format. See "Transmitted Data" on page D - 1.

Report Options
Request Insert?

Prompts for a MultiVolume insert during analysis or calibration
operations. An insert is a device that can be placed in a sample
chamber, allowing use of a smaller sample cup for analysis of smaller
sample quantities. Inserts are available in MultiVolume Kits for the 1.0,
10, and 100 cm3 pycnometers. Press CHOICE to select Yes or No.

If MultiVolume inserts are not used, select No.
Report Options
Request Cup
Mass?

If Yes is selected, prompts user to enter the mass of the sample cup at
start of analysis.

Request Cup Mass? is only necessary if different size cups are used for calibration
and analysis.

2 - 10 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



REVIEW DATA

The Review function allows review of and editing of the results of the last operation – analysis or
calibration – along with its entered parameters. It is important to review and print the report before
starting another operation. Data are no longer available for review on the display when another operation
is started; however, data results are saved in the control module and can be reviewed using a web
browser.

Review Data with a Web Browser

Data results for the last five analyses are saved in the control module for each attached unit. These
results can be viewed by accessing a web browser. To use this feature, connect to a network.

1. Press Alt + 2 to access Setup. Then press CHOICE until Communications is displayed.

2. Press ENTER to display a prompt showing that the IP Address mode is DHCP.

The display may show Specify, depending on how the IP address was assigned.

3. Press ENTER to view the assigned address on the display. If the address was specified, the dis-
play shows IP Address? and the entered address. This line is editable since it is specified and not
assigned automatically. An assigned address cannot be edited.

4. Make a note of the IP address.

5. Press Alt + CLEAR to return to the Reload prompt.

6. Access the web browser and type in the IP address.

7. Press Enter to display the serial number(s) of the attached unit(s).

8. Click on the serial number of the unit containing the data to review. A window displaying the data
files for the last five analyses, and for the zero (slope) and volume offset files is displayed.

Review Data
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2 Data Entry with Keypad

The files are in .HTML format and are assigned the name used as the Sample ID. If
sample identifications are not used, Untitled is assigned and appended for each file.

9. Click the file to view the data results. The progress of a current operation can be monitored by
reloading the page.

10. Use the File > Print option to print a copy of the results.
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VIEW DATA RESULTS

Press Alt + 5 to view data results.

Reports are generated after analysis and calibration, and remain available for viewing or printing until
another automatic operation (other than zero) is performed. When an automatic operation is performed,
data from the previous operation are no longer available for viewing on the display.

A display report is always generated regardless of the specified destination and contains:

l Analysis. The average density (or volume) and the deviation from the mean.

l Calibration. Average cell (or expansion volume) and the deviation from the mean.

PRINT A FILE

Press Alt + 6 to print a report of the last operation; analysis or calibration. If Alt + 6 is pressed during an
automatic operation, a partial report is printed.

Reports are generated after analysis and calibration, and remain available for viewing or printing until
another automatic operation (other than zero pressure) is performed. Previously generated reports are
deleted whenever a new automatic operation begins.

For each attached analysis module, the data for up to five analyses are stored in the control module.
These data sets can be viewed using a web browser when connected to a network.

An asterisk next to a cycle number indicates that it has not been included in calculations.

l Analysis. Volume, density, deviation for each cycle, an average of all cycles, the date and time the
analysis was started and completed, and the temperature of the cell chamber.

l Calibration. Cell and expansion volumes and deviations for each cycle, an average of all cycles, and
the date and time the calibration started and completed.

View Data Results
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3 ABOUT THE SOFTWARE

The AccuPyc II Pycnometer’s unique run precision reports data from five consecutive runs that are
within a user-specified tolerance. This feature allows early termination of analyses, thereby decreasing
the number of runs needed for accurate results.

Analysis provides the measurement of sample volume, from which density can be derived automatically
if the sample mass is entered. The unit comes preprogrammed with default conditions and ready to
perform analyses. It can be reprogrammed to meet specific needs. Analyses can be modified by entering
the number of purges and purge fill pressure, number of cycles and cycle fill pressure, equilibration rate,
and run precision. Modifying these parameters allow control of the primary portions of the analysis;
purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypad mode. For example; if
the computer is inoperative for some reason, analyses can be performed using the keypad.

If running the FoamPyc module, an option to select a Standard method is available so that analyses on
other types of sample materials can be performed.

Hardware and software installation instructions are found in "Installation Instructions" on page J - 1.

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit Number.
If multiple units (analyzers) are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use to manage files.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations.

A Unit [n] displays on the menu bar for each analyzer attached to the
computer.

Reports Use to run reports and view the results.
Options Use to edit the default method, specify system configuration, and change

presentation options.
Window Use to manage open windows and display a list of open windows. A

checkmark appears to the left of the active window.
Help Provides access to the operator manual and information about the ana-

lyzer.

Main Menu Bar Options

3 About the Software
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3 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description
Add Log Entry Use to enter information to appear in the sample log report that cannot be

recorded automatically through the application. Click the button again to
enter multiple log entries.

Autoscale checkbox When enabled on report parameters windows, allows the x- and y-axes to
be scaled automatically. Autoscale means that the x- and y- ranges will
be set so that all the data is shown. If Autoscale is not selected, the
entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending values
for the x- and / or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to the
computer’s USB port. If a bar code reader is not used, this alphanumeric
field can be used to enter additional information about the sample, such as
a sample lot number, sample ID, etc.

Browse Searches for a file. Select a file from the Name column or from the
library, then click Open. Alternatively, double click the file name to
open (or import) the file.

Cancel Discards any changes or cancels the current process.
Close Closes the active window.
Close All Closes all active windows. If changes were made and not yet saved, a

prompt displays for each changed file providing the option to save the file.
Comments Enter comments about the sample or analysis. Comments display in the

report header.
Delete When working with report parameters, Delete removes the selected

report. Deleted reports will have to be regenerated if deleted in error.

Common Fields and Buttons Table
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Field or Button Description
Destination group box l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

l File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Edit When working with report parameters, highlight the item in the Selected
Reports list box and click Edit to modify the report details.

Exit If a file is open with unsaved changes, a prompt displays providing the
option to save the changes and exit or to exit the application without sav-
ing the changes.

Export Exports isotherm data in a sample information file as a .TXT or .XLS
file. When saved to a file, the data can be imported into other applic-
ations.

File name text box Select a file from either the Name column or from the library. The file
name displays in the File name text box. Click Open or double click the
file name to open the file. To select more than one file, hold down the
Ctrl key on the keyboard while selecting the files, or hold down the Shift
key to select a range of files.

From / To text boxes When working with report parameters windows, enter the From and To
range for x- and / or y-axes.

List Provides the option to create a list of sample or report options file inform-
ation, for example, file name, date / time the file was created or last
edited, file identification and file status.

Name column A list of files in the selected directory or library.
Next Click to move to the next window or next step.
OK Saves and closes the active window.
Open Opens the selected file. Alternatively, double click the file name in the

Name column to open the file.
Prev Click to move to the previous window.
Print Sends the report to the selected destination (screen, printer or file).
Remove Click to remove an item from the list.
Replace Click to select another file where the values will replace the current

file’s values.

Common Fields and Buttons Table (continued)

Common Fields and Buttons
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3 About the Software

Field or Button Description
Replace All Click to select another .SMP file where the values will replace all values

for the active Sample Information file. The original file will remain
unchanged.

Report Click to display a window to specify report output options.

l Start Date. Displays a calendar to select the start date for the report.

l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

l File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Save Saves changes to the active window.
Save As Saves a file in the active window under a different file name.
Start Starts the report, test, analysis, or operation.

Common Fields and Buttons Table (continued)
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OPTION PRESENTATION
Options > Option Presentation

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted. Each
display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample information and parameter files. Navigate to

parameter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously entered
or default parameter files are then accessible using drop-down lists.

Restricted Displays the sample information file in a single window similar to the
Basic display option with certain functions disabled. A password is set
when the Restricted option is selected. That same password must be
entered to change to the Basic or Advanced display option. This display
type is typically used in laboratories where analysis conditions must
remain constant — such as the pharmaceutical industry. The Advanced
option is not available at the bottom of the window when using the
Restricted display option.

Presentation Display Table

Option Presentation

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

3 - 5



3 About the Software

FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selector window, the Mic Description column and the Mic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display a menu of standard
Windows functions.

File Status Description
Analyzing Sample information files that are currently being used for analysis.
Complete Sample information files used in an analysis that has been completed.
No Analysis Sample information files which have not been used to perform an

analysis.

File Status and Description Table

File Type File Name Exten-
sion

Default Location

Analysis conditions .ANC Param Directory
Report options .RPO Param Directory
Sample cup .CUP Param Directory
Sample information .SMP Param Directory
The following file types are available when printing or exporting reports:
Spreadsheet .XLS
Unicode .TXT

File Type, Extension, and Location Table

3 - 6 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



APPLICATION SHORTCUTS

MENU SHORTCUTS

Shortcut menus are available for:

l the analyzer schematic when manual control is enabled

l onscreen graphs and tabular reports.

KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (when
applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the menu
command. For example, to access the File menu, press Alt + F, then press the underlined letter on the
submenu. For example, Alt + F opens the File menu, then press O to access the File Selector for
opening files.

If the underscore does not display beneath the letter on the menu or window, press the Alt
key on the keyboard.

Key Description
F1 Access the operator manual.
F2 Opens the File Selector window listing sample information files.
F3 Opens the File Selector window listing analysis conditions files.
F5 Opens the File Selector window listing report options files.
F6 Tile windows.
F7 Cascade windows.
F8 Start a report.
F9 Close all open reports.
Alt + F4 Exit the program.
Shift + F2 List sample information files.
Shift + F3 List analysis conditions files.
Shift + F5 List report options files.

Keyboard Shortcut Table

Application Shortcuts
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3 About the Software

SAMPLE DEFAULTS
Options > Sample Defaults

A Sample Default determines the default sample identification format and sequence number. A Sample
Default is a template of specifications that go into a newly created sample file. It allows for the
definition of complete sets of parameters for each type of sample commonly analyzed, so that only a
single selection is required for each new sample file created.

EDIT A SAMPLE DEFAULT FILE

Options > Sample Defaults

See "Create Sample Files using Advanced Presentation Option" on page 4 - 2.

ANALYZER STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors, or messages.

Field Description
Analysis /
Calibration /
Message

Select the logs to display.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Instrument Log Fields and Buttons Table
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SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve with manual control enabled.

Closed Valve. White indicates a closed valve with manual control not enabled
Sample Chamber.

Expansion Chamber.

Pressure and temperature readings. Displays for either the expansion chamber
or the sample chamber, depending on the unit configuration.

Gas flow direction.

Analyzer Schematic Icon Table

Show Instrument Schematic
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3 About the Software

Instrument Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations available
for that particular component. To access the shortcut menu, hover the mouse pointer over the component
and right click.

Schematic Shortcut Icon Available Options:
Valve options l Close. Closes the selected valve.

l Open. Opens the selected valve.

Schematic Shortcuts Table

SHOW STATUS

Unit [n] > Show Status

Use to show the current status for each port. If multiple units are attached to the computer, go to Unit [n]
> Show Status for the indicated unit.

Field or Button Description
Cycles The current cycle and the number of cycles requested. For example, 2

(current) of 10 (requested).
Density Last computed density and standard deviation, if applicable.
Elapsed Time The elapsed time of the current step.
Equilibration The measured equilibration rate and the limit.
Operation The operation, task, and the step in progress.
Pressure The pressure in the sample chamber.
Sample The name of the sample file being analyzed.
Temperature The temperature of the sample chamber.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sow Status Fields and Buttons Table
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PRINT, LIST, OR EXPORT FILES
File > Print > [File Type]
File > List > [File Type]
File > Export > [File Type]

Field or Button Description
Date Range Click to filter by a date range.

Directories:
c:\...\data

Displays directories where files are found.

Export Type (Export fea-
ture only)

l Cycle Data. Exports as five columns containing the elapsed time, P1
(fill pressure), P2 (expansion pressure), Volume, and Temperature.

l P[n] Equil Data. Exports as one column of equilibration data.
File name Enter the name of a new sample file.
File Type (Export feature
only)

Select either .XLS or .TXT.

Files Displays the files that fit the search criteria. To select more than one file,
hold down the Ctrl key on the keyboard while selecting the files, or hold
down the Shift key to select a range of files.

File Print, List or Export Fields and Buttons Table

Print, List, or Export Files
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3 About the Software

Field or Button Description
Status To filter by file status, select a status from the drop-down list.

l All. Displays all files

l Analyzing. Sample information files that are currently being used for
analysis.

l Complete. Sample information files used in an analysis that has been
completed.

l No Analysis. Sample information files which have not been used to
perform an analysis.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

File Print, List or Export Fields and Buttons Table (continued)

OPEN A FILE
File > Open > [File Type]

When working with an existing file, it is recommended that a copy of the file be used rather
than the original.

Fields and buttons will vary depending on the file type selected.
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Field or Button Description
Date Range Click to filter by a date range.

Directories:
c:\...\data

Displays directories where files are found.

File name Enter the name of a new sample file.
Files Displays the files that fit the search criteria.
Status To filter by file status, select a status from the drop-down list.

l All. Displays all files

l Analyzing. Sample information files that are currently being used for ana-
lysis.

l Complete. Sample information files used in an analysis that has been com-
pleted.

l No Analysis. Sample information files which have not been used to per-
form an analysis.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed. Parameter
files, sample files, reports, calibration files, and data files are not removed.

1. Insert the Setup CD into the CD drive.

2. Select the Uninstall option.

3. Follow the prompts.

Uninstall the Software
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3 About the Software

INSTALLING ANALYZER SOFTWARE UPGRADE
To install software upgrade on the AccuPyc II module:

1. Turn the On/Off switch on the rear panel in the Off ( O ) position.

2. Insert the USB stick containing the software update into one of the USB connectors on the rear
panel.

3. Place the On/Off switch in the On ( | ) position.

4. After approximately 1-2 minutes of initialization, the software starts to load. The following prompt
is displayed:

5. Once the software is successfully installed, the display will read:

6. Remove the USB stick and store in a secure location.

3 - 14 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



4 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. It
identifies the sample, guides the analysis, and specifies report options and may be created in either
Advanced, Basic, or Restricted presentation display option.

A sample information file can consist of parameter sets; however, parameter sets can also stand alone.
A sample information file may be created either prior to or at the time of analysis.

Parameter sets allow repeated use of the file. For example, if the same analysis conditions exist for
multiple analyses, an Analysis Conditions file containing the recurring conditions can be created. When
the sample file is created, the Analysis Conditions file can be selected for the analysis conditions. Once
it becomes part of the new sample file, the new file can be edited as needed without affecting the
original Analysis Conditions file.

The analysis software contains a sample default method. A default method is a template for sample files
that contains the parameters to be used for an analysis. When a new sample information file is created,
all the parameters are filled with the values in the sample default. See "Create Sample Files" on the
next page.

Specify or change the default presentation option by selecting Options > Option Present-
ation, or select Basic or Advanced from the drop-down list at the bottom of the window.

4 About Sample Files
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4 About Sample Files

CREATE SAMPLE FILES

CREATE SAMPLE FILES USING ADVANCED PRESENTATION OPTION

Each analysis must be linked with a sample information file before the analysis can proceed. A sample
information file can consist of parameter files; however, parameter files can also stand alone. See
"About Parameter Files" on page 5 - 1.

Specify or change the default display option by selecting Options > Option Presentation or click Basic
or Advanced at the bottom of the window.

The values specified in the parameter portions of the default sample file are saved as the defaults for
new sample files. To navigate from one set of parameters to another, select the parameter tab across the
top of the window.

1. Go to Options > Option Presentation > Advanced and ensure Advanced has a checkmark.

2. Go to File > Open > Sample Information.

3. Enter a new file name in the File name text box. Click OK.
4. Enter a sample description in the Sample text box.

5. Enter Operator, Submitter, and Bar Code identification information in the respective text boxes.
This information will display on the Sample Information tab of new sample files. This option may
not display (or may have a different field label) if modified in the sample default method. See
"Sample Defaults" on page 3 - 8.

6. If running the TEC module, select the Sample Cup from the drop-down list and enter the cup mas
in the Cup Mass field. See "Sample Cup " on page 4 - 5. If not running the TEC module, skip this
step.

7. In the Sample Mass field, enter the sample mass.

8. ClickMaterial Parameters to specify material parameters using the Standard method. See
"Material Parameters" on page 4 - 6.

9. The optional user-defined fields in the User Parameters group box may be used to enter and track
information from another analyzer or source, along with other statistical process control (SPC)
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data.

10. Enter any pertinent information about the sample information file in the Comments text box.
Entered comments are displayed in the report header.

11. Click Add Log Entry to enter notes for the analyzer log report. Create entries that cannot be
recorded automatically through the software.

12. To auto-populate fields from another .SMP file, click Replace All, then select a .SMP file that
contains the preferred parameters. Select the file, then click OK.

13. After completing the Sample Information tab, click the other parameter tabs to edit more sample
information file parameters See "About Parameter Files" on page 5 - 1.

14. Click Save, then click Close. To save as a different file name, go to File > Save As and enter a
new file name. The file can also be saved as a different file type such as Analysis Conditions,
Report Options, etc.

Field or Button Description
Cup mass Enter the cup mass.
Geometry * Enter material properties when using the FoamPyc Method.

l User Computed. Select to enter the geometric volume and when
using Method A, the Active Area. Active Area is the total geometric
surface area of the sample - excluding any sides that contain a skin.

l Compute. Select the shape of the sample and enter the dimensions.

l Number of Pieces. The number of pieces making up the sample.
Operator Enter operator identification information. This field label may have been

renamed or may not display if modified in Options > Sample Defaults.
Sample Enter a sample description.
Sample cup Select a sample cup file from the drop down list or click Edit to create

and save a new file for sample cup properties. See "Sample Cup " on
page 4 - 5.

Sample File Fields and Buttons Table

Create Sample Files using Advanced Presentation Option
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4 About Sample Files

Field or Button Description
Sample mass Enter the sample mass.
Submitter Enter submitter identification information. This text box may have been

renamed or may not display if modified in Options > Sample Defaults.
User Parameters group
box

These fields are primarily used for the SPC (Statistical Process Control)
reporting to specify sample characteristics or its manufacturing process
but may be used for other data by entering specific analysis conditions or
sample criteria.

The entered parameters display on the Summary Report. This option may
not display (or may have a different field label) if modified in the through
Options > Sample Defaults.

* Option displays only in the FoamPyc application.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sample File Fields and Buttons Table (continued)

CREATE SAMPLE FILES USING BASIC OR RESTRICTED PRESENTATION OPTION

File > Open > Sample Information

The Basic and Restricted formats use predefined parameter files to create a sample information file.

When using the Basic presentation option, switch to Advanced to edit parameter file values.
When using the Restricted presentation option, parameter files cannot be edited.

1. Go to Options > Option Presentation > Basic (or Restricted).

2. Go to File > Open > Sample Information.

3. Enter a new file name in the File name text box. Click OK.
4. In the Sample field, enter a sample description.

5. In the Sample mass field, enter the sample mass.

6. Click the down arrows to select default parameter files Analysis Conditions and Report Options.

7. ClickMaterial Parameters to specify material parameters using the Standard method. See
"Material Parameters" on page 4 - 6.

8. In the Selected Reports list box, double click reports applicable to this sample file.

9. Click Save, then click Close.
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SAMPLE CUP
File > Open > Sample Cup

(or click the Sample Information tab when in Advanced presentation display)

Use to set the sample cup mass and density. This option is available if enabled in Options > Option
Presentation > Show Cup Properties.

Field or Button Description
Density Enter the density of the sample cup.
Mass Enter the sample cup mass.
Sample Cup Enter a description of the sample cup.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sample Cup Properties Fields and Buttons Table

To have multiple cup selections available in the Sample Cup drop down list:

1. Go to File > Open > Sample Cup.

2. Enter a file name, click OK.
3. Complete the fields for the new sample cup.

4. Click Save and the selection will be available in the Sample Cup drop down list.

Sample Cup
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4 About Sample Files

MATERIAL PARAMETERS
File > Open > [.SMP File]

ClickMaterial Parameters on the Sample Description window. Material parameters are used to report
porosity or total solids concentration when using the Standard analysis method.

Field or Button Description
Bulk Density / Envelope
Density

Calculated from a volume that includes pores.

Liquid Density Density of the liquid.
Solids Density Density of the solid sample.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Material Parameters Fields and Buttons Table
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5 ABOUT PARAMETER FILES
Parameter sets allow repeated use of the file. For example, if the same analysis conditions exist for
multiple analyses, an Analysis Conditions file containing the recurring conditions can be created. When
the sample file is created, the Analysis Conditions file can be selected for the analysis conditions. Once
it becomes part of the new sample file, the new file can be edited as needed without affecting the
original Analysis Conditions file.

The following file types can exist as part of the sample information file as well as individual parameter
files:

File Type File Extension
Analysis Conditions .ANC file extension
Material Parameters .MTP file extension
Report Options .RPO file extension
Sample Cup .CUP file extension

PARAMETER FILES DIRECTORY
Options > Parameter Files Directory

Use to select the location for the predefined parameter files displayed in the drop-down lists when using
the Basic or Restricted presentation option. This configuration option is not available if using the
Restricted presentation option.

The system default directory is the recommended location for saving report options files.
The default directory is ..\param, if accessed from the top-level installation directory.

5 About Parameter Files
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5 About Parameter Files

ANALYSIS CONDITIONS
File > Open > Analysis Conditions

(or click the Analysis Conditions tab when in Advanced presentation display)

Analysis conditions specify the data used to guide an analysis.

1. Go to File > Open > Analysis Conditions and open the analysis conditions (.ANC) file.

2. Click Replace to overwrite analysis conditions with parameters from another Analysis Conditions
file. Select the file containing replacement parameters and click OK.

3. Use the Analysis Conditions Fields and Buttons Table to complete the remaining options.

4. Click Save, then click Close.

Field or Button Description
Analysis Conditions Displays the description of the file. If this is a new file, the

description specified in sample defaults is displayed.
Analysis gas The gas to be used for analysis gas (helium is recommended).
Analysis method See "FoamPyc Application" on page 5 - 4.
Cycle fill pressure Enter the fill pressure for the cycles. Typically, the default of 19.500

psig is appropriate for most samples.
End equilibration by: l Rate. Equilibration ends when the rate of pressure change drops

below the entered amount.

l Time. Equilibration ends when the specified time interval is
attained.

Number of cycles The number of cycles to be performed. A cycle is a series of func-
tions which equals to a single volume measurement.

Analysis Conditions Fields and Buttons Table
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Field or Button Description
Number of purges The number of purges to be performed. A higher number of purges

will mean a cleaner sample.
Percent full scale Enabled when Use run precision is selected. Enter the run precision

volume tolerance which is expressed as a percent of nominal cell
volume (sample capacity).

Purge fill pressure The purge fill pressure (in psig or kPa). For FoamPyc analyses, the
typical pressure is 3.5 psig. For analyses on standard samples, the
measured volume is more precise if a greater fill pressure is used.
The default of 19.500 is appropriate for most standard analyses. Some
materials, such as organic polymers, may require a lower pressure in
order to limit permeability into the sample matrix.

Record P1 equilibration data

Record P2 equilibration data

l Record first. Enter the number of cycles to be recorded at the
beginning of the analysis.

l Record last. Enter the number of points to be recorded at the end
of equilibration.

Use run precision Select to use run precision. This feature provides early termination of
the analysis when certain criteria are met. The analysis terminates
after five consecutive cycles are within the specified tolerance. Typ-
ically, a large number (50 to 99) of cycles is requested. If a small num-
ber of runs is selected, the analysis stops when the entered number is
reached even though the specified tolerance has not been met. If
fewer than five cycles are requested, this feature is disabled. See
"Run Precision" on page B - 6.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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5 About Parameter Files

FOAMPYC APPLICATION
1. Select File > Open > Analysis Conditions to display the Open Analysis Conditions File dialog.

2. Enter a name in the File name field, then click OK.
3. Click Yes to create the file; the Analysis Conditions dialog is displayed.
4. Enter a description in the Analysis Conditions field.

5. Complete the following fields:
l Number of purges

l Purge fill pressure

l Number of cycles

l Cycle fill pressure

6. Choose whether to have equilibration end by rate or time, then enter a value in the adjacent field.

7. If using the run precision feature, select the option and enter an appropriate value in the Percent
full scale field.

8. Choose the Analysis method for this file, then complete the fields that display for that method.

Choice Required Action
Standard Select Record equilibration data then enter the criteria (if recording equilibration

data).
A, B, or C Enter the Resin density.
D Enter the initial and final pressure, and the pressure increment.

Enter Resin density.
E Enter the Low pressure and the Fracture pressure.

Enter Resin density.

Analysis Methods (FoamPyc Only)

9. Click Save, then Close.
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REPORT OPTIONS

File > Open > Report Options

(or click the Report Options tab when in Advanced presentation display)

If using the FoamPyc application, reports for all FoamPyc Methods are fixed and cannot be
created or selected from within the application.

Report options specify the types of reports to be generated from an analysis and allow for customization
of reports such as axis scale, axis range, and column headings.

Report Options files can be customized to accommodate standard analysis requirements. Reports can be
generated automatically after each analysis or at any time during or after an analysis. A report generated
during an analysis only includes data collected up to the time of the report.

Report Options files may be defined to include overlay options. This system allows the overlay of up to 8
plots of different samples onto a plot of the same type or overlay one plot type onto a different plot type
from the same analysis. See "Graph Overlays" on page 7 - 20.

1. Go to File > Open > Report Options and open the report options (.RPO) file.

2. Click Replace to overwrite report options with parameters from another Report Options file.
Select the file containing replacement parameters and click OK.

3. Use the Report Options Fields and Buttons Table to complete the remaining options.

4. Click Save, then click Close.

Report Options
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5 About Parameter Files

5. The Selected Reports list box displays the reports that may be generated.

l To include a report in this file, double click the report name and ensure a check mark
appears to the left.

l To specify report options, highlight the report in the Selected Reports list box, then click
Edit. Make changes as necessary. Click OK. See "Selected Reports" on page 8 - 1 for
details.

8. Click Save, then click Close.

Field or Button Description
Overlays Click to open the Graph Overlay Samples window. Click Browse to

select sample files to overlay into a plot. See "Graph Overlays" on
page 7 - 20.

Report Options Displays the description of the file. If this is a new file, the description
specified in sample defaults is displayed.

Selected Reports list box Select the report names to include in the report.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Report Options Fields and Buttons Table
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COLLECTED DATA
The Collected Data tab displays after an analysis has been completed.

Field or Button Description
Cell Volume Nominal cell volume for the unit or for the selected insert.
Chamber Insert Select the chamber insert size, if applicable. Options will vary depending

on the type of unit being used.

Values in the Volume column are recalculated automatically if the
Chamber Insert selection is changed.

Expansion Volume Expansion volume for the current unit or for the selected insert.

Collected Data Fields and Buttons Table

Collected Data
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5 About Parameter Files

Field or Button Description
Pressure Table Columns Displays information collected during analysis:

l Elapsed Time

l P1 Pressure (fill)

l P2 Pressure (expansion)

l Volume

l Temperature

l Exclude. Click the cell for each cycle to exclude in the average cal-
culations. An x in the cell indicates the cycle will be excluded.
Excluded parameters are marked with an asterisk (*) in the generated
report.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Collected Data Fields and Buttons Table (continued)
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6 PERFORM AN ANALYSIS
An analysis can be performed from either the computer application or directly from the keypad on the
analyzer. If using the keypad only, see "About the Keypad" on page 2 - 2.

See "Handling System Components" on page J - 1.

PREPARING AND LOADING SAMPLE

FOAMPYC METHODS

FoamPyc Methods are intended to conform to the procedures detailed in ASTM Test Methods D-6226
and D-3576. Prepare samples according to the methods outlined in these procedures. Once the sample is
prepared and placed it into the sample chamber, see "Start an Analysis" on page 6 - 3.

STANDARD METHOD

Samples must be properly prepared to obtain accurate results. Samples must be free of moisture in order
to obtain true sample mass and to avoid the distorting effect of water vapor on the volume measurement.
The following procedures are recommended; however, modifications may be necessary for some
materials.

l Heat-sensitive materials may have to be dried by long-time exposure to silica gel, freeze drying, etc.

l Materials having a low melting point may be dried using the purge process. In this case, do not weigh
the sample and cup until after the purge and analysis have been completed.

Avoid exposure of the dried sample to atmospheric moisture during each step of the preparation process.
This means weighing as rapidly as possible and installing in the instrument without unnecessary delay.

Keep the cap on the cell chamber except when actually inserting or removing a sample. If
the chamber remains uncapped, water vapor will adsorb on the inner surface of the chamber
and temperature instability will occur; either condition can affect analysis results.

1. Weigh the empty sample cup.

2. Place as large a quantity of sample as is possible in the cup (cup should be two-thirds full). Pack
powders and fluffy materials (if permissible) to obtain maximum sample weight in the cup.

3. Place the sample cup with sample in a drying oven. The amount of time the sample must be
heated depends on the material and the temperature it will tolerate; this may have to be estab-
lished by other tests.

4. Remove the sample cup from the oven and transfer it to a desiccator provided with active desic-
cant. Allow it to cool until near room temperature. Minimize air exposure of the sample.

5. Use this equation to determine the sample mass. (If volume only is to be measured, skip this step.)

6 Perform an Analysis
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6 Perform an Analysis

Masssample = Masssample+cup – Masscup

6. Remove the cell chamber cap, place the sample cup (with sample) into the cell chamber, then
replace the cap.

It is best not to lay the cap down while loading the sample. Immediately replace the cap when the
sample is loaded. This will prevent particles from accumulating on the greased surface (see
"Handling System Components" on page J - 1 for guidelines on handling system components).

7. If using a temperature-controlled AccuPyc, perform the following steps before proceeding, see
"Start an Analysis" on the facing page.

a. Turn on the bath circulator and specify the temperature for analysis. (Refer to the man-
ufacturer manual for instructions on operating the bath circulator.)

b. Allow the temperature to stabilize to the set temperature. Observe the temperature reading
on instrument schematic.

8. If using a TEC module, ensure the temperature reading has stabilized at the specified point.
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START AN ANALYSIS

START AN ANALYSIS USING THE SOFTWARE

Unit [n] > Sample Analysis

After the sample has been properly prepared and loaded into the sample chamber, start the analysis.

1. Go to Unit [n] > Sample Analysis. Select the sample file to run and click OK. To select a dif-
ferent sample file, click Browse and locate the correct file. If sample file parameters exist in
another file, rather than re-enter them again, click Replace to locate and replace parameters in
the current file with those of the selected file.

2. Edit or enter information for the analysis.

3. Click Report after analysis to generate reports automatically when the analysis is complete.
On the Report Settings window, select the report destination. Click OK to return to the previous
window.

4. Click Export after Analysis analysis to have data exported automatically after the analysis. Or,
if exporting equilibration or cycle data, data can be exported after the analysis using the File >
Export.

5. Ensure the correct Chamber Insert is selected.

6. Click Start to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the Idle state.

Start an Analysis
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6 Perform an Analysis

7. If running a FoamPyc analysis, a message displays indicating the sample should be cut.
a. Remove the sample chamber cap, then remove the cap before performing the next step.

b. Cut the sample and return it to the cup.

c. Remove the cap, place the cup back into the samle chamber. Replace the cap.

d. Click OK to complete the second analysis.

START AN ANALYSIS USING THE KEYPAD

Prerequisites:

l specify analysis and report parameters

l prepare and load sample

The prompts that display for an analysis depend on the options selected in Setup >Analysis Parameters
and Report Options; therefore, the analysis may not display all of the prompts referenced in this
procedure.

1. Press Alt + 4 to display the Sample ID prompt. Enter an appropriate identification. Press .
(decimal) to insert a dash.

2. Press ENTER to display the Description prompt.

Most users display this prompt only when a keyboard is attached to the pycnometer.
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3. Press ENTER to display the Sample Mass prompt. At the Anls Display Mode prompt in the Setup
> Report Options choose Density. Enter the sample mass.

4. If an analytical balance is connected to the module, press the appropriate button on the balance to
transfer the sample mass while this prompt is displayed.

5. Press ENTER to display the Chamber Insert prompt if using an insert. Press CHOICE until the
appropriate insert is displayed, then press ENTER.

6. Press ENTER to begin the analysis. Operational status messages display during analysis.

7. When the analysis has finished, the pycnometer beeps three times and the display returns to the
Reload prompt.

Do not remove the cell chamber cap when the pycnometer is pressurized. The sample may
be discharged from the chamber.

8. Ensure the pressure reads approximately 0 (zero), then remove the cell chamber cap and remove
the sample from the chamber.

9. Replace the cell chamber cap or load another sample.

Display Text Description
Analyze
Sample ID:

Enter sample identification for the current analysis. Sample ID can be up
to 20 numbers and dashes. Press . (decimal) to insert a dash.

Analyze
Description Line 1:

Enter the description for the current sample. A prompt for Line 2 of the
description is displayed.

Analyze
Sample Mass:

Enter a value for the sample mass. Displays only when Density is
selected for Analysis display mode. It does not display if Volume is
selected.

The range is 000.0000 to 10000.0000 g.

The range for the 2000 cm3 AccuPyc is 000.0000 to 25000.0000 g.

This field will also accept input from a connected analytical balance.
While this prompt is displayed, press the appropriate button on the
analytical balance to transfer the mass (refer to the manufacturer’s
manual for the appropriate command).

Start an Analysis using the Keypad
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6 Perform an Analysis

Display Text Description
Analyze
Chamber insert?

Select the insert to be used.

l None, 0.1 cm3 (for 1 cm3 unit)

l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)

l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)

l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Press CHOICE until the appropriate insert is displayed or None if an
insert is not being used.

Analyze
Cup Mass?

Enter the mass of the sample cup.

Analyze
[ENTER] to start
[ESCAPE] to cancel

l ENTER. Starts the analysis. The analysis begins and operational
status messages are continually displayed during analysis

l ESCAPE. Cancels the analysis.

For keypad and / or keyboard functions or commands not listed in this table, see the
Keypad and Keyboard Functions section of this operator manual.

QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis

Use to analyze a series of samples of the same type and same analysis conditions. Sample files will be
created using default values.
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Field or Button Description
Analysis Conditions Select the Analysis Conditions file to be used for analysis. See "Analysis

Conditions" on page 5 - 2.
Chamber Insert Select the chamber insert size to be used in this analysis.
Export after analysis Exports reports automatically to the specified destination and in the

selected format when the analysis is complete.
Material Parameters Click to verify or change the material properties to be used for analysis.

See "Material Parameters" on page 4 - 6.
Report after analysis Generates reports automatically to the specified destination when the

analysis is complete.
Report Options Select the Report Options file to be used for analysis. See "Report

Options" on page 5 - 5.
Sample Displays the sample description specified in the Sample Defaults.
Sample Cup Select the sample cup properties file to be used for analysis. See "Sample

Cup " on page 4 - 5.
Sample Mass Enter the sample mass.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

QuickStart Analysis Fields and Buttons Table

QuickStart Analysis
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6 Perform an Analysis

SEQUENCE ANALYSIS
Unit [n] > Sequence Analysis

Use to analyze the same sample using up to eight different sample files.

Field or Button Description
Chamber Insert Select the chamber insert to be used for analysis.
Clear Removes all entries from the Sample Files list box.
Export After Analysis Exports reports automatically to the specified destination and in the selec-

ted format when the analysis is complete.
Insert Click to browse and select a file to be added to the sequence analysis.

The selected file displays in the Sample Files list box.
Pause between analyses When using multiple sample files and this option is selected, the system

will return to the sample selection window after each analysis. When the
previous analysis completes, click Start to run the next analysis. As each
analysis is run, the sample file is removed from the Samples Files list
box.

Remove Select a file in the Samples Files list box then click Remove to delete
the file from the list.

Replace Select a file in the Samples Files list box then click Replace to substitute
a sample file for the selected one.

Report After Analysis Generates reports automatically to the specified destination when the ana-
lysis is complete.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sequence Analysis Fields and Buttons Table
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REVIEW ANALYSIS

Keypad Function

The Review function allows review of the results of the last analysis operation. Press Alt + 5 to review
or edit analysis results. The analysis information can also be edited through the prompts. The prompts
that display during the analysis review depend on the options selected in Setup > Analysis Parameters
and Report Options.

1. Press Alt + 5 to display the Sample ID prompt containing the sample identification.

2. Press ENTER to display the Description prompt containing an additional description. This prompt
typically is not used unless a keyboard is connected to the analyzer.

3. Press ENTER to display the Sample Mass prompt containing the sample’s mass.

4. Press ENTER. The Start prompt containing the start date and time of the analysis is displayed.

5. Press ENTER. The End prompt containing the ending date and time of the analysis is displayed.

6. Press ENTER. The first of the prompts containing data is displayed. The [n] displayed in the
example prompts represents the cycle number.

7. Continue pressing ENTER to view data. Press CHOICE to exclude data from report cal-
culations. An asterisk will display indicating that it will be excluded. Press CHOICE again to
remove the asterisk.

8. Press SAVE to return to the Reload prompt.

9. Press Alt + 6 to print report results.

Display Text Description
Sample ID:
(sample identification)

Identification entered for the analysis.

Sample Mass:
(mass)

Sample mass for the analysis (if Density was chosen as Analysis display
mode).

Temperature:
(sample chamber temp)

Sample chamber temperature.

Start:
(time) (date)

Time and date the analysis began.

Time: HH:MM:SS

Date: DD/MM/YY

Review Analysis
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6 Perform an Analysis

Display Text Description
End:
(time) (date)

Time and date the analysis completed.

Time: HH:MM:SS

Date: DD/MM/YY
Dn[n] = (density)
Dv[n] = (deviation)

or

V[n] = (volume)
Dv[n] = (deviation)

Density or Volume (depending on the selection made for Analysis display
mode).

[n]: cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk indicates that it has been excluded. Press
CHOICE again to remove the asterisk. Each time CHOICE is pressed
to exclude (or include) the value, a new deviation is calculated and
displayed.

Press SAVE to return to the Reload prompt. Press SAVE to automatically
recalculate the collected data and update data reduction messages in the
queue.

For keypad and / or keyboard functions or commands not listed in this table, see the
Keypad and Keyboard Functions section of this operator manual.
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7 ABOUT REPORTS
Review this section for information on the Reports menu options as well as customizing and running
reports.

Reports can be generated for data:

l collected on a sample that has completed analysis

l collected on a sample currently being analyzed

OPEN AND CLOSE REPORTS
Reports > Open Report... > [.REP File]

Opens saved reports.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.

START REPORTS
Reports > Start Report

1. Click Reports, then Start Report.

2. Select a file from the Files list. Ensure the selected file has a status of either Complete or Ana-
lyzing.. To select more than one file, hold down the Ctrl key on the keyboard while selecting the
files, or hold down the Shift key to select a range of files.

If only one report file was selected in Step 1, the Selected Reports window displays allow-
ing the option to select additional reports. Select additional reports as needed, then click
OK. If multiple files were selected, the reports are displayed in a tiled format.

3. Select the report destination in the Settings group box, then click OK.
4. When the Selected Reports box appears, check the reports to be displayed, then click OK. The

reports will display at the selected destination.

7 About Reports
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7 About Reports

SPC REPORT
Reports > SPC Report Options

Use to generate reports with various Statistical Process Control (SPC) options. All selected variables
must be computed for each sample file used in an SPC report; therefore, it is more efficient to select
only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and graph
selections in Reports > Control Chart.

REGRESSION REPORT
Use to generate a Statistical Process Control (SPC) Regression report to determine the interdependency
between two variables. Up to three dependent variables (y-axis) may be plotted against a single
independent variable (x-axis). The degree of correlation between the variables is also reported.
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Field or Button Description
Autoscale When enabled, allows the x- and y-axes to be scaled automatically.
Axis Range Enter the beginning and ending values for the x- and y-axis ranges. These

fields are disabled if Autoscale is selected.
Label data Use to label the points on the plot to correspond with the values in the

sample files.
Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

Do not show me this message again.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.

Regression Report Fields and Buttons Table

Regression Report
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7 About Reports

Field or Button Description
Samples To select more than one file, hold down the Ctrl key on the keyboard

while selecting the files, or hold down the Shift key to select a range of
files.

l Available Files. Contains files located in the directory specified in the
Look In text box.

l Selected Files. Files added from the Available Files list box.

l Add / Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back
to the Available Files list box. Or double click the file name to move
the file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.
Tabular report Generates a tabular report of the included samples. A tabular report

contains the numeric values contributed by each sample.
X- and Y-Axis Variable Use to designate the x- and y-axes variables. The variables in the drop-

down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Regression Report Fields and Buttons Table (continued)
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CONTROL CHART REPORT
Reports > Control Chart

Use to generate a Statistical Process Control (SPC) control chart report which plots the changes in a
statistic.

Control Chart Report
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7 About Reports

Field or Button Description
Graph [n] Click to define the y-axis of each graph.

l Statistic. Displays the SPC variables selected on the Reports > SPC
Report Options window. The selected variable will be plotted against
time. This selection also becomes the y-axis label.

l Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

l Center Line. Displays placement options for the center line in the
graph. Choose Entered to specify placement of the line.

l Limit Lines group box. Displays limiting lines options. Lines can be
placed at some multiple of the standard deviation or at specified pos-
itions (Entered). When Entered is selected, enter the High limit and
Low limit fields with appropriate values.

Control Chart Fields and Buttons Table
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Field or Button Description
Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

Do not show me this message again.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.

Control Chart Fields and Buttons Table (continued)

Control Chart Report
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7 About Reports

Field or Button Description
Samples To select more than one file, hold down the Ctrl key on the keyboard

while selecting the files, or hold down the Shift key to select a range of
files.

l Available Files. Contains files located in the directory specified in the
Look In text box.

l Selected Files. Files added from the Available Files list box.

l Add / Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back
to the Available Files list box. Or double click the file name to move
the file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.
Tabular report Generates a tabular report of the included samples. A tabular report con-

tains the numeric values contributed by each sample.
X Axis Order by Select the order in which x-axis statistics are placed. Sort by:

l Time. Time the files were analyzed.

l File name. Alphanumeric order.

l Date. Date the files were analyzed.

l Minutes. Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

l Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Control Chart Fields and Buttons Table (continued)
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REPORT FEATURES AND SHORTCUTS
Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature, or axis
cross-hairs.

l After analysis, reports can be viewed, printed, and / or copied and pasted into other documents.

l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.

l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and / or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date / time, ana-
lysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.

l Summary report headers contain the same information as tabular and graphical reports with the excep-
tion of notes.

Report Features and Shortcuts
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7 About Reports

REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Field or Button Description
Copy header as text Use to copy the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Use to edit the report title and / or graphic in the report header.

Report header Shortcut Field and Button Table
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REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top of the
report header. To view a specific report, either select the tab or the report in the Reports list box, then
click Show.

Field or Button Description
Default Style Click to specify default report parameters for fonts and curve properties.

l Font Type. Use to edit the font type and attributes for the selected
item. Select an item in the list, click Edit, and select from various font
options.

l Thickness. Enter a thickness number for the curve.

l Histogram Fill Style. Select a histogram fill option.

l Graph border line thickness. Enter a thickness number for the graph
border.

Delete Deletes the selected report in the Reports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide Hides (or temporarily removes) the selected report from the tabbed view.
The report name remains in the Reports list box.

Print Displays the Print window for report output.

l Name drop-down list and Properties. Select the printer from the drop-
down list and click Properties to change printer setup, etc.

l Copies. Select the number of copies and collate option.

l Current. Selects the active report (or selected tab).

l All. Selects all reports in the Reports list box.

l Shown. Selects only the reports not hidden.

l Clear. Clears all selections.

Report Toolbar Fields and Buttons Table

Report Toolbar
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7 About Reports

Field or Button Description
Reports list box Contains a list of all generated reports. The same reports display as tabs

at the top of the report header unless the report has been hidden using the
Hide button.

Show Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Report Toolbar Fields and Buttons Table (continued)
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GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right clicking in the body of the graph report.

Field or Button Description
Autoscale Returns the report to full view after using the zoom feature.
Copy as Metafile Copies the report data as a metafile (.WMF)
Copy as Text Copies the report data to the clipboard. It can then be pasted into

other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Graph Shortcuts Options and Description Table

Graph Features and Shortcuts
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7 About Reports

Field or Button Description
Edit axis Use to edit the selected axis properties.

l Title. Use to edit the selected axis label.

l Title font. Use to modify the font for the selected axis label.
Deselect the Use default font to enable font options. Select new
font attributes for the report data. To return to the default fonts,
enable Use default font.

l Linear / Logarithmic. Select the option to scale the graph as lin-
ear or logarithmic.

l Autoscale minimum / maximum. To manually specify minimum
/ maximum autoscale, deselect the option and enter the new
amount in the text box.

l Invert scale. Use to invert the scale.

l Scale font. Use to modify the font for the scale label. Deselect
Use default font to enable font options.

l Grid lines. Use to change how to display major / minor grid
lines.

Graph Shortcuts Options and Description Table (continued)
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Field or Button Description
Edit curve Use to edit selected curve properties.

l Title. Use to change the title of the selected curve.

l Style. Use to select another style for the collected data curve.

l Curve group box. Use to change the interpolation, point style
and pen style for the selected curve. These options are disabled
if Use default fill style is selected in the Histogram group box.

Color. Click to change the curve color.

Use default thickness. Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text
box.

l Histogram group box. Enabled only if Histogram is selected in
the Style drop-down list. Use to specify the type of fill, fill color
and label position for the selected curve.

l Label. Select where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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7 About Reports

Field or Button Description
Edit legend Use to change the legend location and font. Click Font to modify

font attributes. Deselect the Use default font to enable font options.
Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Edit title Use to change the graph title and font. Click Font to font attributes.
Deselect the Use default font to enable font options. Select new font
attributes for the report data. To return to the default fonts, enable
Use default font.

Hide curve Hides selected curve.
Redraw Sets the axis boundaries to the original view. This option also

removes cross-hairs.
Show curve Displays a list of all curves. Select the curve to display.

Graph Shortcuts Options and Description Table (continued)
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Axis Cross-hair

The cross-hair feature displays axis coordinates.

1. Left click on the graph to view the cross-hair coordinates.

2. To remove the cross-hair, right click in the graph area and select either Autoscale all axes or
Reset axis limits to initial setting.

Graph Features and Shortcuts
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7 About Reports

Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using Restricted
presentation option.

Field or Button Description
Grid Line Styles Select if the major and / or minor grid lines should appear as solid or dot-

ted lines.
X-Axis / Y-Axis Select major and / or minor lines to display in reports for the logarithmic

and linear scales. Deselect this option to remove the grid lines.

Graph Grid Lines Fields and Buttons Table

Zoom Feature

Use the zoom feature to examine graph details.

1. Open the graph.

2. Hold down the left mouse button, then drag the mouse pointer across the graphical area to be
enlarged. A box will display in the area to be enlarged.

3. Release the mouse button. The enlarged area fills the graph area. To return to normal view, right
click in the graph area, then select either Autoscale or Redraw on the shortcut menu.
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report.

Field or Button Description
Align column Change the column alignment to either left, right, or centered.
Column font Change the column font. Deselect the Use default font to enable font

options. Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Copy table as text Copy the report contents to the clipboard as tab-delimited text. It can then
be pasted into another document.

Edit title Change the report title in the tabular data area.
Header font Change the column header font. Deselect the Use default font to enable

font options. Select new font attributes for the report data. To return to
the default fonts, enable Use default font.

Hide column Hide the selected column.
Move column Move the selected column left or right.
Rename column Rename the selected column.
Resize column Resize the width of the selected column.
Show column Show a hidden column.

Tabular Reports Shortcut Options and Descriptions Table

Tabular Report Features and Shortcuts
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7 About Reports

GRAPH OVERLAYS

Use the graph overlay functions to compare multiple graph options. Graphical lines are differentiated by
the use of varying colored symbols outlined on a legend. Overlays may be generated in two ways:

l Multiple Graph Overlays. Overlay two different types of graphs from one sample.

l Multiple Sample Overlays. Overlay up to 8 graphs of the same type with that of the current plot.

This feature is available only when using Advanced presentation display.

GENERATING GRAPH OVERLAYS

Use graph overlays when graphically comparing results for multiple samples, or multiple graphs for one
sample. Graphical lines are generated in different colors and denoted in a legend on the report.

Use the Advanced format to specify graph overlays. Graph overlays can be implemented in two ways:

l Multiple Sample Overlays
Overlay results for up to eight samples on top of a previously selected sample.

l Multiple Graph Overlays
Overlay two different types of graphs from one sample.
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GENERATE MULTIPLE SAMPLE OVERLAYS

Use a copy of a file rather than the original file when performing a sample overlay.

1. Go to Options > Option Presentation and ensure there is a checkmark to the left of Advanced.

2. Go to File > Open > Sample Information and open the sample file.

3. On the Report Options tab, in the Selected Reports list box, select the reports to be used by double
clicking the report name. This places a checkmark to the left of each selected report.

4. Highlight the graph to be used for multiple overlays, then click Edit.

5. On the overlay window, click the down arrow to the right of the Overlay field and select the Over-
lay Samples Select other options as needed, then Click OK.

6. In the Report Options tab, click Overlays.

Generate Multiple Sample Overlays
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7 About Reports

7. Om the Graph Overlays window, click Browse to locate and select which graphs are to be over-
laid. Click OK.

8. Go to Reports > Start Report. Select the report destination in the Settings group box. Select the
overlay file name in the Files list box, then click OK.

9. In the pop-up Selected Reports list box, reports can be added or removed by double clicking the
entry. Selected reports as indicated by a checkmark to the left. Click OK.

10. Reports display in a tabbed format. Click each tab to view each report.

GENERATE MULTIPLE GRAPH OVERLAYS

Multiple graph overlays can be generated by:

1. Go to Options > Option Presentation and ensure there is a checkmark to the left of Advanced.

2. Go to File > Open > Sample Information and open the sample file.

3. On the Report Options tab, in the Selected Reports list box, highlight the graph to be used for mul-
tiple overlays, then click Edit.

4. Click the down arrow to the right of the Overlay field and select a graph. This selection will over-
lay the graph selected in the Y-axis field.
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5. Click OK then click Save.
6. Go to Reports > Start Report. Select the report destination in the Settings group box. Select the

overlay file name in the Files list box, then click OK.
7. In the pop-up Selected Reports list box, reports can be added or removed by double clicking the

entry. Selected reports as indicated by a checkmark to the left. Click OK.
8. Reports display in a tabbed format. Click each tab to view each report.

Generate Multiple Graph Overlays
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7 About Reports

REPORT EXAMPLES

COMBINED REPORT
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SUMMARY REPORT EXAMPLE

Summary Report Example
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7 About Reports

TABULAR REPORT EXAMPLE
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GRAPH REPORT EXAMPLE

Graph Report Example
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7 About Reports

OVERLAY REPORT EXAMPLE
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EQUILIBRATION REPORT EXAMPLE

Equilibration Report Example
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7 About Reports

SAMPLE LOG EXAMPLE
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8 SELECTED REPORTS

COMBINED REPORT

The Combined Reports option creates a single report from all selected reports. The Combined Report
contains no breaks between reports and no headings. Highlight the report, then click Edit to edit report
details.

DENSITY AND VOLUME TABLE

8 Selected Reports
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8 Selected Reports

Field or Button Description
Columns 1 though 7 Select a variable for each column.
Name Enter the name of the report.
Summary Data Select the average, standard deviation, and coefficient of variation (C.V.)

for report parameters.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Density and Volume Fields and Buttons Table

DENSITY VS CYCLE NUMBER TREND PLOT

There are four types of graphical reports available. Report titles are based on the parameters selected for
the X-axis and Y-axis.

Field or Button Description
Autoscale x-axis
Autoscale y-axis

When enabled on the report parameters windows, allows the x- and y-
axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Overlay Select overlay plot options.

l A second Y-axis can be selected to overlay with the variable in the Y-
Axis field.

or

l Select Overlay Samples to overlay data of the type selected in the Y-
Axis field with the same type of data contained in other sample files.
To select other sample files, go to the Report Options tab and click the
Overlays button.

Volume vs Cycle Number Trend Plot Fields and Buttons Table
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Field or Button Description
Plot curve
Plot points

Select to display how data are plotted.

Show +/- Select to place two horizontal lines on the graph. The top line will be
placed at a point relative to the average and standard deviation of the
data. The bottom line will be placed at the point entered in the adjacent
field.

Show Average Select to show the average of all cycles. A horizontal line is placed at the
average point for the cycles.

Show Min
Show Max

Select to show the average of all cycles. Horizontal lines are placed at
the entered limits.

Show Reference Select to show a horizontal line placed at a reference point specified in
the adjacent field.

X-Axis Variables available for the X-axis.
Y-Axis Variables available for the Y-axis.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Volume vs Cycle Number Trend Plot Fields and Buttons Table (continued)

DENSITY VS TIME TREND PLOT

The Density vs Cycle Number Trend Plot and the Volume vs Cycle Number are identical unless
otherwise noted.. See "Density vs Cycle Number Trend Plot" on the previous page.

Density vs Time Trend Plot
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8 Selected Reports

EQUILIBRATION REPORT

This report is available only if the Record equilibration data option was selected on the Analysis
Conditions tab.

Field or Button Description
Autoscale x-axis
Autoscale y-axis

When enabled on the report parameters windows, allows the x- and y-
axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

From cycle Enter the beginning report cycle.
Report every Enter which cycle to report.
Overlay cycles Select to overlay the number of cycles entered in the Report total of field.
Overlay samples Select to overlay the last cycle in the current file with the last cycle con-

tained in other files. Click Overlays on the Report Options tab to select
the other sample files.

Plot curve
Plot points

Select to display how data are plotted.

Report quantity Select a variable to be reported.
Report total of Enter the number of cycles for this report. Enter up to 8 cycles.
Report every Enter time between cycles. Up to 60 seconds can be entered.
Show plot Generates a plot (graph) for the Report quantity field selection.
Show table Generates a tabular report for the Report quantity field selection.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Equilibration Report Fields and Buttons Table
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OPTIONS REPORT
The Options report provides information on the sample, its material properties, and analysis conditions.
This report cannot be edited.

PRESSURE AND VOLUME TABLE

The Pressure and Volume Table and the Density and Volume Table are identical unless otherwise noted.
See "Density and Volume Table" on page 8 - 1.

SAMPLE LOG REPORT
The Sample Log report displays:

l Automatic operations

l Information entered using Add Log Entry on the Sample Information tab
l Warnings and / or errors which occurred during analysis

The Sample Log Report cannot be edited.

Options Report
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8 Selected Reports

SUMMARY REPORT

The Summary Report provides a condensed listing of data results. Select the type of information to
include in the report. If Pass/Fail is selected, the Min andMax fields are enabled. Enter the minimum
and maximum values for the pass / fail.

TABULAR REPORT
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Field or Button Description
Columns 1 through 7 Select a variable to appear in each column.

Selections applicable only to the Asphalt configuration:

l Volume (60 °F)

l Density (60 °F)

l Specific Gravity (60 °F)

l Volume (60 °F) Deviation

l Density (60 °F) Deviation

l Specific Gravity (60 °F)) Deviation
Name Enter a name for the report.
Summary Data Select options for reporting the average, standard deviation, and coef-

ficient of variation (C.V.).

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Tabular Report Fields and Buttons Table

TOTAL PORE VOLUME VS TEMPERATURE

The Total Pore Volume vs Temperature and the Density vs Cycle Number Trend Plot are identical
unless otherwise noted. See "Density vs Cycle Number Trend Plot" on page 8 - 2.

Total Pore Volume vs Temperature
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8 Selected Reports

VOLUME VS CYCLE NUMBER TREND PLOT

The Volume vs Cycle Number and the Density vs Cycle Number Trend Plot are identical unless
otherwise noted. See "Density vs Cycle Number Trend Plot" on page 8 - 2.
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9 DIAGNOSTICS USING THE SOFTWARE

Unit [n] > Diagnostics

Performs a leak test for the analysis module.

Field or Button Description
File Shows a status bar of steps complete once the test begins.
Next Starts the next test.
Report after test Automatically generates reports to the selected destination when the test

is complete.
Sequence Sequence number assigned to the test.
Test Select the test from the drop-down list.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Diagnostic Test Fields and Buttons Table

9 Diagnostics using the Software
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10 CALIBRATION
The pycnometer volume should be calibrated every time it is restarted. Cell volume and expansion
volume in the set up parameters are updated automatically upon calibration. Run an analysis with an
empty cup to see how close the average volume is to 0. It should be ± 0.05% of full scale. If it is not
within ± 0.05% of full scale, calibration is required.

If calibrating using the keypad, see "Calibrate using the Keypad" on page 10 - 14.

CALIBRATE USING THE SOFTWARE

CALIBRATION REPORT

Unit [n] > Calibration > Calibration Report

1. Select the type of chamber insert used.

2. Select the report destination.

3. Click OK to generate the report.

10 Calibration
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10 Calibration

CALIBRATE TEMPERATURE OFFSET

Unit [n] > Calibration > Temperature

Opens the Calibrate Temperature Offset box.

Calibrates the temperature offset. Use an external reference device to determine the sample cell
temperature. Enter the value in the field, then click Done.

A Calibration report is not generated for the temperature offset. The entry is recorded in the Instrument
Log. To view the log, go to Unit [n] > Show Instrument Log.

1. Enter the current sample cell temperature.

2. Click Done. Temperature reading will be adjusted to the entered temperature.

CALIBRATE ZERO CELL VOLUME

Unit [n] > Calibration > Zero Cell Volume

Use to calibrate the cell volume offset.
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Field or Button Description
Analysis Conditions Specify conditions for the calibration.

Click Replace to replace the values with those from an existing Analysis
Conditions file. See "Analysis Conditions" on page 5 - 2.

Cell Volume Current cell volume (without an insert) or the volume of the selected
insert.

Expansion Volume Current expansion volume, and the date and time of calibration.

Insert values listed in this table are default values. The insert title can be changed by
the user by clicking Unit > Unit Configuration and changing the Insert title.

Insert
1 cm3 unit

l None

l 0.1 cm3

If None is selected, place an empty sample cup in the chamber.
Insert
10 cm3 unit

l None

l 3.5 cm3

If None is selected, place an empty sample cup in the chamber.
Insert
1.0 cm3and 100 cm3 unit

l None

l 35 cm3

l 10 cm3

If None is selected, place an empty sample cup in the chamber.
Insert
350 cm3 and 2000 cm3
units

l None

l Large

l Small

If None is selected, place an empty sample cup in the chamber.

Calibrate Zero Cell Volume
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10 Calibration

Field or Button Description

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

CALIBRATE ZERO PRESSURE

Unit [n] > Calibration > Zero Pressure

This option zeros the pressure transducer reading.

Click Start to calibrate the pressure offset.

10 - 4 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



RESET PRESSURE CALIBRATION

Unit [n] > Calibration > Reset Pressure Calibration

This procedure resets the pressure calibration to the factory default settings.

This option can be used when the pressure appears not to be reported correctly by the analyzer. For
example: a zero, negative, or unreasonably high reading is being consistently reported. Resetting to
nominal may restore normal pressure readings but a proper calibration should be performed.

A popup warning indicates that when this option is used, the previous pressure calibration is lost and the
nominal calibration is used.

Temperature and volume calibrations are not affected by a reset of the pressure calibration.

Click OK. The nominal calibrations may be sufficient. However, it is recommended to contact your
Micromeritics Service Representative and schedule a proper pressure calibration as soon as possible
since data accuracy may be compromised.

Reset Pressure Calibration
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10 Calibration

CALIBRATE VOLUME SCALE

Unit [n] > Calibration > Calibrate Volume

Calibrates the cell volume offset and expansion volume.

Although the instrument is calibrated prior to shipment, the pycnometer should be recalibrated to
laboratory atmospheric and environmental conditions.

1. On the pressure regulator, turn the pressure control knob clockwise to set the regulator pressure at
21.500 psig (low pressure gauge).

2. Remove the chamber cap and place an empty cup into the sample chamber, then replace the cap.
If an insert is being used, place the insert sample cup into the chamber.

Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands when hand-
ling sample cups, calibration standards, and inserts. See "Handling System Components"
on page J - 1.

3. Go to Unit [n] > Calibration > Calibrate Volume.
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4. Enter the volume of the calibration standard (located on the outside of the calibration standards
case shipped with the instrument) in the Volume of Calibration Standard field.

The value recorded on the case for a 10 cm3 pycnometer is the sum of the two standards, and on
a 350 cm3 pycnometer, the sum of the three standards.

5. Select the Measured option.

6. Click Analysis Conditions to specify calibration parameters. Click Replace and select the
file calstd.anc. The values in the current file will be replaced with those contained in the selected
file. Click OK, then click OK again to return to the Calibrate Volume Scale window.

7. Click Start to begin the first phase of the calibration (volume offset). Status messages display
until this phase is complete. When the phase has finished, a prompt display indicates to insert the
calibration standard.

8. Remove the sample chamber cap, then remove the sample cup from the chamber. Place the cap
back onto the chamber while placing the standard into the cup.

9. Tilt the sample cup and allow the standard to roll gently into the cup to prevent denting of the cup.

Calibrate Volume Scale
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10 Calibration

l one standard is shipped with the 1-, 100-, and 2000 cm3 pycnometers

l two are shipped with the 10 cm3 pycnometer

l three are shipped with the 350 cm3 pycnometer

10. Remove the sample chamber cap, place the sample cup back into the chamber, and replace the
cap. Turn the cap clockwise to tighten.

11. Allow the standards to reach thermal equilibrium with the pycnometer.

l Wait 10 minutes for 1- and 10 cm3 pycnometer

l Wait 15 minutes for the 100 cm3 pycnometer

l Wait 20 minutes for the 350 cm3 pycnometer

l 30 minutes for the 2000 cm3 pycnometer

12. Click Continue to complete the second phase of the calibration (volume scale). Status messages
display until the calibration is complete.

13. Click Done to accept the new values, then click OK.
14. Do not remove the standard from the sample chamber until the operation is verified. See "Verify

Operation" on page 10 - 10.
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Field or Button Description
Analysis Conditions Specify conditions for the calibration.

Click Replace to replace the values with those from an existing Analysis
Conditions file.

Cell Volume Displays the current cell volume (without an insert), or the volume of the
selected insert.

Continue Place the standard into the sample cup and click Continue to complete
the volume scale calibration.

Expansion Volume Displays the current expansion volume, and the date and time of cal-
ibration.

Insert l 1 cm3 unit None, 0.1 cm3

l 10 cm3 unit None, 3.5 cm3

l 1.0 cm3100 cm3 unit None, 35 cm3, 10 cm3

l 350 cm3 and 2000 cm3 units None, Large, Small

If None is selected, pace an empty sample cup in the chamber.
Previously Entered /
Measured

Select the method for calibrating the cell and expansion volumes.

l Previous. Uses the current values.

l Entered. Enables the fields for the cell and expansion volumes.

l Measured. Measure the cell and expansion volumes using a reference
standard.

Start Begins the first segment of the volume offset calibration. Status messages
are shown as the calibration proceeds. When the volume offset cal-
ibration is complete, a prompt displays indicating to insert the standard.

Volume of Calibration
Standard

The volume of the standard used for the previous calibration.

Calibrate Volume Scale Fields and Buttons Table

Calibrate Volume Scale
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10 Calibration

Field or Button Description

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Calibrate Volume Scale Fields and Buttons Table (continued)

VERIFY OPERATION

Verify operation of the pycnometer by performing an analysis on the calibration standard to ensure that
the pycnometer is operating properly.

1. Go to Unit [n] > Sample Analysis.

2. Click OK, then Yes to create a new sample file.

3. Click Replace and select the refanly.smp file. The values in the current file will be replaced
with those contained in refanly.smp. Click OK.

4. Click Report After Analysis. Select the Report after analysis option, then click OK.
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5. Click Start to begin the analysis.
6. Compare the value displayed for the average volume to the value recorded on the calibration stand-

ards case. These two values should agree plus or minus the tolerance obtained using the following
calculation:

Tolerance = (chamber volume * 0.0003) + (Value recorded on Standards case * 0.0003)

Example: calculate the tolerance for a 10 cm3 pycnometer with a value of 6.372242 recorded
on the case as :
Tolerance = (10 * 0.0003) + (6.372242 * 0.0003) = 0.003 + 0.0019116726 = 0.005

If the values do not agree, a leak may be indicated. Check the system for leaks. Then repeat steps
1 through 6. If the values continue to disagree, contact your Micromeritics service representative.
See "Diagnostics using the Software" on page 9 - 1.

7. Remove the standards and place them back into the case.

Verify Operation
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10 Calibration

LOAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File

Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration > Save to
File prior to loading another calibration file. When loading a previously saved calibration file, a backup
of the current file is created and saved as [SN]last.cal. The backup file is overwritten each time a new
one is created.

Changing the calibration may affect the analyzer’s performance.

1. Select the calibration file from the Files list box.

2. Click OK.
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SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using Unit [n] >
Calibration > Load from File menu option.

The default file naming convention for calibration files can be used or the file name can be changed. The
default file name of 0217-001.CAL is interpreted as:

0217 is the analyzer serial number
001 is the sequence number
.CAL is the file name extension

Save Calibration to File
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10 Calibration

CALIBRATE USING THE KEYPAD

CALIBRATE FUNCTION

This command performs a full volume slope and offset calibration. Press ALT + . (decimal) to access
the Calibrate function.

Display Text Description
Calibration Type?
Volume

Press CHOICE until the option is displayed, then press ENTER.

l Volume

l Temperature

l Pressure

l Copy to an external device

l Load from an external device

l Reset Pressure Calibration

CALIBRATION DATA

Display Text Description
Setup Type?
Calibration Data

Press CHOICE until Calibration Data is displayed, then press ENTER.

Calibration Data
Chamber Insert?

Select Yes at the Request insert prompt in Report Options. Press
CHOICE until the appropriate insert is displayed, then press ENTER.

l None, 0.1 cm3 (for 1 cm3 unit)

l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)

l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)

l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)
Calibration Data
Cell Volume:

Displays the cell volume determined during calibration Cell volumes can
also be entered at this prompt. Press ENTER.

The range is 0.01 to 999.0000 cm3.
Calibration Data
Expansion Volume:

Displays the expansion volume determined during calibration. Press
ENTER.

The range is 0.5 to 999.0000 cm3.
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CALIBRATE VOLUME

Place an empty cup into the sample chamber for Cal1 (volume offset). If using an insert, place the insert
and its appropriate sample cup into the sample chamber.

Display Text Description
Calibration Type?
Volume

Press ENTER to accept Volume (default) and display the next prompt.

Calibrate Volume
Chamber insert?

Press CHOICE until the appropriate insert is displayed, then press
ENTER. Yes must be selected for the Request Insert prompt in Report
Options for this prompt to display.

l None, 0.1 cm3 (for 1 cm3 unit)

l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)

l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)

l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)
Calibrate Volume
Volume of Cal Std:

Enter the volume of the calibration standard to be used in the calibration
(located on the outside of the calibration standards case). Some
pycnometers require and are shipped with multiple standards. In this
instance, the value recorded on the case is the sum for all standards and
is the one that should be entered at the prompt. Press ENTER.

The range is 0.1 to 999.0000 cm3.
Calibrate Volume
[ENTER

Press ENTER to begin the calibration or Alt + CLEAR to cancel. The
volume offset is calibrated first (Cal1). When the first calibration is com-
plete, the pycnometer beeps three times and the next prompt is displayed.

Insert Cal Std
[ENTER] to start

Place the calibration standard in the cup in the sample cell chamber and
replace the chamber cap. Press ENTER to calibrate the temperature
offset (Cal2). Calibration continues and operational status messages are
continually displayed. After the operation is complete, the pycnometer
returns to the Reload prompt.

For best results, sample volume should be approximately equal to the
volume of the calibration standard. Therefore, if calibrating the 10 cm3

pycnometer for use with smaller sample volumes, use only one standard.
If using one standard, enter half of the value at the Volume of cal std
prompt. Press Alt + CLEAR to cancel the operation.

Calibrate Volume
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10 Calibration

RESET PRESSURE CALIBRATION

Contact a Micromeritics service representative and schedule a proper pressure calibration
since data accuracy may be compromised.

This option can be used when the pressure is suspected of not being reported correctly by the analyzer.
For example: a zero, negative, or unreasonably high reading is being consistently reported. Resetting to
nominal may restore normal pressure readings but a proper calibration should be performed.

Display Text Description
Calibration Type?
Reset Pressure Cal

Press CHOICE until the desired option is displayed, then press ENTER.

Reset Pressure cal?
[Yes / No]

Resets the pressure calibration to nominal values. Temperature and
volume calibrations are not affected. Nominal values may be sufficient.
Schedule a proper pressure calibration as soon as possible, then press
CHOICE.

Select Yes to reset the calibration to nominal values. Press ENTER.

Select No to contact your service representative to schedule a proper
pressure calibration. Press ENTER.
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REVIEW CALIBRATION

The Review function reviews the results of the last calibration operation.

The sample cell volume and the expansion cell volume are used for calculating the sample volume. The
cell volume and expansion volume are updated automatically when the pycnometer is calibrated.

The prompts that display during a review of calibration data depend on the options specified in Setup >
Analysis Parameters and Report Options.

1. Press Alt + 5 to display the Chamber Insert prompt from which the insert can be selected (if
used).

2. Press ENTER to display the volume of the calibration standard. This volume can be edited from
this prompt.

3. Press ENTER to display the Which Chamber prompt.

4. Press CHOICE to select whether to view the results for the sample chamber or the expansion
chamber.

5. Press ENTER to display a prompt showing the starting time and date.

6. Press ENTER to display a prompt showing the ending time and date.

7. Press ENTER to display the first of the prompts containing data. The [n] in this example rep-
resents the cycle number.

8. Continue pressing ENTER to view all of the data. Press CHOICE to exclude data from report
calculations. An asterisk will display indicating that it will be excluded.

9. Press SAVE to return to the Reload prompt

10. Press Alt + 6 to print report results.

Review Calibration
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10 Calibration

Display Text Description
Chamber insert?
(insert)

Displays the insert selected for the calibration or None if an insert was
not used. If the selection is incorrect, press CHOICE until the correct
one is shown, then press ENTER.

l None, 0.1 cm3 (for 1 cm3 unit)

l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)

l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)

l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)
Volume of Cal Std:
(volume)

Displays the volume of the calibration standard that was used for the
calibration. Press ENTER.

Which Chamber?
(chamber type)

Select to view calibration data for the sample cell chamber or the
expansion chamber. Press CHOICE until the chamber is displayed, then
press ENTER.

The chamber type options are Cell volume and Expansion volume.
Start:
(time) (date)

Displays the time and date the calibration began. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

End:
(time) (date)

Displays the time and date the calibration completed. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

Cell[n] = (volume)
Dv[n] = (deviations)

or

Exp[n] = (volume)
Dv[n] = (deviations)

Displays the Volume, depending on the chamber type selected (Cell
volume or Expansion volume).

[n] represents the cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk next to the density indicates it has been
excluded. Press CHOICE again to remove the asterisk and have it
included.

Each time CHOICE is pressed to exclude or include the value. A new
deviation is calculated and displayed.

Press ENTER to view the values for the next cycle.

Press SAVE to return to the Reload prompt. Press SAVE to automatically
recalculate collected data and add all data reduction messages back into
the queue.
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TEMPERATURE

This operation typically is performed by a Micromeritics service representative.

Press Alt + ., then press CHOICE until Temperature is displayed.

Display Text Description
Calibrate Temperature
Temperature:

Enter the temperature obtained from a reference temperature sensor. Press
ENTER to automatically return to the Reload prompt. Press ALT +
CLEAR to cancel the operation.

ZERO THE PRESSURE TRANSDUCER & CHAMBER VOLUME

The pressure transducer zeroes automatically before each cycle in an analysis or calibration; therefore,
it is not necessary to zero the unit for these operations. Typically, this function is not required unless
manually performing analyses for an extended period of time.

Press Alt + 0 to access the Zero function.

Display Text Description
Zero Type?
Pressure

Allows zeroing of the pressure transducer or the volume offset. Press
CHOICE until the option is displayed, then press ENTER. If choosing
Pressure, the next prompt is not displayed. Choices are Pressure and
Volume. Ensure the sample chamber is empty if selecting Volume.

Zero Volume?
Chamber insert?
None

Does not display for
Pressure

Displays when Volume is selected. Select Yes at the Request insert
prompt in Report Options. Press CHOICE until the appropriate insert is
displayed, then press ENTER.

l None, 0.1 cm3 (for 1 cm3 unit)

l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)

l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)

l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)
Zero Volume
[ENTER] to start
[ESCAPE] to cancel

or

Zero Pressure
[ENTER] to start
[ESCAPE] to cancel

Press ENTER to begin the zero operation or Alt + CLEAR to cancel the
operation.

If zeroing the Volume, the purges and cycles specified in the current
analysis parameters are used to calculate the volume offset.

After the operation is complete, the pycnometer returns to the Reload
prompt.

Temperature
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10 Calibration

LOAD CALIBRATION DATA FROM A USB STICK

Display Text Description
Calibration Type?
Load from USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. Press ENTER.

Local cal for SN: Key in the serial number. Press ENTER.
Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USB stick. The system automatically returns to the Reload
prompt. This prompt appears immediately after the Calibration for SN
prompt.

COPY CALIBRATION DATA TO A USB STICK

Display Text Description
Calibration Type?
Copy to USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. Wait a few seconds, then press ENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USB stick. The the Reload prompt displays.. This prompt
appears immediately after the Calibration for SN prompt.
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11 HARDWARE COMPONENTS AND ACCESSORY
INSTALLATION

ADD ANALYSIS MODULE TO CONTROL MODULE

Additional analysis modules provide the ability to increase productivity and / or provide a means for
analyzing different size samples concurrently. Multiple analysis modules can be connected to an
integrated controller / analysis module.

If connecting to a temperature controlled unit, see "Add Analysis Modules to a Temperature Controlled
Module" on page F - 1.

Component Description
A Separate power cord for external power supply. Connect cable to wall outlet.
B External power supply
C Hardwired 8-pin mini-DIN power cable for external power supply.
D 8 pin mini DIN cable.
E Power adapter DIN port.
F Power adapter.
G Module Connection - 8-pin mini-DIN OUT port to connect next analysis module.
H Module Connection - 8-pin mini-DIN IN port to connect the control module or

previously connected analysis module (not shown).
I Hardwired power mini-DIN cable for power adapter.

Diagram Components

11 Hardware Components and Accessory Installation

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

11 - 1



11 Hardware Components and Accessory Installation

If using the Windows version of the AccuPyc II, exit the application before powering off
the analyzer.

If installing an external TEC module, it is suggested that the TEC system be installed first,
to allow time for temperature to stabilize at the desired temperature, while the AccuPyc is
being installed. The TEC module has a separate power cord and external power supply.

1. Power OFF the control module.

2. Connect one external power supply cable to the back of the new unit and another external power
supply cable to each power adapter.

3. Connect a power cable to each external power supply.

4. Attach one end of the DIN cable (provided in the module accessories kit) to the connector labeled
Module Connection on the back of the new unit.

5. Attach the other end of the DIN cable to the separate power adapter.

6. Attach the hardwired power adapter cable to the lower connector labeledModule Connection on
the back of the analysis module.

7. Plug the external power supply cables into electrical wall outlets.

8. Power ON the control module. If running the application software, start the application.

9. Verify the unit is recognized:

l If running the application software, Unit
[n] menus are added to the menu bar for
each analysis module connected.

l If using the keypad for analysis, press Alt
+ CHOICE + 2 to access the additional
analysis module. Unit [n] appears in the
upper left corner of the display.

10. Calibrate the pycnometer. See "Calibrate using the Keypad" on page 10 - 14 or "Calibrate using
the Software" on page 10 - 1.
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CONFIGURE AN ANALYTICAL BALANCE
Options > Configure Balance

Used to connect and set up an RS-232 balance to the analyzer. See "Connect an Analytical Balance"
on page J - 6.

The analytical balance tested by Micromeritics is Scientec® model #ZSA120. See "Parts and
Accessories" on page 13 - 1.

Field or Button Description
Enable / Disable Select to enable or disable the attached balance.
Serial Parameter Used to set the baud rate, parity, data bits, and stop bits. This field should

not require modification from the default values.
Serial Port Select which serial port is used to connect the balance to the analyzer.

Configure Balance Fields and Buttons Table

PRINTER SETUP
Printers are connected to the AccuPyc II via a USB port. See "Specifications" on page 1 - 10 for a list
of supported printers. Using the keypad:

1. On the display, select Setup > Report Options.

2. Press ENTER until the Printer? prompt is displayed.

Configure an Analytical Balance
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11 Hardware Components and Accessory Installation

3. Press CHOICE until the appropriate printer driver is displayed.

11 - 4 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



12 MAINTENANCE AND TROUBLESHOOTING
What happened Why What to do
Power indicator did not
illuminate when analyzer
was power ON.

Power or DIN cables not fully inser-
ted

Verify cable connections and con-
nect any loose cable ends into
proper outlets.

No power at outlet. Test the outlet. If there is no
power, contact electrician.

Plug prongs bent so that contact not
made at outlet.

Unplug the power cable and re-
plug into outlet. If indicator does
not illuminate, have electrician
adjust prongs or replace outlet or
plug.

Power cord damaged. Have electrician check cord using
test meter. Replace if defective.

Loose internal connection, broken
wire, or failure of internal power
supply.

Contact a Micromeritics Service
Representative for repair or
replacement information.

12 Maintenance and Troubleshooting
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12 Maintenance and Troubleshooting

What happened Why What to do
Specified pressure not
reached or maintained.

Chamber cap not properly closed. Close chamber cap by turning fully
clockwise.

Chamber cap contains dust or debris
or the O-ring is not properly
greased.

Using a lint free tissue, clean the
chamber cap and the rim of the
cell chamber. Lightly grease the
chamber cap O-ring. See "Grease
the Chamber Cap O-Ring" on
page 12 - 4.

The chamber cap O-ring is not prop-
erly seated.

Check the chamber cap. Ensure
that the O-ring is properly seated
and that it contains no scratches or
cuts.

The chamber cap O-ring is cut or
scratched.

Replace the O-ring in the chamber
cap. See "Replace the Chamber
Cap O-Ring" on page 12 - 4.

Gas leaks in the cell chamber or
expansion chamber.

Check the pycnometer for leaks.
See "Check for Leaks using the
Keypad" on page 12 - 8 or "Check
for Leaks using the Software" on
page 12 - 6.

The helium tank is low on gas, or
empty.

Check tank. Minimum recom-
mended pressure is 200 psig. See
"Set Regulator Pressure" on
page 12 - 14.

The Shut-Off valve on the gas cyl-
inder is closed.

Ensure that the valve is open.

Pressure regulator defect or the pres-
sure is set too low.

Check regulator to be sure it is set
properly. See "Set Regulator Pres-
sure" on page 12 - 14. Call a
Micromeritics Service Rep-
resentative, if necessary.

The Zero offset (of pressure trans-
ducer) is too low.

Check offset by opening chamber
cap. If pressure is negative (dis-
played on instrument schematic),
run a new zero offset. See "Zero
the Pressure Transducer & Cham-
ber Volume" on page 10 - 19.

Dust filter on 2000 cm3 unit is
clogged or leaking to atmosphere.

Clean the dust filter. See "Clean
the Dust Filter" on page 12 - 9.

12 - 2 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



What happened Why What to do
Helium drained from tank. Leaks in the gas line connection. Pressurize the system. Close, then

open the gas cylinder Shut-Off
valve. If the needle on the pressure
gauge falls abruptly, a leak in the
gas line connections may be indic-
ated. Check all gas line con-
nections.

Pycnometer was left in Manual
mode with all the valves open or the
fill valve open and chamber cap off.

Close all valves, then attach a new
tank of helium.

Unit will not equilibrate,
or results are not repro-
ducible.

Sample outgassing. Prior to analysis, remove moisture
and contaminants from the sample.
See "Preparing and Loading
Sample" on page 6 - 1.

Dust filter on 2000 cm3 unit is
clogged or leaking to atmosphere.

Clean the dust filter. See "Clean
the Dust Filter" on page 12 - 9.

Defective cap O-ring Check cap O-ring for defects.
Regrease or replace the O-ring, if
necessary.

Debris on valves With manual mode enabled and
with the cap installed, open all
valves. With helium flowing
through the pycnometer, open and
close the expansion valve
repeatedly for approximately one
minute. This will remove sample
contamination, which may cause a
leak, from the valve seat. Repeat
the process for the vent valve with
the inlet and expansion valves
open.

12 Maintenance and Troubleshooting
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12 Maintenance and Troubleshooting

CHAMBER CAP O-RING
The cell chamber cap contains an O-ring that requires routine maintenance. The chamber cap O-ring
should be greased at the beginning of each period of use.

Fine fibers and particles between the O-ring and its sealing surfaces can cause leaks, as can scratches
or cuts in the O-ring or in the metal surfaces.

GREASE THE CHAMBER CAP O-RING

1. Turn the chamber cap counter-clockwise and lift it from the chamber.

2. Place the chamber cap on a clean surface with the O-ring side exposed.

3. Use a small drop of Dow Corning high vacuum grease (or equivalent).

4. Distribute the grease evenly and completely around the O-ring groove.

5. Replace the chamber cap.

6. If recalibrating the pycnometer, allow the pycnometer to warm up for 30 minutes before cal-
ibrating.

REPLACE THE CHAMBER CAP O-RING

1. Use a pointed tool and carefully remove the O-ring from its groove in the cap. A small niche is
provided at the groove for placement of the tool.
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Do not to scratch the metal surface of the chamber cap. Scratches could result in an imper-
fect seal.

2. Clean the groove in the chamber cap using a small brush or lint-free tissue moistened with iso-
propyl alcohol.

3. Allow the chamber cap to dry thoroughly.

4. Use a small drop of Dow Corning high vacuum grease (or equivalent).

5. Grasp the O-ring with the two greased fingers. Distribute the grease evenly and completely
around the O-ring.

Apply the grease sparingly. Too much grease may alter cell volume while too little grease
results in an imperfect seal and leaks.

6. Place the O-ring back into the groove on the cap and, with the greased index finger, gently press it
back into position.

7. Ensure the O-ring groove is properly greased. See "Grease the Chamber Cap O-Ring" on the
previous page.

8. Replace the chamber cap.

Replace the Chamber Cap O-Ring
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12 Maintenance and Troubleshooting

CHECK THE CELL AND EXPANSION CHAMBERS FOR LEAKS
This procedure should be performed in a temperature-stable environment after the pycnometer has been
allowed to warm for at least two hours. Before performing this procedure, check the chamber cap to
ensure that it is not the source of leaks. It should be free from particles, the O-ring should be properly
seated, and should not contain excessive grease.

CHECK FOR LEAKS USING THE SOFTWARE

Before performing this procedure, check the chamber cap to ensure that it is not the source
of leaks. It should be free from particles, the O-ring should be properly seated, and it should
not contain excessive grease.

1. Allow the pycnometer to equilibrate thermally in a room having a stable temperature.

2. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the menu
item. The instrument schematic should display. If not, go to Unit [n] > Show Instrument
Schematic.

3. If the system has been open, manually purge the system before proceeding:
a. On the schematic, open the Expansion valve and close the Vent valve.

b. Open the Fill valve and fill the sample chamber (1-, 10-, 100 cm3) or expansion chamber
(1- and 2000 cm3) to the correct pressure. Pressure is displayed to the left of the chamber
on the schematic.

c. Close the Fill valve and open the Vent valve.

d. Repeat steps (a) through (c) two or three times.

e. Close the Expansion valve.

4. Open the Fill valve.

5. Fill the first chamber to 19.5 psig (134.4 kPag).

6. Close the Fill valve.

7. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure
should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.
l If the pressure does not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02
psig (0.14 kPag) in a two minute span, proceed to step 8.

l If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the
system, then repeat steps 4 through 7 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

8. Close the Vent valve, then open the Expansion valve and the Fill valve.
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9. Fill the chambers to 19.5 psig (134.4 kPag).

10. Close the Fill valve.

11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure
should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.

If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the
system, then repeat steps 8 through 11 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

Check for Leaks using the Software
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12 Maintenance and Troubleshooting

CHECK FOR LEAKS USING THE KEYPAD

Before performing this procedure, check the chamber cap to ensure that it is not the source
of leaks. It should be free from particles, the O-ring should be properly seated, and it should
not contain excessive grease.

Check the cell and expansion chambers for leaks.

1. Allow the pycnometer to equilibrate thermally in a room with a stable temperature.

2. Press Alt + 1 to enter Manual mode.

3. If the system was previously open, manually purge the system before proceeding:
a. Press 8 to open the Expansion valve and 9 to close the Vent valve; X - O - X.

b. Press 7 to open the Fill valve. Once the sample chamber fills to the appropriate pressure,
press 7 to close the Fill valve.

c. Press 9 to open the Vent valve; X - O - O.

d. Repeat this procedure two or three times.

e. Press 8 to close the Expansion valve; X - X - O.

4. Press 7 to open the Fill valve; O - X - O.

5. Fill the sample chamber to 19.5 psig.

6. Press 7 to close the Fill valve; X - X - O.

7. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure
should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.
l If the pressure does not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02
psig (0.14 kPag) in a two minute span, proceed to step 8.

l If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the
system, then repeat steps 4 through 7 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

8. Press 9 to close the Vent valve, 8 to open the Expansion valve, and 7 to open the Fill valve;
O - O - X.
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9. Fill the chambers to 19.5 psig.

10. Press 7 to close the Fill valve; X - O - X.

11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure
should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.

If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig (0.14
kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the system,
then repeat steps 8 through 11 several times to verify that a leak is indicated. If a leak is indic-
ated, call a Micromeritics Service Representative.

CLEAN THE DUST FILTER

Applicable to 2000 cm3 units only.

Dust from the sample may be carried into the instrument plumbing. A dust filter protects the valves,
minimizing valve leaks.

1. Press Alt+1 to enter Manual mode.

2. Close the Fill valve. Open the Expansion and Vent valves to ensure that the system is not under
pressure.

3. At the lower rear of the instrument, remove the two screws which hold the dust filter cover and
remove the cover plate.

4. Remove the spring and the filter. Remove the small O-ring inside the filter port.

5. Clean all parts with alcohol. The filter may require sonication to dislodge dust. It should be
replaced if it becomes severely clogged.

6. Inspect the O-rings before re-assembly. A very thin coating of vacuum grease may be used.

Clean the Dust Filter
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12 Maintenance and Troubleshooting

7. Re-assemble.

8. Check for leaks:
a. Fill the system with gas.

b. Open Expansion valve.

c. Check for leaks by applying a leak detecting liquid around the dust filter cover.

CLEAN THE PYCNOMETER
The exterior casing of the pycnometer may be cleaned using a clean cloth, dampened with isopropyl
alcohol (IPA), a mild detergent solution, or a 3% hydrogen peroxide solution.

Do not immerse the pycnometer or the power cord in any liquids. Doing so could result in
electrical shock to personnel or damage to the unit.

Do not allow liquid to penetrate the casing of the pycnometer. Doing so could result in dam-
age to the unit.

RECOVER FROM A POWER FAILURE
Setup parameters and collected data are recorded by the pycnometer in case of a power failure. These
settings will be available when power is restored. If an automatic operation was in progress when the
power failure occurred, it will be canceled when the pycnometer restarts.

Even though the pycnometer saves data during a power failure, any operation should be
restarted to ensure complete results.
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RESET THE PYCNOMETER
There are two ways to reset the Pycnometer.

l Hold the . key on the keypad during power ON. This erases data and setup parameters except for
printer and network settings.

l Hold 5 on keypad during power ON. This resets setup parameters, as well as printers and network set-
tings.

GUIDELINES FOR CONNECTING GASES

l Place gas cylinders close to the analyzer. Using gas line extenders on gas cylinders located in remote
areas may degrade gas quality and reduce pressure. Gas lines are typically five to six feet long. Place
the bottles close enough to allow for proper connection at the analyzer inlet.

l Use a retaining strap (or other appropriate tether) to secure the gas cylinder.

l Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.
o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as those

with a herringbone covering, but the line may be coated internally with a polymer.

l Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated for
an extended period of time to remove ambient gases. When possible, avoid placing gas cylinders in
remote locations. It is always better to have gas cylinders located near the analyzer.

l Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling gas
lines. This will help avoid confusion in the event maintenance is required.

l Label the gas line at the analyzer inlet for proper identification and maintenance.

l Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pressure
reads approximately 200 psi on the high-pressure gauge. Contaminants absorbed to the walls of the
cylinder will desorb as the pressure decreases.

l Ensure the gas cylinder is closed before connecting to the analyzer.

Reset the Pycnometer
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12 Maintenance and Troubleshooting

REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. When working with hazardous
gases, follow the safety procedures established by your lab.

A power failure can result in dangerous pressures in the sample chamber. When using toxic
or flammable gases, additional venting of the cabinet may be required.

Disconnect the Depleted Gas Cylinder

1. Close the gas cylinder shut-off valve by turning the valve clockwise.

2. Disconnect the gas line from the regulator and allow the regulator line to purge. The gas will
begin to vent. It is not necessary to disconnect the gas line from the analyzer inlet.

3. Open the gas regulator shut-off valve by turning the valve counter-clockwise. The gas will con-
tinue to vent.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges should
read at or near zero. If not, open the gas regulator shut-off valve to release gas. It is not necessary
to disconnect the gas line from the regulator or the analyzer.
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5. Close the regulator control knob.

6. Use an appropriate wrench to loosen the nut at the regulator / gas cylinder connection then remove
the regulator from the bottle.

7. Replace the protective cap on the depleted bottle. Disconnect the retaining strap and move the
bottle to an appropriate location.

Connect A Gas Cylinder

Move the replacement bottle close to the analyzer and tether it into place. It is not necessary to
disconnect the gas line from the regulator or the analyzer.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas cyl-
inder. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand-tighten the nut, then use an appro-
priate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

3. Check for leaks at the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counter-clockwise.

b. Slowly open the gas cylinder shut-off valve, then quickly close it.

c. Observe the pressure on the high-pressure gauge for approximately one minute:

l If the pressure is stable, proceed with the next step.

l If the pressure decreases, tighten the regulator connector nut until it
becomes stable. If the pressure does not remain stable, remove the reg-
ulator and clean all contacts at the regulator connection, then reinstall the
regulator.

4. Purge the lines and set the regulator pressure.
a. If the gas line is not connected to the regulator and the instrument connect it now.

b. Fully open the gas bottle shut-off valve and the gas regulator shut-off valve.

c. Under manual control, open the fill, expand, and vent valves.

d. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure,
whichever is higher, is shown on the regulator display.

e. Allow gas to flow for 30 seconds.

f. Close the fill, expand, and vent valves.

g. Turn the regulator control knob clockwise to increase pressure by 2 psi (15 kPa).

Replace a Gas Cylinder
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12 Maintenance and Troubleshooting

SET REGULATOR PRESSURE

SET REGULATOR PRESSURE WITH THE SOFTWARE

Ensure the tank pressure for the gas regulator is at least 200 psig. Pressures less than 200
psig indicate the tank is low on gas. Analyses are terminated automatically if gas is
depleted.

The Purge fill and Cycle fill pressures are specified in Analysis Conditions. Set the regulator pressure at
the higher of the two, plus 2.0 psig. For example; if the Purge fill pressure is set to 19.500 psig (134.445
kPag) and the Cycle fill pressure as 19.000 psig (131.000 kPag), set the regulator pressure at 21.500 psig
(148.237 kPag).

1. Verify that the tank pressure for the gas regulator is at least 200 psig (1379 kPag).

2. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the menu
item. The instrument schematic should display. If not, go to Unit [n] > Show Instrument Schem-
atic.

3. On the schematic, right click the Expansion and Vent valves and select Open for both. Then open
the Fill valve.

4. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure, whichever is
higher, is shown on the regulator display.
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5. On the schematic, close the Fill valve, then increase the regulator pressure by 2.0 psig (13.8
kPag).

6. Allow the pressure in the pycnometer to drop below 2.0 psig, then close the Expansion and Vent
valves.

SET REGULATOR PRESSURE WITH THE KEYPAD

Ensure the tank pressure for the gas regulator is at least 200 psig. Pressures less than 200
psig indicate the tank is low on gas. Analyses are terminated automatically if gas is
depleted.

The Purge fill pressure and cycle fill pressure are specified using Setup > Analysis Parameters. Set the
regulator pressure at the higher of the two (plus 2.0 psig). For example; if the purge fill pressure is
specified as 19.500 psig and the cycle fill pressure as 19.000 psig, then set the regulator pressure at
21.500 psig.

1. Press Alt + 1 to enter Manual mode.

2. Press 8 (EXPAND) and 9 (VENT) to open the expansion and vent valves; the display will show:
X - O - O

3. Press 7 (FILL) to open the fill valve; the display will show: O - O - O

4. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure, whichever is
higher, is shown on the regulator display.

5. Press 7 to close the Fill valve, then increase the regulator valve by 2.0 psig. The display will
show: X - O - O.

6. Allow the pressure in the pycnometer to drop below 2.0 psig, then press 8 and 9 to close the
Expansion and Vent valves. The display will show: X - X - X

7. Press SAVE to return to the Reload prompt.

Set Regulator Pressure with the Keypad
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13 PARTS AND ACCESSORIES
Order system components and accessories using one of the following methods:

l Call our Customer Service Department at 1-770-662-3636

l Email orders to Orders@Micromeritics.com

l Contact your local sales representative

Part Number Item and Description
Analyzer Equipment

134-00000-00 AccuPyc II, 10 cm3 capacity
134-00001-00 AccuPyc II, 1 cm3 capacity
134-00002-00 AccuPyc II, 100 cm3 capacity
134-00005-00 Control Module, no sample compartment
134-00010-00 AccuPyc II, flowing temperature control, 10 cm3 capacity
134-00020-00 AccuPyc II, flowing temperature control, 100 cm3 capacity
134-00030-00 AccuPyc II Glove Box, 10 cm3 capacity
134-00031-00 AccuPyc II Glove Box, 1 cm3 capacity
134-00032-00 AccuPyc II Glove Box, 100 cm3 capacity
134-00033-00 AccuPyc II Glove Box, 350 cm3 capacity
134-00034-00 AccuPyc II Glove Box, 2000 cm3 capacity
134-00035-00 AccuPyc II TEC, 10 cm3, Glove Box
134-00036-00 AccuPyc II TEC, 100 cm3, Glove Box
134-00040-00 Analysis module, 10 cm3 capacity
134-00041-00 Analysis module, 1 cm3 capacity
134-00042-00 Analysis module, 100 cm3 capacity
134-00043-00 Analysis module, 350 cm3 capacity
134-00044-00 Analysis module, flowing temperature control, 10 cm3 capacity
134-00045-00 Analysis module, flowing temperature control, 100 cm3 capacity
134-00046-00 Analysis module, 2000 cm3 capacity
134-00047-00 Analysis module 1340 TEC, 10 cm3

134-00048-00 Analysis module 1340 TEC, 100 cm3

134-00050-00 AccuPyc II TEC, 10 cm3

134-00051-00 AccuPyc II TEC, 100 cm3

Cables
003-60623-00 Cable, 2 ft; for connecting analysis modules
003-60623-01 Cable, 25 ft; for connecting Control module to Glove box unit
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13 Parts and Accessories

Part Number Item and Description
003-63801-00 Ethernet cable, cross-over
003-63821-00 Null Modem Cable, for connecting Analytical Balance to Con-

troller/Data Management Module
Calibration Kit

133-34900-00 Calibration Standard Kit, 10 cm3; contains two calibration standard
and one sample cup

134-34901-00 Calibration Standard Kit, 2000 cm3; contains one calibration standard
and one 2000 cm3 sample cup

133-34902-00 Calibration Standard Kit, 100 cm3; contains one calibration standard
and one 100 cm3 sample cup

133-34903-00 Calibration Standard Kit, 350 cm3; contains 3 calibration standard
and one sample cup

Chamber Cap O-rings
004-25032-00 Chamber cap O-ring, 2000 cm3

004-25575-00 Chamber cap O-ring, 10 cm3

004-25577-00 Chamber cap O-ring, 100 cm3

004-25637-00 Chamber cap O-ring, 1 cm3

004-25689-00 Chamber cap O-ring, 350 cm3

Dust Filter Components (for 2000 cm3 units only)

004-25006-00 O-ring, -006 70 DURO BUNA-N
004-25011-00 O-ring, -011 70 DURO BUNA-N
004-25312-00 Compression spring
004-27082-00 Filter, Line, 10 Micron

Equipment (Optional)
011-00000-00 Scientec Analytical Balance, model ZSA120
133-33604-00 MultiVolume Kit for 100 cm3 pycnometer; includes 10 cm3 and 35

cm3 inserts and appropriate sample cups
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Part Number Item and Description
133-33605-00 MultiVolume Kit for 10 cm3 pycnometer; includes 1 cm3 and 3.5 cm3

inserts and appropriate sample cups
134-33605-00 MultiVolume Kit for 2000 cm3 pycnometer; includes 650 cm3 and

1300 cm3, cups, inserts, and reference standards
134-33006-00 MultiVolume Kit for 1 cm3 pycnometer; includes 0.1 cm3 insert /

sample cup combination
Filtered Cup Assemblies (Optional)

133-25862-00 Filtered cup assembly, 10 cm3; used to constrain powdered samples
133-25863-00 Filtered cup assembly, 100 cm3; used to constrain powdered samples

Filtered Cup Assembly Components (for 100 cm3 units only)

004-25299-00 O-ring, size -024 70 DURO BUNA-N
004-27055-00 Paper filter (100 pack)
133-25845-01 Modified 100 cc sample cup
133-25901-00 100 cc sample cup filter cap
133-25902-00 Spring clip for 100 cc sample cup cap

Gas Accessories
004-25549-00 Reducer, 1/8 in. tube × 1/4 in. tube
004-62230-58 Gas regulator, 30 psig, CGA 580
134-33020-00 Multigas Manifold; to connect multiple gases to the analysis unit
290-25846-00 Gas inlet line assembly

Keypad Template
134-42701-01 French template
134-42701-02 German template
134-42701-03 Spanish template
134-42701-04 Italian template

13 Parts and Accessories

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

13 - 3



13 Parts and Accessories

Part Number Item and Description
Operating Supplies

0089-16045-00 High Vacuum grease, Dow Corning
Power Accessories

003-40054-00 AC/DC power supply, external
003-40058-00 AC/DC external power supply, for TEC module on TEC instruments
003-60101-00 Power cord, US, Canada, Japan
003-60101-05 Power cord, Schuko, for European countries
134-34007-00 Power Adapter

Sample Cups
134-25600-00 Sample cup, disposable, 2.5 cm3 capacity (qty. 50)
133-25805-00 Sample cup, 10 cm3 capacity
133-25805-02 Sample cup, 10 cm3 capacity, stainless steel
133-25845-00 Sample cup, 100 cm3 capacity
133-25845-02 Sample cup, 350 cm3 capacity
133-25855-02 Sample cup, 1 cm3 capacity
134-25874-00 Sample cup, 2000 cm3 capacity (used with CorePyc)
134-25875-00 Sample cup, 1300 cm3 capacity (used with CorePyc MultiVolume kit)
134-25876-00 Sample cup, 650 cm3 capacity (used with CorePyc MultiVolume kit)
134-33007-00 Disposable Sample Cup Kit, for AccuPyc II (10 cm3) includes cham-

ber insert for 2.5 cm3 (nominal) disposable aluminum cups, cal-
ibration sphere, plus 50 disposable cups.

135-25804-00 Sample cup, 35 cc capacity (used with 100 cc MultiVolume kit)
135-25805-00 Sample cup, 3.5 cc capacity (used with 10 cc MultiVolume kit)

Software and Manuals
134-20802-00 AccuPyc II Software for Windows
134-20804-00 AccuPyc II Software for Windows (with FoamPyc)
134-20808-00 AccuPyc II Software for Windows (Asphalt)
134-33005-00 Windows Upgrade for FoamPyc; includes software and operator

manual
134-42800-00 AccuPyc II Operator Manual (includes keypad and software ver-

sions, binder and dividers)
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A ERROR MESSAGES

2201 | Cannot execute report subsystem.

Cause: Start Report failed to execute the report subsystem (which is a separate process).
Action: Restart the computer. If the problem persists, reinstall the application (this will not

affect any of your sample files). Contact a Micromeritics service representative if
this error message continues.

2204 | Communication attempt with [n] failed [n]. Please check application directory for
file.

Cause: A file necessary for reporting is missing.
Action: Re-install the software.

2401 | FATAL ERROR.

Cause: An internal processing and / or hardware error has occurred during communication
with the analyzer.

Action: Contact your Micromeritics service representative.

2430 | Error accessing file [n], error code = [n].

Cause A: Media may be damaged.
Action A: Clean the media drive. If this does not eliminate the problem, attempt operation

using a backup copy of the file.
Cause B: Hard disk may be damaged.
Cause B: Contact your Micromeritics service representative.
Cause C: A software error occurred when the file was accessed.
Cause C: Contact your Micromeritics service representative.
Cause D: The file name specified contains one or more invalid characters.
Cause D: Enter a valid file name. Do not use characters such as * or ?. Refer to the oper-

ating system manual.

2431 | Error writing file [n], error code = [n].

Cause : Insufficient hard disk to perform the operation.
Action : Copy files not used regularly from the hard disk external media. Delete them from

the hard disk, and then try the operation again.

2432 | Invalid response from MMI ‘FILE_READ’ request.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact a Micromeritics service representative if this error message continues.

2433 | New entries have been found in this directory. Refresh the directory information?
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A Error Messages

Cause: Several analyzer files (sample information, analysis conditions, adsorptive prop-
erties, or report options) have been added to this directory by some function other
than the analyzer program.

Action: Click Yes to update the directory information with data from each new file. This
operation may take a minute.

Click No to locate the file manually. This option may be feasible if a large number
of files have been copied into the directory and the file name is known.

2434 | File [n] — Subset [n] wrote wrong [n] of data, expected [n] bytes.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2436 | Path specification [n] is invalid.

Cause: An invalid path name and / or extension was entered.
Action: Type a valid path name (including the proper extension), then press Enter.

2437 | File name [n] does not exist.

Cause: The entered file specification does not exist.
Action: Enter an existing file specification, or select a file name from the list box.

2439 | Could not register file.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2440 | Subset not found.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2441 | Seek within file failed.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2442 | Bad header in subset file.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2443 | Subset owner denied access.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.
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2444 | Not a valid file format.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2445 | Subset wrote the wrong amount of data.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2446 | Error reading data.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2447 | Error writing data.

Cause: An unexpected error occurred when you tried to access a data file.
Action: Contact your Micromeritics service representative.

2448 | Basic Mode default parameter file directory [n] is invalid. Resetting to the install-
ation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default Adsorptive Properties directory [n] is invalid. Resetting to the installation
directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default parameter file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default report options directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.
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2448 | Default sample file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default script test file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The reference file directory [n] cannot be used. Resetting to the installation dir-
ectory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The z-table file directory [n] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2449 | This field does not contain a valid file specification.

Cause: An invalid file name was entered.
Action: See the description of file naming conventions in a Windows manual, then re-enter

the name.

2450 | Sample Defaults may not be edited while this operation is in progress. Do you wish
to save and close the Sample Defaults edit session?

Cause: An automatic analysis (an analysis in which sample files are created using the
defaults) was processing while editing the defaults.

Action: Finish the edit session of the defaults, close the window, then restart the automatic
analysis.

2452 | Attempt to write MICATTR.DIR in read only mode. [n]

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file (this
file exists in each folder containing sample or parameter files).
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Action: Use Windows Explorer to access the folder containing the MICATTR.DIR file,
then disable the Read-Only option.

2453 | Attempt to append MICATTR.DIR in read only mode. [file name]

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file (this
file exists in each folder containing sample or parameter files).

Action: Use Windows Explorer to access the folder containing the MICATTR.DIR file,
then disable the Read-Only option.

2454 | Too many selections for a print-to-file operation. Only the first (number) selections
will be processed. Please reselect the remainder.

Cause: Too many files were selected for this operation.
Action: Select only the number of files specified in the message.

2455 | Too many selections for an export-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

Cause: Too many files were selected for this operation.
Action: Select only the number of files specified in the message.

2456 | Insufficient file handles available. Application cannot continue.

Cause: More than 50 files are open at the same time.
Action: Refer to an operating system manual then set the limit for open files to 50 or

greater.

2457 | Results cannot be displayed. More than [n] windows are currently displaying or
printing results.

Cause: Too many windows are open in the application.
Action: Close some of the open windows.

2458 | An instrument is performing a critical operation. Wait a few moments before exiting
the application.

Cause: An attempt was made to exit the application while the instrument was performing a
critical operation. This operation must be completed before the application can be
exited.

Action: Wait a short time and attempt to exit the application again.

2459 | An instrument is busy. A delay in restarting this application could result in loss of
new data. Continue with program Exit?

Cause: An attempt was made to exit the application while an analysis was in progress.
While this is possible, the data collected when the application is inactive will not
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be permanently recorded until the application is re-started. A power failure to the
instrument could cause some data to be lost.

Action: If not concerned with the potential for loss of data should a power failure occur,
click Yes to continue; otherwise, click No.

2460 | Fatal Communications error on [n].

Cause: There was a fatal error in communication between the application and the software
in the instrument. All displays for that instrument will be closed.

Action: Ensure that the analyzer is connected to the computer on the communications port
configured in the Setup program. Stop and restart the analyzer software. Contact
your Micromeritics service representative.

2461 | No instruments are in operation. This application will unconditionally terminate.

Cause: At least one instrument must be active for the application to operate. The
initialization of all of the instruments configured with the Setup program has failed.
The application stops.

Action A: Usually this message is preceded by another message giving the reason for the
instrument’s failure to initialize. Refer to the instructions for that message.

Action B: Ensure that the instrument is attached to the computer on the communications port
configured with the Setup program. Verify that the instrument's power switch is in the
ON position and that the light on the front panel is illuminated. If the application
continues to fail in its attempts to initialize the instrument, contact your
Micromeritics service representative.

2477 | [n] did not properly initialize.

Cause: The software was unable to initialize this instrument. This is usually caused by one
of the conditions listed in the previous error messages.

Action A: Run the Setup program and ensure that a valid port is specified; if not, specify a
valid one when prompted.

Action B: Reinstall the software, then restart application.
Action C: Contact a Micromeritics service representative if this error message continues.

2478 | Error copying sequential data segment.

Cause: An internal processing and / or hardware error occurred while accessing a portion
of a sample file.

Action: Confirm that the media being accessed does not contain errors.. Contact your
Micromeritics service representative.

2479 | The instrument is busy performing an operation of which this application is
unaware. Do you want to cancel? [Yes, No]

Cause: During initialization of the application, the status of the analyzer was found to be in

A - 6 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



a different state than expected.
Action: Click Yes to cancel the operation in process and allow the analyzer to reset, then

continue with initialization. Click Noto cancel the initialization process.

If this error message continues, verify that files in the application directory
structure are not being changed or removed.

2480 | File [n] cannot be analyzed. It is currently being edited.

Cause: An attempt was made to start an analysis using a file that is open for editing.
Action: Finish editing the file, save and close it, then start the analysis.

2481 | Error accessing the sample information file [n].

Cause: An unexplained error prevented access to this file.
Action: The hard disk drive may be corrupt. Run diagnostics.

2482 | File cannot be opened for writing.

Cause: An attempt was made to open a file currently being used.
Action: Locate the application using the file (in the Micromeritics application, use the

Windows menu item to get a list of all open windows, one of which may contain
this file).

2483 | An analysis cannot be performed on [n]. It is open for editing and contains errors.

Cause: An attempt was made to use a sample file containing errors that is currently open.
Action: Go to the window containing the file, correct the errors, then save it.

2484 | The edit session for [n] must be saved before the analysis. Save changes and con-
tinue with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is open for editing.

Action: Click Yes to save the changes, then proceed with the analysis. Click No to cancel
the analysis, then continue editing the Sample Information file.

2485 | The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected file has a status other than No Analysis.
Action: Select a different service test file, or create a new one and use Replace All to

copy parameters from the file originally selected.

2486 | Could not construct [n] report type. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
Action A: Contact a system administrator to have full rights granted.
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Cause B: An internal processing and / or hardware error has occurred.
Action B: Contact your Micromeritics service representative.

2487 | Could not start report generator. Error code [n]. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
Action A: Contact a system administrator to have full rights granted.
Cause B: An internal processing and / or hardware error has occurred.
Action B: Contact your Micromeritics service representative.

2488 | File [n] cannot be opened for editing.

Cause: The specified file is being used in another edit operation.
Action: Check the Windows list to locate the other edit session.

2489 | File [n] cannot be opened for writing.

Cause: The specified file in a Save As operation is already open for edit.
Action: Select a different file for the Save As operation.

2490 | No ‘.INI’ file present. Application will terminate.

Cause: The ASCII .INI file containing initialization information and system options inform-
ation used during program startup does not exist.

Action: Run the analyzer Setup program (located on the applications CD), select Change
analyzer setup and enter the pertinent information.

2491 | Highlighted fields contain errors. Please correct the errors before dialog box.

Cause: The highlighted fields contain invalid entries. The window cannot be closed until
all errors are corrected.

Action: Check the entries, correct the errors, then close the window.

2492 | This field’s entry is invalid.

Cause: The highlighted field contains an invalid entry.
Action: Check the entry and correct the error.

2493 | An entry is required for this field.

Cause: This field requires a valid entry to proceed.
Action: Enter or select an appropriate value.

2494 | Value is out of the valid range.

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.
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2495 | Value is out of the valid range. Enter a value between [n] and [n].

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.

2496 | Invalid number.

Cause: An invalid number was entered in the highlighted field.
Action: Check the entry, then either enter or select a valid number.

2497 | This field contains an invalid character.

Cause: An invalid character was entered in the highlighted field.
Action: Check the entry, then enter valid characters.

2498 | The requested change to the Sample’s status is invalid at this time.

Cause: A request to change the file’s status, for example, from automatically collected to
manually entered could not be done.

Action: Contact your Micromeritics service representative. Record the name of the sample
file in which the problem occurred.

2499 | Sequence number must contain at least 3 digits.

Cause: An attempt was made to enter a sequence number that did not contain at least three
digits.

Action: Enter a sequence number that contains at least three digits.

2500 | All sample file names that can be created using the sequence number pattern
already exist. You may want to modify the next sequence number.

Cause: No more sample information files can be created using the currently entered file
name sequence number.

Action: Go to Options > Default Method, then enter another sequence number.

2501 | System resources have reached a dangerously low level. Please close some win-
dows to avoid the loss of data.

Cause: A large number of windows are open and consuming the system resources
available to all applications.

Action: Close one or more windows. Contact your Micromeritics service representative.

2502 | Error writing to file [n] during print. Error code [n].

Cause: An error occurred in the file being written to during a print operation.
Action: Ensure there is sufficient space on the drive containing the file.

2503 | Error converting file [n]. Cannot create DIO intermediate file.
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Cause: An error occurred while printing a report to file.
Action: An attempt was made to replace a file that is read only or the computer login does

not have permission to do so. Contact your IT Department.

2504 | Cannot create output file for sample [n].

Cause: There may be insufficient disk space.
Action: Ensure that sufficient space is available. Contact a Micromeritics service

representative if this error message continues.

2505 | Error logger cannot be initialized. Error code [n]. Program will exit.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.

2506 | Output device [n] is not installed. Printing cannot be accomplished.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.

2508 | Overlay [n] was not found. It will not be included in the reports.

Cause: The specified overlay file could not be found.
Action: Ensure the file specified as an overlay exists.

2509 | Error opening file [n]. Reports cannot be produced.

Cause: An error occurred while the program was opening a file necessary to the report
operation.

Action: Use the name given in the error message to investigate. Contact your Micro-
meritics service representative.

2510 | Error parsing reports from file [n]. Reports cannot be produced.

Cause A: One or more data entry fields in the sample file may contain an invalid character
(such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field), then remove the
invalid character.

Cause B: The system was unable to create the usual temporary files during the report, pos-
sibly due to insufficient disk space.

Action B: Check the space available on the hard disk.
Cause C: An internal processing error occurred.
Action C: Contact your Micromeritics service representative.

2511 | Print job [n] has been canceled due to insufficient disk space. Delete unnecessary
files and restart the report.
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Cause: The disk drive does not have required space for the temporary file.
Action: Delete unnecessary files from the disk. At least five megabytes of free space is

required for normal operation.

2512 | Print job [n] canceled.

Cause: The print job was canceled by the operator.
Action: None required.

2513 | Unable to read the calibration file [n].

Cause: An invalid calibration file was selected or cannot be read.
Action: Ensure the media containing the calibration file has no problems.

2514 | Unable to write the calibration file [n].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action A: Ensure the destination location has no problems.
Action B: Choose an alternate media to save the calibration data.

2515 | Warning: Changing the calibration information will affect the performance of the
instrument. Only qualified service personnel should do this. Do you wish to proceed?

Cause: The process of performing a calibration operation was started.
Action: Calibration operations should only be done by or under the direction of qualified

service personnel.

2516 | Warning: Keeping a backup copy of the calibration data is recommended by Micro-
meritics. Would you like to do so now?

Cause: A calibration operation was performed and a backup copy is recommended.
Action: Go to Unit [n] > Calibration > Save to File to perform a calibration save operation.

2517 | Canceling this dialog will reset the calibration state to what it was when this dialog
was first opened. Are you sure you want to cancel?

Cause: The calibration has not been accepted.
Action: If the calibration operation was successful, click Accept.

2520 | No data points available for reporting.

Cause: The selected sample file does not have collected data and cannot be used for
reporting.

Action: Select a different sample file.

2521 | Unable to program controller.
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Cause: A hardware malfunction has occurred.
Action: Contact your Micromeritics service representative.

2522 | Invalid controller application file.

Cause: The application’s control file has been corrupted or deleted.
Action: Reinstall the analysis program.

2523 | Programming controller failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2524 | CRC check failed on programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2525 | Unknown error programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2526 | Controller download was not successful.

Cause: An internal processing and / or hardware error has occurred.
Action A: Contact your Micromeritics service representative.

2527 | Controller CRC error on boot block.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2528 | Controller DRAM error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2529 | Controller Com 1: error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2530 | Controller Com 2: error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2531 | Controller debug port error.
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Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2532 | The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of software operating in the
analyzer.

Action: If there are no analyzers other than the one connected to the computer, click Yes,
then allow the updated software to load.

2533 | Analyzer initialization failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2534 | Error opening file[n] for printing. Error Code [n].

Cause: An error occurred in the selected file for print output.
Action: Ensure that sufficient disk space is available.

2548 | System status 1 [n].

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2548 | System status 2 [n].

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2549 | Error accessing online manual file [n].

Cause: The operator’s manual file could not be located.
Action A: Reinstall the application.
Action B: Copy the contents of the manual folder from the setup CD to the application

directory.

2550 | Attempts to acquire the instrument’s status timed out.

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection. Contact your Micromeritics
service representative.
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2551 | Cannot access web page [n].

Cause: The Micromeritics web page for DFT models cannot be accessed. This could be
caused by an ISP problem of high internet traffic.

Action: Try the operation later.

6000 | An error occurred while loading the application control information. Data entry can-
not be performed. (Code [n]).

Cause: An error occurred accessing the control information disk file required by this applic-
ation.

Action: The disk drive may have failed or be corrupt. Run diagnostics on the disk drive.

6001 | Unable to establish the TCP connection with the instrument.

Cause: A communications problem between the computer and the analyzer has occurred.
Action A: Check the cable connection between the computer and the analyzer
Action B: Go to Unit [n] > Unit Configuration and verify that the TCP/IP configuration for

the computer and the analyzer are correct.
Action C: Exit the application, and turn off the analyzer. Then turn on the analyzer and restart

the application. Contact a Micromeritics service representative if this error mes-
sage continues.

6002 | Configured serial number does not match instrument.

Cause: An incorrect serial number was entered when installing the software.
Action Exit the application. Access the Setup program and remove the incorrect analyzer.

Then use the Add an Analyzer option in the Setup program to add the correct serial
number for the controlling unit. Contact a Micromeritics service representative if
this error message continues.

6003 | The instrument [n] is not calibrated.

Cause: Calibration data for the selected unit was not found
Action: Go to Unit > Calibration. Select the appropriate Calibration menu item or load a

saved calibration.

6110 | Error accessing the sample information file [n].

Cause: There was an error opening a file.
Action: Code 5: There is a problem with the computer login permissions. Consult your IT

department.
Code 2: File not found. Select a different file name.

6111 | File [n] cannot be analyzed. It is currently being edited.

Cause: An open file was selected. This message is informational-only.
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Action: Click OK to close the error message window. Then continue editing the file, save
and close it; or click Browse and choose a different file.

6112 | File [n] cannot be opened. It is currently being setup for analysis.

Cause: An open file was selected that is currently being used for analysis.
Action: Select a different file.

6113 | An analysis cannot be performed on [n]. It is open for editing and contains errors

Cause: The selected analysis file contains errors and is open for editing.
Action: Finish editing the file, save, and close it, or choose a different file. Then restart the

analysis.

6114 | The edit session for [n] must be saved before the analysis. Save changes and pro-
ceed with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis. Click No to cancel
the analysis and continue editing the file, save and close it; or click Browse and
choose a different file.

6120 | Unable to read the calibration file [n].

Cause: The selected calibration file is not valid or cannot be read.
Action: Ensure the media containing the calibration file has no problems.

6121| Unable to write the calibration file [n].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action A: Confirm the media containing the calibration file has no problems.
Action B: Choose an alternate media to save the calibration data.

6122 | File contains calibration data for a different unit [n].

Cause: A calibration file from a different unit was loaded.
Action: Load a file for the current unit or go to Unit > Calibration and select the appro-

priate menu item.

6123 | The device has no calibration data for the selected insert.

Cause: A calibration report was produced for an insert that has not been calibrated.
Action: Perform a volume calibration for the insert or produce a report for a different

insert.

6126 | The cell and expansion volumes must be positive. Enter positive values and recal-
ibrate.
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Cause: According to the calibration data, the cell volume or expansion volume for the
selected insert is zero or a negative value

Action: Perform these steps:

1. Select Setup > Calibration Data.

2. In the Cell volume field, enter the volume of the sample cell (or insert).

3. In the Expansion volume field, enter half of the sample cell volume.

4. Perform a volume calibration.

6127 | The entered calibration volume is < 10% of the cell volume. The resulting calibration
may be inaccurate.

Cause A: An incorrect volume was entered for the calibration standard.
Action A: Correct the volume entry.
Cause B: The calibration standard is too small for the cell.
Action B: Use a larger calibration standard.

6160 | Device in recognizable state. Analysis canceled.

Cause: The application was closed during an analysis. When the application was restarted,
the analysis had been canceled.

Action: None required. The data collected up to the point of cancellation is saved in the
sample file.

6161 | The sample file [n] is already present in the sequence.

Cause: An attempt was made to insert an existing file into the Sample File list.
Action: None required. The same file cannot be inserted into the list multiple times.

6162 | The sequence list is full.

Cause: An attempt was made to add another file to the Sample File list for sequenced ana-
lyses when the list already contains eight entries.

Action A: Run the sequence analysis with the current list and include the preferred file in the
next sequence analysis.

Action B: Remove one of the files from the list, then add the preferred file.

6163 | The sample file has an invalid status and cannot be used for analysis.

Cause: A sample file with a status other than No Analysis was selected.
Action: Select a sample file that has not been used in an analysis.

6164 | FoamPyc analyses cannot be done on a 1 cm3 unit.

Cause: An attempt was made to perform a FoamPyc analysis on a unit that does not sup-
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port it. FoamPyc analyses cannot be performed on a unit with a 1 cm3 or 2L sample
cell.

Action A: Start the analysis on a different unit.
Action B: Close the analysis window, open the sample file, and select Standard Method.

Then restart the analysis.

6165 | Failure to fill sample cup.

Cause: There was insufficient pressure to allow filling within five minutes during an ana-
lysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain
a new tank of helium.

6166 | Pressure overrange

Cause A: A pressure overrange occurred during an analysis because the regulator pressure is
set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.

Action B: Contact your Micromeritics service representative.

6167 | Pressure underrange

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.

Action: Contact your Micromeritics service representative.

6168 | Pressure failed to equilibrate.

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.
Action A: Check the system carefully for leaks following the instructions in the instrument

operator manual. Ensure the sample is properly prepared before performing an ana-
lysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.
Action B: Set the equilibration rate to progressively higher values until reasonable equi-

libration times (15 sec to 120 sec) are achieved.

6169 | The instrument lost power during analysis.

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation.

6170 | The measured volume is < 10% of the cell volume. Results may be inaccurate.
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Cause: Not enough sample was placed in the sample cup to give an accurate reading.
Action: Rerun the sample using enough material to occupy the maximum amount of the

nominal cell chamber volume

6171 | Valve failed to respond.

Cause: The instrument valves failed to operate.
Action: Contact your Micromeritics service representative.

6200 | At least one report item must be selected. Press Cancel if you do not want a report.

Cause: No reports were selected in the Selected Reports list. No output could be produced.
Action: Ensure that at least one report is selected for the sample and re-submit the sample

for reporting, or click Cancel.

6201 | No data available in [n] for reporting.

Cause: The requested report file does not contain collected data.
Action: Use the file in an analysis before requesting reports.

6202 | Total solids concentration is invalid; liquid density is greater than or equal to solids
density.

Cause: A report was requested on a file containing invalid densities for Total Solids Con-
centration.

Action A: Specify appropriate densities for liquid and solids.
Action B: Do not request that total solids concentration be reported.
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ERROR MESSAGES FOR 1340 ACCUPYC KEYPAD ONLY

Press CHOICE to cycle through the messages and data. To delete the message, press CLEAR.
Messages that are not cleared will remain in the queue until the next analysis or calibration is performed;
at that time, any remaining messages will be cleared automatically.

l NN = Number of cycles completed

l ZZ = Number of cycles requested

Add Unit

Cause A: A new analysis module has been attached to the instrument where previously a dif-
ferent module had been attached.

Action A: Press Choice and select Yes to add the new analysis module.
Cause B: An incorrect serial number was read by the analysis module.
Action B: Press Choice and select No to use the serial number and calibration information

stored in the command module. Contact a Micromeritics service representative if
this error message continues.

ANLSERR: Eq failure — NN/ZZ cycles completed

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.
Action A: Check the system carefully for leaks following the instructions in the instrument

operator manual. Ensure the sample is properly prepared before performing an ana-
lysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.
Action B: Set the equilibration rate to progressively higher values until reasonable equi-

libration times (15 sec to 120 sec) are achieved.

ANLSERR: Fill failure — NN/ZZ cycles complete

Cause: There was insufficient pressure to allow filling within five minutes during an ana-
lysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain
a new tank of helium.

ANLSERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during an analysis because the regulator pressure is
set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.

Action B: Contact your Micromeritics service representative.
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ANLSERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.

Action: Contact your Micromeritics service representative.

Automatic operation has been canceled

Cause: The automatic operation has been canceled.
Action: Wait for the termination process to complete or end the termination process by

pressing Alt + CLEAR two more times.

CAL_ERR: Reset Pressure Cal. ?

Cause: The calibration information could not be read from the command or analysis mod-
ule.

Action A: Select Yes and press Enter to reset the pressure and temperature calibration to
nominal values. Resetting to nominal may restore normal readings but a proper cal-
ibration should be performed by a service technician.

Action B: Select No to avoid resetting the calibration. The instrument will be unresponsive.

CAL_ERR: Temperature Calibration Failed

Cause: The temperature calibration was unsuccessful.
Action: Contact your Micromeritics service representative.

CAL1ERR: Eq failure — NN/ZZ cycles complete

Cause: The empty cell chamber failed to equilibrate in 1000 seconds during the first pass
of calibration.

Action: Check the system for leaks.

CAL1ERR: Fill failure NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the first
pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium. (Minimum recommended
tank pressure is 200 psig.)

CAL1ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the first pass of calibration because the reg-
ulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures
specified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during the first pass of calibration because an error
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occurred in the pressure measurement electronics.
Action B: Contact your Micromeritics service representative.

CAL1ERR: Underrange — NN/ZZ cycles complete

Cause: A pressure underrange occurred during the first pass of calibration because an
error occurred in the pressure measurement electronics.

Action: Contact your Micromeritics service representative.

CAL2ERR: Eq failure — NN/ZZ cycles completed

Cause: The calibration standard failed to equilibrate in 1000 seconds during the second
pass of calibration.

Action: Check the system for leaks.

CAL2ERR: Fill failure — NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the
second pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium. (Minimum recommended
tank pressure is 200 psig.)

CAL2ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the second pass of calibration because the
regulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Action B: Contact your Micromeritics service representative.

CAL2ERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during the second pass of calibration because an
error occurred in the pressure measurement electronics.

Action: Contact your Micromeritics service representative.

DATA_ERR: Chamber volumes must be > 0

Cause: According to the calibration data, the cell volume or expansion volume for the
selected insert is zero or a negative value

Action: Perform these steps:

1. Select Setup > Calibration Data.

Error Messages for 1340 AccuPyc Keypad Only

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

A - 21



A Error Messages

2. In the Cell volume field, enter the volume of the sample cell (or insert).

3. In the Expansion volume field, enter half of the sample cell volume.

4. Perform a volume calibration.

DATA_ERR: No data to compute

Cause A: An automatic operation was canceled before a complete cycle could be completed.
Action A: Restart the automatic operation.
Cause B: All the cycles have been excluded in review mode.
Action B: Return to review mode and include some cycles.

DTA_WRN: Cal std — 10% of full-scale

Cause A: You entered a value for the calibration standard that was less than 10% of the nom-
inal cell chamber volume. Resulting data may be inaccurate.

Action A: Be sure you enter the value recorded on the Calibration Standard case.
Cause B: You used an inappropriate calibration standard for the nominal cell chamber.
Action B: Use a calibration standard of sufficient size (calibration standards are available

from Micromeritics). The calibration standard should occupy at least 10% of the
nominal cell chamber volume and the more nearly filled the cell is, the better the
calibration.

DTA_WRN: Volume — 10% of full-scale

Cause: There was not enough sample placed in the sample cup to give an accurate read-
ing.

Action: Rerun the sample using enough material to occupy the maximum amount of the
nominal cell chamber volume.

HW_ERR: Calibration could not be read

Cause: The calibration information could not be read from the command or analysis mod-
ule.

Action: Close the application and cycle power on the instrument. Contact a Micromeritics
service representative if this error message continues.

MAN_ERR: Pressure overrange

Cause: The fill valve was left open until the maximum system pressure was exceeded.
Action: Close the fill valve and open the vent and expansion valves. Allow the pressure to

stabilize.

No A.C. Found

Cause: The control module cannot detect an analysis module.
Action: Contact your Micromeritics service representative.
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No collected data to report, or all cycles excluded

Cause: You requested a report in which there is either no data available or data have been
excluded via review mode.

Action: Initiate an automatic operation or return to review mode and include at least one
cycle.

Printer port not responding

Cause: Printer port not responding
Action: Check to make sure the printer is properly connected to the pycnometer, is turned

on, and is online.

Queuing print job [ESCAPE] to cancel

Cause: Status message displayed when a report is being printed.
Action: None; this is a status message only.

Reset to factory defaults

Cause: The . (period) key was pressed at startup and the instrument was reset. Data files
and HTML reports have been erased. Setup options have been returned to default
values.

Action: Review setup options.

Sending line (line number) [ESCAPE] to cancel

Cause: Status message displayed when data are being transmitted.
Action: None; this is a status message only.

SYS_ERR: Power Fail — NN/ZZ Cycles Completed

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation if desired.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Updating Unit [n] failed: Press [CLEAR]

Cause: One of the analysis modules has malfunctioned.
Action: Press CLEAR and follow the instructions displayed in the keypad window. After
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disconnecting the faulty unit (as instructed), you may reconnect the control module
with the remaining analysis module(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nom-
inal full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.

Action: Abandon request.

USR_ERR: Number of cycles must be ≥ 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.

Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.
Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.
Action: Return to manual mode and vent the system.

Transmission port not responding

Cause: The receiving device took longer than five seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Transmission port waiting for Xon

Cause: The receiving device stopped transmission by sending an Xoff, and hasn’t resumed
the transmission by sending an Xon.

Action: None; when the receiving device is ready for more data, it should send the pycno-
meter an Xon.

SYS_ERR: Power Fail — NN/ZZ Cycles Completed
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Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation if desired.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Updating Unit [n] failed: Press [CLEAR

Cause: One of the analysis modules has malfunctioned.
Action: Press CLEAR and follow the instructions displayed in the keypad window. After

disconnecting the faulty unit (as instructed), you may reconnect the control module
with the remaining analysis module(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nom-
inal full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.

Action: Abandon request.

USR_ERR: Number of cycles must be ≥ 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.

Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.
Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.
Action: Return to manual mode and vent the system.
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B CALCULATIONS

ANALYSIS
For derivation, see "Sample Volume Equation Derivation" on page C - 1.

10, 100, AND 350 CM3 UNITS

V V= −s c

V

− 1

x

P

P

1

2

ρ =
s

m

V

s

s

where

Vc = sample chamber volume
Vx = expansion chamber volume
Vs = sample volume
ms = sample mass
ρs = sample density
P1 = gauge pressure after fill
P2 = gauge pressure after expansion

1 CM3 AND 2000 CM3 UNITS

 






V V V= − − 1s c x

P

P

1

2

ρ =
s

m

V

s

s

where
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Vc = sample chamber volume
Vx = expansion chamber volume
Vs = sample volume
ms = sample mass
ρs = sample density
P1 = gauge pressure after fill
P2 = gauge pressure after expansion

CALCULATIONS FOR FOAMPYC METHODS

METHOD A: COMPUTED OPEN CELL FRACTION

= ×
V

OpenCellPct
GeomVol− −VolCellsCutOpen

GeomVol
100

s

ResinPlusClosedCellPct = 100 − OpenCellPct

If cell measure is Chord Length,

×VolCellsCutOpen = ActiveArea
ChordLength

1.14

If cell measure is Diameter,

×VolCellsCutOpen = ActiveArea
CellDiam

1.4515

METHOD B: MEASURED OPEN CELL FRACTION

V V= [1] − [2]s sVolCellsCutOpen

V= [1] +sResinPlusClosedCellVol VolCellsCutOpen

−OpenCellVol = GeomVol ResinPlusClosedCellVol

= × 100ResinPlusClosedCellPct
ResinPlusClosedCellVol

GeomVol

= × 100OpenCellPct
OpenCellVol

GeomVol

where
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Vs[1] = Vs from the first analysis (before recutting)
Vs[2] = Vs from the second analysis (after recutting)

METHOD C: UNCORRECTED OPEN CELL FRACTION

VsOpenCellVol=GeomVol −

= × 100OpenCellPct
OpenCellVol

GeomVol

METHOD D: COMPRESSIBILITY TEST

Quantities appended with [i] are for cycle i, where i goes from 1 up to the number of cycles.

 
V i∆ [ ] =P

V i V i

P i P i

− 1 − [ ]

[ − 1] − [ ]

s s

1
1 1

 
V i∆ [ ] =P

V i V i

P i P i

− 1 − [ ]

[ − 1] − [ ]

s s

2
2 2

V i= avg(∆ [ ])PAvgVolChangeP1 1 for all included i

V i= avg(∆ [ ])PAvgVolChangeP2 2 for all included i

× 100PctAvgVolChangeP1 =
AvgVolChangeP1

GeomVol

= × 100PctAvgVolChangeP2
AvgVolChangeP2

GeomVol

METHOD E: FRACTURE TEST

V V∆Vol = [3] − [1]s s

× 100PctFracturedCells =
∆Vol

GeomVol

where

Vs[1] = Vs for the first (prefracture) cycle
Vs[3] = Vs for the third (postfracture) cycle

Method C: Uncorrected Open Cell Fraction
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CALIBRATION
Volume calibration uses the ultra-precise method of separate adjustments for the offset and scale factor.

VOLUME OFFSET

V V V= −c celprev sampempty

V− sampempty is reported as the offset in volume calibration reports.

VOLUME SCALE









V V=c celprev

V

V

calib

sampball









V V=x

V

Vexpprev
calib

sampball











V

V

calib

sampball is reported as the scale factor in volume calibration reports.

where

Vc = sample chamber volume
Vcelprev = previously stored cell volume
Vsampempty = average Vsamp from volume offset calibration analysis (no calibration ball)
Vcalib = calibration ball volume
Vsampball = average Vsamp from volume scale calibration analysis (with calibration ball)
Vx = expansion chamber volume
Vexpprev = previously stored expansion volume
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GEOMETRIC VOLUME AND ACTIVE AREA
Geometric volume of the sample is calculated based on the sample shape; for Method A, Active area is
also calculated.

CUBE

= ×GeomVol EdgeLength
3

NumPieces

= × ( − ) ×ActiveArea EdgeLength
2

6 NumSkins NumPieces

CYLINDER

πGeomVol = × × Height × NumPieces
Diam

4

2







π

π
DiamActiveArea = × Diam × Height +

4
×

2
× (2 − NumSkins) × NumPieces

RECTANGLE

GeomVol = LongEdge × ShortEdge × RemainEdge × NumPieces

+ActiveArea = [(LongEdge × RemainEdge × (2 − NumLargeSkins) ShortEdge × RemainEdge ×

(2 − NumSmallSkins) + LongEdge × ShortEdge × (2 − NumRemainSkins)] × NumPieces

Geometric Volume and Active Area
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RUN PRECISION
Run precision requires at least five runs. Run precision criterion is met when the sample volumes
calculated for the four most recent previous runs fall within the specified error band for the current run’s
sample volume. The error band is a specified percentage of the nominal volume of the sample chamber
(1, 10, 100, 350 and / or 2000 cm3).

Vs[0] to Vs[4] are the five most recent sample volumes, Vs[4] being the most recent.

= ×PctFullScale
V

ErrBand
100

nominal

where

Vnominal = nominal sample cell volume

If V i V( [ ] − [4] ≤ )s s ErrBand for i = 0 to 3, run precision is achieved.

TOTAL PORE VOLUME
Total pore volume is per gram of sample.

ρ ρ

ρ ρ
TotalPoreVol =

−

×

s bulk

s bulk

where

ρ
bulk = entered bulk density
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TOTAL SOLIDS CONCENTRATION

− × × 100
ρ

ρ

ρ

ρ ρ
WeightPctSolids = 1

−

liq

s

sol

sol liq

where

ρ
liq = entered liquid density

ρ
sol = entered solid density

ρ
s = sample density

Total Solids Concentration
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B Calculations

SPC REPORT VARIABLES

REGRESSION CHART

The line of best fit for the Regression Chart is calculated by the usual least squares method. If there is
only a single point, or all N points have the same x-value, there can be no line of best fit in the standard
form.

X =
x

N

Σ i

Y =
y

N

Σ
i

( )( )

( )
Slope =

x x y y

x x

Σ − −

Σ −

i i

i
2

⋅y Slope xIntercept = −

The coefficient of correlation for this line also is calculated in the usual way1 ) .

( )
σ =x

x x

N

Σ −i
2

( )
σ =y

y y

N

Σ −
i

2

( )( )
Cov x y( , ) =

x x y y

N

Σ − −i i

CorrelationCoef =
Cov x y

σ σ

( , )

x y

1 ) Mathematical Handbook for Scientists and Engineers, G.A., Korn and T.M. Korn, McGraw
Hill, Sec. 18.4 (1968)
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CONTROL CHART

Mean =
y

N

Σ
i

( )
StdDev =

y Mean

N

Σ −

− 1

i
2

CoefVar =
StdDev

Mean

Control Chart
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B Calculations

RESIN VOLUME

ResinVol =
m

ResinDensity

s

ResinVolPct = × 100
ResinVol

GeomVol

where

ms = sample mass

PERCENT POROSITY
ρ ρ ρpercent porosity = ( − ) ÷
s s

SPECIFIC GRAVITY

SG ρ ρ= ÷
s w

where

ρw = water density at analysis temperature
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ASPHALT DENSITY CALCULATIONS
Sample volume at 60 °F is found by multiplying the measured volume by the asphalt volume correction
factor.

α T VV(60) = ( ) measured

where

α T T T( )= 1.0211326242 − 3.548988118 × 10 + 4.498813 × 10
4 −8 2

and T is the analysis temperature in degrees Fahrenheit.

Sample density at 60 °F is

m Vp(60) = / (60)

Specific gravity at 60 °F is calculated by dividing the adjusted sample density by the density of water at
60 °F.

ρSG(60) = p(60) ÷ (60)
H20

where

ρ = 0.990170g / cm
H20

3

Note that the density of water at the analysis temperature is not required for this calculation.

Asphalt Density Calculations
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C SAMPLE VOLUME EQUATION DERIVATION

10, 100, AND 350 CM3 UNITS
The AccuPyc II is a gas displacement pycnometer which measures the volume of solid objects of
irregular or regular shape whether powdered or in one piece. A greatly simplified diagram of the
instrument is shown below.

Sample volume is determined from the known cell and expansion volumes and from measured pressures.

The cell and expansion chamber are initially at ambient pressure and the valve is closed. The cell is then
charged to an elevated pressure.

The ideal gas law gives:

P V V n RT( − ) =c s c1 (1)

where

nc = moles of gas in the sample cell

R = the gas constant

T = temperature

Vc = cell volume

Vs = sample volume

Vx = expansion volume

P1 = initial cell pressure

Expansion volume:

P V n RT=a x x (2)

where

C Sample Volume Equation Derivation
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C Sample Volume Equation Derivation

Pa = ambient pressure

nx = moles of gas in the expansion volume

When the valve is opened, the pressure falls to an intermediate value, P2, and mass balance yields:

P V V V n RT n RT( − + ) = +c s x c x2 (3)

Substituting from equations (1) and (2) into (3):

P V V V P V V P V( − + ) = ( − ) +c s x c s a x2 1 (4)

or

P P V V P P V( − )( − ) = ( − )c s a x2 1 2 (5)

then

V V V− =c s

P P

P P
x

−

−

a 2

2 1

(6)

Adding and subtracting Pa in the denominator and rearranging gives

V V V− = − +s c

P P

P P P P
x

−

− − +

a

a a

2

2 1

(7)

Dividing by (Pa - P2) in both the numerator and denominator











V V= −s c

V

−1 −

x

P Pa

Pa P

1−

− 2

(8)

or











V V= −s c

V

− 1

x

P Pa

P Pa

1−

2 −

(9)

Using gauge pressure defined as:

P P P= −ig i a (10)
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equation (9) is rewritten as:

V V= −s c
V

− 1

x

P g

P g

1

2

(11)

1 CM3 AND 2000 CM3 UNITS
The 1 cm3 and 2000 cm3 pycnometers operate by filling the expansion chamber while the sample cell
remains at ambient pressure. After P1 is equilibrated, the expansion valve opens to allow gas to expand
into the sample chamber and P2 is equilibrated.

For the 1 cm3 and 2000 cm3 pycnometers, equation (1) becomes

P V n RT=x x1

and equation (2) becomes

P V V n RT( − ) =a c s c

A derivation similar to that above yields the working equation for the 1 cm3 and 2000 cm3 pycnometers









V V V= − − 1s c x

P

P

g

g

1

2

1 cm3 and 2000 cm3 Units
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D TRANSMITTED DATA
Analysis and calibration data can be transmitted in a single column or spreadsheet with data in ASCII
delimited format. Units are displayed as:

Type Measurement
Date DD/MM/YY
Time HH:MM:SS
Pressure psig
Temperature °C
Elapsed Time seconds

Data Units

ANALYSIS REPORT

Record
Number

Description Form

1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = analysis 8 characters
4 Start (reported on one line as ASCII comma delimited data)

l 4a. Date

l 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited data)

l 5a. Date

l 5b. Time

8 characters (each)

6 Temperature 1 floating point
7 Description line 1 20 characters
8 Description line 2 20 characters
9 Sample IDs 20 characters
10 Sample mass 1 floating point
11 Number of purges 1 integer
12 Equilibration rate 1 floating point

Analysis Report - Spreadsheet

D Transmitted Data
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D Transmitted Data

Record
Number

Description Form

13 Chamber Insert:

l 0 = None

l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

14 Cell volume 1 floating point
15 Expansion volume 1 floating point
16 Average volume 1 floating point
17 Volume standard deviation 1 floating point
18 Average density 1 floating point
19 Density standard deviation 1 floating point
20 Number of runs 1 integer
21 Run precision

l 0 = Disabled

l 1 - Enabled

1 floating point

22 Percent full scale 1 floating point
23 Carriage return / Line feed
24 Carriage return / Line feed
25 Carriage return / Line feed
26 Run number and pressure (reported on one line as ASCII

comma delimited data)
26a Run number 1 integer
26b P1 1 floating point
26c P2 1 floating point
26d Include in average calculation

l 0 = Excluded

l 1 = Included

1 integer

26e Elapsed time 1 unsigned integer

Analysis Report - Spreadsheet (continued)
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Record
Number

Description Form

26f Volume 1 floating point
26g Volume deviation 1 floating point
26h Density 1 floating point
26i Density deviation 1 floating point
27 Temperature (all temperature data) 1 floating point

Analysis Report - Spreadsheet (continued)

CALIBRATION REPORT

Record
Number

Description Form

1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = calibration 11 characters
4 Start (reported on one line as ASCII comma delimited data)

l 4a. Date

l 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited data)

l 5a. Date

l 5b. Time

8 characters (each)

6 Temperature 1 floating point
7 Calibration standard size 1 floating point
8 Number of purges 1 integer
9 Equilibration rates 1 floating point

Calibration Report - Single Column

Calibration Report
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D Transmitted Data

Record
Number

Description Form

10 Chamber Insert:

l 0 = None

l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point
12 Cell volume standard deviation 1 floating point
13 Average expansion volume 1 floating point
14 Expansion volume standard deviation 1 floating point
15 Number of runs 1 integer
16 P1 (all P1 data) 1 floating point
17 P2 (all P2 data) 1 floating point
18 P1* (all P1* data) 1 floating point
19 P2* (all P2* data) 1 floating point
20 Include in average calculation

l 0 = Excluded

l 1 = Included

1 integer

Calibration Report - Single Column (continued)

Record
Number

Description Form

1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = calibration 11 characters
4 Start (reported on one line as ASCII comma delimited data)

l 4a. Date

l 4b. Time

8 characters (each)

Calibration Report - Spreadsheet
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Record
Number

Description Form

5 Stop (reported on one line as ASCII comma delimited data)

l 5a. Date

l 5b. Time

8 characters (each)

6 Temperature 1 floating point
7 Calibration standard size 1 floating point
8 Number of purges 1 integer
9 Equilibration rates 1 floating point
10 Chamber Insert:

l 0 = None

l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point
12 Cell volume standard deviation 1 floating point
13 Average expansion volume 1 floating point
14 Expansion volume standard deviation 1 floating point
15 Number of runs 1 integer
16 Carriage return / Line feed
17 Carriage return / Line feed
18 Carriage return / Line feed
19 Run number and pressure (reported on one line as ASCII

comma delimited data)
19a Run number 1 integer
19b P1 1 floating point
19c P2 1 floating point
19d P1* 1 floating point
19e P2* 1 floating point

Calibration Report - Spreadsheet (continued)

Calibration Report
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D Transmitted Data

Record
Number

Description Form

19f Include in average calculation

l 0 = Excluded

l 1 = Included

1 integer

19g Cell volume 1 floating point
19h Cell volume deviation 1 floating point
19i Expansion volume 1 floating point
19j Expansion volume deviation 1 floating point

Calibration Report - Spreadsheet (continued)
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E RS-232 PIN ASSIGNMENT
The AccuPyc is a standard DTE device. The RS-232 port can be used to connect an analytical balance
for transfer of sample weight, or for transmitting data to a computer. The receiving device must be
configured to interface with the RS-232 pin assignments. Any signals that are not listed in the RS-232 Pin
Assignment table are ignored.

Pins Signal Description Data Direction
2 RXD Receive Data Into AccuPyc
3 TXD Transmit Data From AccuPyc
4 DTR Data Terminal Ready From AccuPyc
5 GND Ground N/A
6 DSR Data Set Ready Into AccuPyc

RS-232 Pin Assignments

The AccuPyc uses the DTR and DSR signals for hardware flow control. Ensure that the serial device
provides these signals. For example, if attaching to a computer (also a DTE device), use a null modem
cable which includes the designated signals. If transmission problems occur, ensure that the signals are
set up properly. If the signals are correctly configured, contact the receiving device manufacturer for
assistance.

E RS-232 Pin Assignment
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F TEMPERATURE CONTROLLED ACCUPYC
A temperature controlled AccuPyc must be connected to a circulating bath (not provided by
Micromeritics). Refer to the manufacturer operator manual for circulating bath operating instructions.

ATTACH A CIRCULATING BATH
The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.

1. Power off the controlling unit.

2. Remove the plugs from the In port and the Out port.

3. Insert the provided hose fittings into each connector.

4. Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.

5. Install the tubing on the In and Out connectors.

6. Install the other end of the Out tubing to the Inlet connection of the bath circulator.

7. Install the other end of the In tubing to the Outlet connection of the bath circulator.

8. Set the temperature using the appropriate controls on the bath circulator.

ADD ANALYSIS MODULES TO A TEMPERATURE CONTROLLED MODULE

If using the Windows version of the AccuPyc II, exit the application before powering off
the analyzer.

1. Power OFF the controlling unit.

F Temperature Controlled AccuPyc
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F Temperature Controlled AccuPyc

2. Connect the circulating bath. See "Attach a Circulating Bath" on page J - 5.

3. Connect one end of the module connector cable (provided in the analysis module accessories kit)
to the connector labeledModule Connection on the rear panel of the control module.

4. Connect the other end of the module connector cable to the lower connector labeledModule Con-
nector on the rear panel of the analysis module.

5. Power ON the analyzer. If using the Windows version of the AccuPyc II, start the application .

6. Calibrate the analysis module using the calibration kit shipped with the system. See "Calibration"
on page 10 - 1.
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G MULTIVOLUME INSERT OPTION

The MultiVolume Insert option provides analysis of samples using smaller-sized sample chambers.

Equipment Description
AccuPyc 1 cm3 Includes a 0.1 cm3 insert/sample cup combination.
AccuPyc 10 cm3 Includes 1 and 3.5 cm3 inserts with corresponding sample cups and appro-

priate calibration standards. Fritted filter lids are included for both inserts.
AccuPyc 100 cm3 Includes 10 and 35 cm3 inserts with corresponding sample cups and appro-

priate calibration standards. A fritted filter lid, which prevents the escape
of sample particles under rapid gas flow, is included for the 10 cm3

insert.
AccuPyc 2000 cm3 Includes 650 and 1300 cm3 cups, supporting inserts and calibration stand-

ards. A tool is also included to allow removal of the supporting inserts

See "Parts and Accessories" on page 13 - 1.

OPERATING PARAMETERS
To operate using inserts, access the Chamber Insert prompt to select the appropriate MultiVolume
insert.

1. Press Alt + 2 to access the Setup function.

2. Press CHOICE until Report Options is displayed, then press ENTER.

3. Continue pressing ENTER until the Request Insert prompt is displayed.

4. Press CHOICE until Yes is displayed, then press ENTER.

5. Press SAVE to save the changes and return to the Reload prompt.

A Chamber Insert prompt will display during all normal operating procedures. For example, a Chamber
Insert prompt will display when starting a calibration or analysis.

G MultiVolume Insert Option
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G MultiVolume Insert Option

ABOUT INSERTS AND SAMPLE CUPS

Wear latex gloves when handling inserts and sample cups. Oils from skin may contaminate
the surface and affect analysis results. See "Handling System Components" on page J - 1.

An insert changes the size of the sample chamber and requires its own sample cup. All inserts are
shipped with appropriate cups, with the exception of the 0.1 cm3 insert for the 1 cm3 unit. Because of its
size, the sample cup for the 0.1 cm3 insert is built-in. The appearance of the inserts and cups varies.

l The fritted filter caps for the 1 cm3 and 3.5 cm3 inserts fit on top of the insert.

l The cap for the 10 cm3 insert (shown in image) fits on the sample cup.

This example shows a 10 cm3 cup and insert.

The inserts for the 2000 cm3 systems are installed and removed with a special tool.
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INSTALL AND REMOVE INSERTS AND SAMPLE CUPS

0.1 cm3 Insert

The MultiVolume kit contains a special tool required to install the 0.1 cm3 inserts. The sample cup is
built into the 0.1 cm3 insert.

1 cm3 Insert

The MultiVolume kit contains a special tool required to install the 1 cm3 inserts.

Install the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

Contamination from airborne particles can occur rapidly. The chamber cap should be left
off the sample chamber for as little time as possible.

2. Place the insert into the sample chamber.

3. Use the handling tool to grasp the cup for placement in the insert. After placing the sample into
the sample cup, insert the tip of the tool into the cup and press down firmly. The handling tool fea-
tures an O-ring to grip the inside surface of the sample cup.

Install and Remove Inserts and Sample Cups
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G MultiVolume Insert Option

4. Place the cup into the insert, then tilt the tool to one side and remove it from the sample cup.

5. If using a fritted filter cap, place it onto the top of the insert.

6. Replace the sample chamber cap.

Remove the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

2. Remove the fritted filter cap (if used).

3. Insert the handling tool into the sample cup until the sample cup is gripped by the O-ring.

4. Lift the sample cup out of the insert.

5. Pull the insert from the sample chamber.

6. Replace the sample chamber cap.

10, 3.5, and 35 cm3 Inserts

Remove the chamber cap and place the insert into the sample chamber. The insert should fit snugly in
the chamber. Place the appropriate sample cup into the well of the insert.
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Do not force the insert or cup into the openings. This may damage the instrument, insert, or
sample cup.

Install the fritted filter cap (if used) before closing the sample chamber. A fritted filter cap is used to
constrict gas flow and is included with some inserts. The fritted filter cap for the 10 cm3 insert fits on the
top of the sample cup. The fritted filter caps for the 1 and 3.5 cm3 inserts fit on the top of the insert.
Fritted filter caps are not available for the 0.1 and 35 cm3 inserts.

CALIBRATE INSERT
An insert must be calibrated and its operation verified. Appropriate calibration standards are included in
the MultiVolume kits. For example, a 100 cm3 capacity AccuPyc with a 10 cm3 insert must be calibrated
with the 10 cm3 insert, cup, and calibration standards.

0.1 CM3 INSERT

Because of the size of the 0.1 cm3 insert, its calibration is performed in a different manner from that of
other inserts.

If the 1 cm3 pycnometer has not been calibrated recently, perform a calibration before cal-
ibrating the 0.1 cm3 insert.

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

2. Place the insert into the sample chamber (the sample cup is built into the insert). Replace the
chamber cap.

3. Press Alt + 4 to access the Analyze function. Press ENTER until the Chamber Insert prompt is
displayed. Ensure that None is displayed.

4. Press ENTER to display the Analyze prompt. Press ENTER to begin the calibration.

5. After the calibration is complete, the Reload prompt is displayed.

6. Press CHOICE until the average measured volume is displayed. Record this value.

7. Press Alt + 2 to access Setup.

8. Press CHOICE until Calibration Data is displayed.

9. Press ENTER to display the Chamber Insert prompt.

10. Ensure that None is selected, then press ENTER to display the Cell Volume prompt.

11. Subtract the average volume of the 0.1 cm3 insert/cup (recorded in Step 6) from the cell volume
displayed in the prompt. Record this value.

12. Press ENTER to display the Expansion Volume prompt.

Calibrate Insert
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G MultiVolume Insert Option

13. Record the value displayed for the expansion volume, then press ENTER to return to the Cal-
ibration Data prompt.

14. Press ENTER. The Chamber Insert prompt is displayed.

15. Press CHOICE until 0.1 cm3 is displayed, then press ENTER to display the Cell Volume prompt.
Enter the value recorded in Step 11.

16. Press ENTER to display the Expansion Volume prompt. Enter the value recorded in Step 12.

17. Press SAVE to save the information and return to the Reload prompt.

The pycnometer is now ready for analyses using the 0.1 cm3 insert/cup.

1, 10, 3.5, 35, 650, AND 1300 CM3 INSERTS

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

2. Place the insert and sample cup into the sample chamber. Replace the chamber cap.

3. Calibrate the insert. See "Calibration" on page 10 - 1.

4. See "Verify Operation" on page 10 - 10.
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H TEC MODULE

This AccuPyc system has been modified to provide temperature control from 15 to 36 °C. The system
uses a thermoelectric control (TEC) system to heat or cool the AccuPyc. The temperature is controlled
using a digital temperature controller and a separate power system from the AccuPyc.

It is suggested that the TEC system be installed first, to allow time for temperature to stabilize at the
desired temperature, while the AccuPyc is being installed. See ."Add Analysis Module to Control
Module" on page 11 - 1and "Set the TEC Temperature" on page J - 4.

SET THE TEC TEMPERATURE
1. Power on the TEC module. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current temperature
and a message such as ErAt displays, press the P (Program) key on the front panel of the
controller. The ErAt message should stop and only the current temperature will display.

2. Press P. SP 1 displays followed by the current setpoint (SP 1). Use the Up or Down key to set the
temperature.

3. Press P to accept the temperature. The controller will now start heating or cooling to achieve the
setpoint

The TEC module uses a fan to remove heat. The fan is located on the underside of the
instrument. The fan pulls air into the instrument and the air is exhausted through ventilation
slots on the rear panel. The exhaust slots must remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC system will be unable to control temperature, and may
become damaged.

H TEC Module

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

H - 1



H TEC Module

OPERATE THE TEC MODULE

When the TEC controller shows the correct temperature, there may be a small difference between the
temperature on the TEC unit and the AccuPyc display because two different sensors are being used. The
AccuPyc sensor and electronics are calibrated together to compensate for any component differences
between the sensor and the circuit board components. Micromeritics considers the AccuPyc temperature
display to be a more accurate reflection of the sample temperature than the reading from the controller.
The controller and the sensor used with the controller cannot be calibrated.

The TEC controller may be adjusted to compensate for the small difference. If the AccuPyc temperature
is a little high, then reduce the setpoint of the TEC controller by the difference. Wait for stabilization.
Readjustment may need to be repeated until the correct AccuPyc temperature is achieved.

The AccuPyc volume must be calibrated at the analysis temperature. Perform the volume calibration in
the normal way until it is time to insert the reference volume (sphere or spheres). After installing the
reference volume, wait at least 20 minutes to allow the volume to achieve the same temperature as the
AccuPyc. Then continue as normal.

When it is necessary to perform AccuPyc tests at a different temperature, re-calibrate the system
volume at the new temperature.

VOLUME CHANGE WITH TEMPERATURE FOR THE 10 CM3 ACCUPYC

The reference spheres supplied with the 10 cm3 AccuPyc are made from tungsten carbide. They were
measured at 20 °C. The spheres will change volume with temperature. The change is very small and is
shown in the following table. Every sphere is a slightly different size, and so the table provides the factor
to be used if the value used during calibration needs to be adjusted. Multiply the volume provided with
the reference spheres by the value in the right column.

Temperature (°C) Typical Volume (cm3), two balls Factor
15 6.37125 0.99991
20 6.37182 1.00000
25 6.37238 1.00009
30 6.37295 1.00018
35 6.37351 1.00027

For example, if the ball is 6.37182 cm3 at 20 °C but run at 50 °C, multiply the Volume × the Factor in the
table.

6.37182 x 1.00053 = 6.37520
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VOLUME CHANGE WITH TEMPERATURE FOR THE 100 CM3 ACCUPYC

The stainless steel calibration standard (ball) supplied with the 100 cm3 AccuPyc is made from 440
grade stainless steel. It was measured at 20 °C. Its volume will be higher when heated above 20 °C. The
following table uses the coefficient of thermal expansion of 440 grade stainless steel (0.0000101
m/m/degree C change) to provide the volume of the sphere at various temperatures.

Every ball is a slightly different size therefore the table provides the factor to be used if the value used
during calibration needs to be adjusted. Multiply the volume provided with the reference sphere by the
value in the right column.

Temperature (°C) Typical Volume (cm3) Factor
15 51.089712 0.99995
20 51.092292 1.000000
25 51.094872 1.000051
30 51.097452 1.000101
35 51.100032 1.000152

For example, if the ball is 51.092292 cm3 at 20 °C but run at 50 °C, multiply the Volume × the Factor in
the table.

51.092292 × 1.000303 = 51.107773

Volume Change with Temperature for the 100 cm3 AccuPyc
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ASPHALT DENSITY MEASUREMENT

Samples can be analyzed in disposable cups. Any difference in the mass of the cups used for calibration
and analysis will be corrected for in the reported quantities. Performing an asphalt density measurement
requires the AccuPyc II Asphalt software and disposable sample cups. Refer to "Parts and
Accessories" on page 13 - 1 for ordering information.

Steps 1-9 do not need to be repeated for subsequent analyses.

1. Set the instrument temperature and allow 12 hours for equilibration.

2. Go to Options > Options Presentation. Select Show Cup Properties. Verify that a checkmark
displays to the left.

3. Label each disposable cup with a permanent marker and record its mass.

4. Place a disposable cup in the 3.3 cm3 insert and position the insert in the sample chamber.

5. Go to Unit [n] > Calibration > Calibrate Volume.
a. Enter the mass of the cup in the Cup mass field.

b. Enter the volume of the reference sphere in the Volume of calibration standard field.

c. Select the correct chamber insert.

d. Select Measured .

e. Click Start.
6. Insert the reference sphere when prompted and resume the calibration.

7. When the calibration is complete, remove the cup and reference sphere .

8. Prepare a sample in a different disposable cup and place it in the sample chamber.

9. Create a sample file for the analysis.

10. Go to Unit [n] > Sample Analysis and select the sample file created in the previous step.
11. Enter the mass of the cup in the Cup mass field.

12. Select the chamber insert that was used for calibration.

13. Click Start.

Asphalt Density Measurement



I MULTIGAS OPTION

The Multigas option enables the AccuPyc to use up to four different gases. The Multigas assembly
consists of:

l Valve assembly and two retaining screws

l Gas entrance tubing for connection from the analyzer to the valve assembly

l Gas supply tubing for four gases

INSTALL THE MULTIGAS ASSEMBLY

If a gas is attached to the gas inlet on the rear panel of the analyzer, close the gas cylinder
valve and remove the inlet tubing from the analyzer before installing the multigas assembly.
The gas can then be attached to one of the inlet valves on the assembly.

1. Remove the two retaining screws on the rear panel of the AccuPyc.

2. Position the valve assembly against the rear panel so that the retaining screw holes on the valve
assembly align with those on the rear panel of the analyzer.

3. Attach the valve assembly to the rear panel using the two screws included in the multigas kit.

4. Carefully cut and remove the cable ties holding the gas entrance tubing in position and remove the
ties.

5. Remove the protective caps from the ends of the gas entrance tubing, then remove the ferrules
from the upper end of the tubing.

6. Remove the nut from the center port and slide it onto the end of the gas entrance tubing, then
replace the front and rear ferrules.

7. Insert the tubing into the center port of the multigas assembly. Use the nut to secure the tubing to
the assembly.

8. Insert the other end of the tubing into the gas inlet. Use the self contained swage nut to secure the
tubing to the inlet.

I Multigas Option
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I Multigas Option

CONNECT GASES

1. Connect one end of the gas supply tubing to the gas supply. See "Instrument Components" on
page 1 - 4.

2. Insert the other end of the tubing into one of the valve inlets on the multigas assembly.

3. The faceplate of the valve assembly contains four sections; one for each gas inlet on the
assembly. Write the name of the gas in the applicable section.

SELECT GASES

After installing the gases, use the knob to select the gas. Purge the gas lines when changing gases.
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J INSTALLATION INSTRUCTIONS
These instructions assume that the shipping cartons have been opened and their contents checked and
verified as instructed in the AccuPyc II Installation Checklist part number 134-42870-02.

HANDLING SYSTEM COMPONENTS

CALIBRATION STANDARD

l Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.

l Do not drop the standard into the sample cup. Roll the standard into the cup to prevent damage.

l Always return the standards to the case. Standards are unit specific.

SAMPLE CHAMBER CAP

l Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.

l Keep the cap on the sample chamber except when inserting or removing the sample cup .

When left uncapped, the sample chamber temperature may become unstable and / or water
vapor will adsorb on the inner surface of the chamber. Either of these conditions can affect
analysis results.

l Avoid laying the chamber cap on a work surface. Debris may collect on the greased surface of the O-
ring which can also affect analysis results.

l When multiple analysis modules are connected, never interchange sample chamber caps. Caps are
unit specific.

GAS REQUIREMENTS
The pycnometer uses helium or nitrogen (99.995% pure or better) to provide rapid, accurate analyses.
The cylinder containing helium must be fitted with a gas regulator set for 19-23 psig (131-159 kPag). The
pressure input to the pycnometer should never be greater than 25 psig (172 kPag). Excessive pressures
waste gas due to a protection device contained in the pycnometer that vents the pycnometer to
atmospheric pressure if pressure exceeds 35 psig (241 kPag).

This protection device is not installed on 2000 cm3 units.

Minimum recommended gas tank pressure is 200 psig (1379 kPag).

Other inert, dry gases can also be used and may be more applicable for some applications.

J Installation Instructions
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J Installation Instructions

PYCNOMETER SET UP

PYCNOMETER CONFIGURATION

Single Module Configuration

Control Module and Analysis Module Configuration
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TEC Module Configuration

Component Description
A Separate power cord for external power supply. Connect cable to wall outlet.
B External power supply
C Hardwired 8-pin mini-DIN power cable for external power supply.
D 8 pin mini DIN cable.
E Power adapter DIN port.
F Power adapter.
G Module Connection - 8-pin mini-DIN OUT port to connect next analysis module.
H Module Connection - 8-pin mini-DIN IN port to connect the control module or

previously connected analysis module (not shown).
I Hardwired power mini-DIN cable for power adapter.

Diagram Components

Set Up Procedure

1. Unpack and inventory all boxed parts. Contact your Micromeritics Service Representative if parts
are missing or broken.

2. Place module(s) on work surface.

3. Connect separate power cable(s) to external power supply(s).

4. Connect external power supply(s) to power outlet on the module(s).

5. Connect power cable to wall outlet.

6. Toggle the module power switch to the ON position.

Pycnometer Configuration
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J Installation Instructions

7. Check the power indicator on the front panel of the analyzer. The indicator will blink green to
indicate that power is applied to the analyzer. Once the application is running, the indicator will
stop blinking and remain illuminated.

8. On the keypad, press Alt + CHOICE + 2. Unit [n] appears in the upper left corner of the display.

9. Adjust the display brightness control using the Brightness Control button on the rear of the ana-
lyzer.

SET THE TEC TEMPERATURE

1. Power on the TEC module. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current temperature
and a message such as ErAt displays, press the P (Program) key on the front panel of the
controller. The ErAt message should stop and only the current temperature will display.

2. Press P. SP 1 displays followed by the current setpoint (SP 1). Use the Up or Down key to set the
temperature.

3. Press P to accept the temperature. The controller will now start heating or cooling to achieve the
setpoint

The TEC module uses a fan to remove heat. The fan is located on the underside of the
instrument. The fan pulls air into the instrument and the air is exhausted through ventilation
slots on the rear panel. The exhaust slots must remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC system will be unable to control temperature, and may
become damaged.
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TEMPERATURE CONTROLLED MODULE HARDWARE SETUP

Setup a Single Temperature Controlled Module

See "Pycnometer Configuration" on page J - 2 for setup instructions. When complete, connect the
circulating bath.

Attach a Circulating Bath

The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.

1. Power off the controlling unit.

2. Remove the plugs from the In port and the Out port.

3. Insert the provided hose fittings into each connector.

4. Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.

5. Install the tubing on the In and Out connectors.

6. Install the other end of the Out tubing to the Inlet connection of the bath circulator.

7. Install the other end of the In tubing to the Outlet connection of the bath circulator.

8. Set the temperature using the appropriate controls on the bath circulator.

CHAMBER CAP O-RING

See "Grease the Chamber Cap O-Ring" on page 12 - 4.

Temperature Controlled Module Hardware Setup
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J Installation Instructions

CONNECT KEYBOARD

An optional USB keyboard can be connected to a USB port on the rear panel of the analysis module. The
keyboard is not provided by Micromeritics.

CONNECT AN ANALYTICAL BALANCE

An analytical balance can be connected to a serial port on the computer and used to transfer the
sample’s mass via a third-party software directly to the AccuPyc II application. Refer to the balance
manufacturer’s operator’s manual for transmission instructions.

Connect the analytical balance to the RS-232 port on the rear panel of the analyzer.

To configure the Analytical Balance, see "Configure an Analytical Balance" on page J - 20.

GAS CONNECTION

These instructions are for connecting inert gases only. Follow the safety procedures used by
your laboratory for connecting hazardous gases.

Review "Gas Requirements" on page J - 1 prior to installing gas.

1. Attach an appropriate regulator to the gas cylinder or gas line, then tighten with a wrench. Leave
the gas bottle shut-off valve closed until instructed otherwise.

2. Attach the gas inlet line to the regulator, reducer fitting, or regulator expansion:
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It is important to use the inlet tubing supplied with the analyzer. Gas lines made of mater-
ials other than copper or stainless steel can cause operational problems as well as inac-
curate data.

If Regulator has... Then...
1/4 in. outlet Attach the reducer fitting to the outlet of the regulator shut-off / isolation

valve
Tighten the nut finger-tight, then 1-1/4 turns with a wrench.
Continue with the steps given for the 1/8 in. outlet

1/8 in. outlet Insert the gas tubing into the fitting.
Enure the tubing is seated fully inside the fitting.
Tighten the nut finger-tight
While holding the fitting body steady, tighten the nut with a wrench 3/4
turn.

Do not overtighten the fittings. Doing so can collapse the brass fitting and cause a leak.

3. Purge the regulator and inlet tubing to prevent contamination of the analysis gas.
a. Turn the regular shut-off valve clockwise to close.

b. Turn the pressure regulator control knob counter-clockwise to open.

c. Slowly turn the gas cylinder shut-off valve counter-clockwise to open, then quickly close it.

d. Observe the high-pressure gauge.

If the pressure decreases, tighten the nut connecting the regulator to the gas cylinder. If the
pressure is stable, proceed to the next step.

Enure the gas supply equipment is adequately vented before performing the next step.

e. Turn the pressure regulator control knob clockwise until the low-pressure gauge
indicates 19.500 psig (134.445 kPag).

f. Turn the regulator shut-off valve counter-clockwise to open.

g. Turn the gas cylinder shut-off valve counter-clockwise to open. Flow gas for 10 to
30 seconds, then close the valve.

h. Turn the gas regulator shut-off valve clockwise to close

Gas Connection
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J Installation Instructions

4. Attach the other end of the copper tubing to the gas inlet on the rear panel of the pycnometer.
Remove the inlet plug that shipped with the pycnometer.

5. Turn the nut on the tubing clockwise until it is finger-tight. Then use a 7/16 in.(1 mm) wrench to
tighten the nut an additional 1/4 turn.

6. Open the gas cylinder and regulator shut-off valves.

7. Turn the regulator control knob until the low pressure gauge indicates 21.5 psig (148 kPag).
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CONNECT THE ANALYZER TO THE COMPUTER

If using the analyzer with the keypad or keyboard only, skip this section.

An Ethernet switch is required if connecting a different type of analyzer to the same computer as the
AccuPyc. If configuring multiple AccuPyc modules. they are connected together with only the Control
Module connected to the Ethernet switch. See "Connect an Ethernet Switch" below.

CONNECT AN ETHERNET SWITCH

An Ethernet switch is required to connect one or more analyzers and one computer.

BRIGHTNESS CONTROL

To adjust the display brightness:

1. Insert a small flat head screwdriver into the opening.

2. Rotate the screwdriver until it engages in the slot, then turn clockwise to darken and coun-
terclockwise to lighten.

Connect the Analyzer to the Computer
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J Installation Instructions

CONFIGURE THE PYCNOMETER
If using the keypad option, see "Configure the Pycnometer using the Keypad" below and skip the
section on "Software Installation" on page J - 15.

When using the software application, the display window on the pycnometer is disabled.

CONFIGURE THE PYCNOMETER USING THE KEYPAD

If using the keypad to control analyses, follow these instructions for configuring the module.
If using the Windows application, skip this section.

Complete the installation process by configuring the module:

l Unit type. See "Unit Types" on page J - 13.

l System setup (date / time / language). See "System Setup" below.

l Calibrate. See "Calibrate Volume" on page 10 - 15.

l Reports. See "Setup Reports" on page 2 - 9.

l Transmit parameters. See "Transmit" on page 2 - 6.

l Printer setup. See "Printer Setup" on the facing page.

System Setup

Press Alt + 2 to access the set-up function.

Display Description
Setup. Choose or enter parameters for analysis, calibration,
reporting, and data transmission.

Choices: Analysis Parameters, Report Options, Calibration
Data, Communications, Unit Types

Press CHOICE to display the set up type, then press
ENTER.

The parameters for each set up type are stored and used to
control the pycnometer until new ones are specified.

At the completion of each set up, the display returns to the Setup type? prompt.
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l Press SAVE to save the information and return to the Reload prompt.

l Choose another set up type. Do not press SAVE until all parameters have been entered. The display
will return to the Reload prompt.

l Press Alt + CLEAR to discard the information entered and return to the Reload prompt.

Printer Setup

Printers are connected to the AccuPyc II via a USB port. See "Specifications" on page 1 - 10 for a list
of supported printers. Using the keypad:

1. On the display, select Setup > Report Options.

2. Press ENTER until the Printer? prompt is displayed.

3. Press CHOICE until the appropriate printer driver is displayed.

Communications

Use these instructions for keypad installations only. If a computer will be attached to the
module, skip this section. All setup functions will be done in the analysis software applic-
ation.

Communications enables specification of communications criteria, such as baud rate, parity, etc.

Display Text Description
Setup Type?
Communications

Press CHOICE until Communications is displayed.

Communications
IP Address?
[choice]

Enables selection of the manner in which the IP address is assigned. With
an IP address, analysis results can be access via a web browser.
Typically, after an analysis (or calibration) is started, results from the
previous operation cannot be reviewed. However, results from five
analyses are stored in the controller. A web browser enables review of
these results. An IP address must exist for this operation. An IP address
can be detected and assigned automatically, or one can be specified.

Ensure the Ethernet cable is plugged into the Ethernet port on the analyzer
and to the network. Choose DHCP to have an IP address assigned
automatically, or Specify to specify an address. Press CHOICE until the
option is displayed.

If using DHCP, an IP Address should be assigned within a minute.

Configure the Pycnometer using the Keypad

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014

J - 11



J Installation Instructions

Display Text Description
Communications
Requesting Address *
[ENTER] to continue

Displays the first-time selection of DHCP.

Press ENTER. The system automatically attempts to assign an IP
address. If the system is able to determine an address, the assigned
address is displayed.

Communications
Requesting Address
[ESCAPE] to cancel

If an address cannot be determined, this prompt is displayed:

Press Alt + CLEAR to cancel the operation and return to the Reload
prompt. Contact your IT department, or choose the Specify option and
enter the appropriate information.

Communications
IP Address *
(user entered)

Displays when the Specify option is selected. Enables entry of an
appropriate IP address. This is a numerical field in the following format:
nnn.nnn.nnn.nnn. Enter the address.

Communications
Subnet Mask *
(user entered)

Enables entry of the subnet mask number. Enter the subnet mask number.

Communications
Gateway *
(user entered)

The Gateway address is used for communicating outside the local
network. The Gateway address is often the same as the IP address, with a
“1” after the last dot instead of the last three characters (nnn.nnn.nnn.1).
Contact your IT department with any questions.

Communications
E-mail Address:

When connected to a network, analysis or calibration results can be e-
mailed automatically upon their completion. This prompt enables entry of
the e-mail address where results are to be sent.

If not using DHCP and the e-mail address is outside the local network,
specify a gateway address (see previous prompt). A keyboard is required
to type in the e-mail address.

Communications
E-mail Server:

Enables entry of the numerical address of the SMTP server. If this
address is unknown, contact your IT department.
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Display Text Description
IT may need to configure
the server to accept email
from the AccuPyc. The
following information
may be required:

l IP address for the
AccuPyc

l Sender line: Micro-
meritics-1340

IT may need to configure the server to accept e-mail from the AccuPyc.
The following information may be required:

l IP address for the AccuPyc

l Sender line: Micromeritics-1340

Communications
Baud Rate?

Press CHOICE to select proper baud rate.

Communications
Data Bits?

Press CHOICE to select 8 or 7.

Communications
Stop Bits?

Press CHOICE to select 1 or 2.

Communications
Parity?

Press CHOICE until the required option (None, Even, or Odd) is dis-
played.

Communications
Xon / Xoff Protocol?

Transmits data through the Xon/Xoff protocol. Press CHOICE to select
Disabled or Enabled.

* Does not display for DHCP.

Unit Types

If not using the analyzer software, these keypad prompts enable selection or entry of:

l units of measurement

l operating language

l current date and time

Display Text Description
Set-up Type?
Unit Types

Press CHOICE until Unit Types is displayed, then press ENTER.

Unit Types
Pressure units?

Enables selection of unit type for reports. Press CHOICE to select the
desired unit.

Options are:

l psig (pounds per square inch gauge)

l kPag (kilopascal gauge)

Configure the Pycnometer using the Keypad
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J Installation Instructions

Display Text Description
Unit Types
Language?

Enables selection of operating language. Pressing SAVE is not required.

Error messages that may be in the message queue will remain in English
(or the current selected language). Error messages that occur after
selecting the language will display in that language.

Keypad overlays containing translations for the alternate functions are
available for each language. Choose the language.

Unit Types
Date (DD/MM/YY)?

The date is entered in a two digit format for the day, month, and year. For
example; to set the date for September 1, 2014, enter 01/09/14
(day/month/year). Use the . (decimal) key to enter a slash (/).

Unit Types
Time (HH:MM:SS)?

The time (in 24 hour format) at which an analysis begins and ends is
shown on all reports. The time shown on the display may not match the
current time.

The time is entered in a two digit format for the hour, minutes, and
seconds. For example; to set the time to 1:05 pm, enter 13:05:00
(hour:minutes:seconds). Use the . (decimal) key to enter a colon (:).

Setup Date, Time , and Language

1. On the keypad, press Alt + 2 to enter Setup mode.

2. Press Choice until Date displays, then press Enter and enter the current date.

3. Press Choice until Time displays, then press Enter and enter the current time.

4. Press Choice until Language displays, then press Enter and select the correct language.

Calibration

See "Calibrate Volume" on page 10 - 15.
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SOFTWARE INSTALLATION

If installing multiple analyzers, connect the Ethernet switch to the configured port on the
computer, connect the analyzers to the Ethernet switch, then turn the analyzers on.

The application should not be installed on a network drive with shared access. Multiple
users cannot operate the application at the same time.

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

These prerequisites must be completed prior to installing the software:

l Configure an Ethernet port on the computer to communicate with the analyzer. The IP address must
be 192.168.77.100. Reference the computer operator manual for instructions on changing the
IP address.

l Attach the analyzer to the computer’s configured Ethernet port. Use an Ethernet switch if multiple
analyzers will be attached.

1. Insert the installation CD into the CD-ROM drive. The program automatically starts the install-
ation. If the installation does not immediately start, navigate to the CD-Rom drive, then locate and
double click the setup.exe file.

2. On the Ethernet Introduction window, verify that all prerequisites have been met.

a. If not, click Cancel and complete the steps, then restart the installation program. Do not
proceed with installation until these tasks have been completed.

b. If the prerequisites have been met, click OK.

Software Installation
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J Installation Instructions

3. On the New Installation window, verify that sufficient disk space is available to continue the
installation. If not, click Exitand free up the minimum required disk space. If the disk space is
OK, click Next to accept the default installation directory, or click Browse to change the install-
ation location.

a. To add a shortcut to the desktop, select the Add the application icon to the Desktop.....
checkbox.

b. To allow all computer users access to the software application , select Install this applic-
ation for All Users.all users of the computer.

c. Click Next.

4. On the Analyzer Configuration window, select 1 for the number of analyzers to be installed and
enter the analyzer serial number in the text box.
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10. On the Ethernet Ports window, select one option from the following table:

If... Then...
the configured port is listed Select the port, then click Next.

Software Installation
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J Installation Instructions

If... Then...
the configured port is not listed Click Specify and enter the remaining portion of the

IP Address, then click Next.

The IP Address must be 192.168.77.100

11. If prompted to configure a balance, select either 0 or 1. The balance should be connectd to Com
Port 1. The default parameters should be OK. If not prompted for a balance, skip this step.

12. On the Installation Complete window, click Finish.
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START THE APPLICATION

To start the application, click the application shortcut on the desktop or select the application from the
Windows program list.

SPECIFY UNIT SELECTIONS

Options > Units

Use to specify how data should appear on the application windows and reports.

Start the Application
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CONFIGURE AN ANALYTICAL BALANCE

Options > Configure Balance

Used to connect and set up an RS-232 balance to the analyzer. See "Connect an Analytical Balance"
on page J - 6.

The analytical balance tested by Micromeritics is Scientec® model #ZSA120. See "Parts and
Accessories" on page 13 - 1.

Field or Button Description
Enable / Disable Select to enable or disable the attached balance.
Serial Parameter Used to set the baud rate, parity, data bits, and stop bits. This field should

not require modification from the default values.
Serial Port Select which serial port is used to connect the balance to the analyzer.

Configure Balance Fields and Buttons Table
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REINSTALL OR MODIFY THE SOFTWARE

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

The Setup program is located on the installation CD. After initial software installation, if changes need
to be made to the analyzer setup, reinsert the Setup CD and follow the prompts.

l Reinstall the software version [n]

l Add an analyzer

l Move an analyzer

l Remove an analyzer

l Change analyzer setup

l Reinstall calibration files for an analyzer

l Uninstall

l Reset security to default

To access the Setup program:

1. Insert the Setup CD into the CD drive.

2. Locate and double click the Setup.EXE file.

If the IP address needs to be changed on the computer connected to the analyzer, refer to
the computer's operating system manual or the internet for instructions. The IP address for
the computer and the IP address specified in the setup program must match. The IP address
must be 192.168.77.100.

Reinstall or Modify the Software
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UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed. Parameter
files, sample files, reports, calibration files, and data files are not removed.

1. Insert the Setup CD into the CD drive.

2. Select the Uninstall option.

3. Follow the prompts.
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Dust filter, clean 12 - 9

E
Equilibration

Report Example 7 - 29
Equilibration Report

report options 8 - 4
Equipment Options 1 - 7
Error messages

Keypad A - 19
Windows A - 1

Ethernet Switch, connect J - 9
Expansion Chamber

check for leaks 12 - 6
check for leaks using software 12 - 6
check for leaks using the keypad 12 - 8

F
Features and shortcuts

graphs 7 - 13
tabular report 7 - 19

Files
default locations 3 - 6
description 3 - 6
extensions defined 3 - 6
status 3 - 6

FoamPyc Option 1 - 3

G
Gas Connection J - 6
Gas Requirements J - 1
Gas Supply

Connect Gases I - 2
Select Gases I - 2

Calibrate Function, keypad 10 - 14
Calibration 10 - 1

Calculations B - 4
copy data 10 - 20
data, keypad 10 - 14
load data 10 - 20
load from file 10 - 12
report 10 - 1
reset pressure 10 - 5, 10 - 16
review 10 - 17
save to file 10 - 13
Temperature 10 - 19
verify operation 10 - 10
Zero the chamber volume (using the keypad)

10 - 19
Zero the pressure transducer (using the

keypad) 10 - 19
Cell leaks

check for 12 - 6
check using software 12 - 6
check using the keypad 12 - 8

Chamber Cap O-Ring 12 - 4
Circulating bath, attach F - 1, J - 5
Collected Data 5 - 7
Combined Report

report example 7 - 24
report options 8 - 1

Common Fields and Buttons 3 - 2
Complete, file status 3 - 6
Components

handling J - 1
instrument 1 - 4

Computer
connect to analyzer J - 9

Configuration
AccuPyc II 1 - 8

Contact Us ii
Control chart, report 7 - 5
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Data
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Reports, setup 2 - 9

L
Leaks,check for 12 - 6
Leaks,check using software 12 - 6
Leaks,check using the keypad 12 - 8
List files 3 - 11

M
Maintenance

guidelines for connecting 12 - 11
replace gas cylinder 12 - 12

Manual mode 2 - 5
Manual, about this iii
Material Parameters 4 - 6
Menu structure 3 - 1
Modules, connect 11 - 1
Multigas Option 1 - 7, I - 1
MultigGas Option

Install I - 1
MultiVolume Inserts 1 - 7, G - 1

N
No Analysis, file status 3 - 6

O
O-ring

chamber cap, grease 12 - 4
chamber cap, replace 12 - 4

Option presentation 3 - 5
Options Report

report options 8 - 5
Overlay

Generating Graph 7 - 20
Report Example 7 - 28

Overlays
generate 7 - 20
multiple graph 7 - 22
multiple sample 7 - 21
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connect a replacement gas cylinder 12 - 13
disconnect the depleted gas cylinder 12 - 12
guidelines for connecting 12 - 11
replace a gas cylinder 12 - 12

Glove Box 1 - 8
Graph

features and shortcuts 7 - 13
generate overlays 7 - 20
Report Example 7 - 27
zoom feature 7 - 18

Graph Grid Lines 7 - 18

H
Handling System Components J - 1
Hardware components, install 11 - 1

I
Insert

1 cm3
install G - 3
remove G - 4

Inserts G - 2
0.1 cm3 G - 3
1 cm3 G - 3
10, 3.5, and 35 cm3 G - 4
install and remove G - 3
Operating Parameters G - 1

Install
Hardware components 11 - 1
Software Upgrade 3 - 14

Installation
software J - 15

Installation Instructions J - 1
Instrument components 1 - 4
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Report examples 7 - 24

Combined Report 7 - 24
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Report Options 5 - 5
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Density vs Cycle Number 8 - 2
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Options Report 8 - 5
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Summary Report 8 - 6
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S
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Parameter files
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FoamPyc application 5 - 4
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Presentation option

advanced 4 - 2
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Software
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